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Warranty
A. Limited Warranty Statement

1 Matrox Electronic Systems Ltd. (“Matrox”) warrants to the end-user customer who provides adequate proof of 
purchase, that Matrox hardware products purchased from Matrox authorized dealers will be free from defects in 
materials and workmanship for a period of three (3) years from the date of purchase. This warranty applies only 
to the original end-user purchaser and is non-transferable. Conditions and limitations of Matrox’s warranty are 
stated below.

2 Matrox’s limited warranty covers only those defects that arise as a result of normal use of the hardware and does 
not apply to any:
a improper or inadequate maintenance;
b incompatibilities due to the user’s hardware or software applications with or in which the Matrox product 

interfaces;
c product of a special or custom-made nature;
d unauthorized modification or misuse;
e improper installation, misapplication or negligence;
f operation outside the product’s environmental specifications;
g improper site preparation or maintenance;
h software;
i other causes that do not relate to a product defect;
j defects or damage suffered as a result of force majeure (including theft);
k defects or damage suffered as a result of normal wear and tear; and/or
l stolen goods.

3 If Matrox receives, during the applicable warranty period, notice of a defect in a warranted hardware product and 
the defective Matrox product in question, Matrox shall at its sole option, either repair or replace the product, and 
shall return the repaired product or a replacement product within a reasonable delay. The replacement product 
may not be new, provided that it has functionality at least equal to that of the product being replaced.

4 This warranty is valid in any country where Matrox hardware products are distributed by Matrox or its 
authorized dealers.

5 This Limited Warranty Statement gives the customer specific legal rights. The customer may also have other 
rights which vary from state to state in the United States, from province to province in Canada, and from country 
to country elsewhere in the world.

B. Limitations of Warranty
1 NEITHER MATROX NOR ANY OF ITS THIRD PARTY SUPPLIERS MAKES ANY OTHER WARRANTY 

OF ANY KIND, WHETHER EXPRESSED OR IMPLIED, WITH RESPECT TO MATROX PRODUCTS. 
MATROX SPECIFICALLY DISCLAIMS (and the customer, by accepting the Matrox product, specifically 
accepts such disclaimer and waives) ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR OR INTENDED PURPOSE OR USE AND THE WARRANTY AGAINST 
LATENT DEFECTS, WITH RESPECT TO THE HARDWARE AND/OR SOFTWARE. MATROX FURTHER 
DISCLAIMS ANY WARRANTY THAT MATROX PRODUCTS, IN WHOLE OR IN PART, WILL BE FREE 
FROM INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY OR PROPRIETARY 
RIGHTS."

2 To the extent that this Limited Warranty Statement is inconsistent with the law of the locality where the 
customer purchases the Matrox product, this Limited Warranty Statement shall be deemed modified to be 
consistent with such local law. Under such local law, certain limitations of this Limited Warranty Statement may 
not apply to the consumer.

3 To the extent allowed by local law, the remedies provided in this Limited Warranty Statement are the customer’s 
sole and exclusive remedies.
rranty
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C. Limitations of Liability

1 EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THE LIMITED WARRANTY 
STATEMENT, IN NO EVENT SHALL MATROX BE LIABLE FOR:
a any direct, indirect, special, incidental, consequential, foreseeable or unforeseeable, or punitive damages, 

whether based on contract, tort, delict or any other legal theory and whether advised of the possibility of such 
damages; and/or

b damages arising from the loss of use, data, production revenue and/or profit of in connection with the Matrox 
product or any business interruption.

2 Without prejudice to the foregoing, any liability of Matrox for any breach of warranty shall be limited to the 
amount paid by the customer for the defective hardware in question.

3 To the extent allowed by local law, Matrox’s entire liability and the customer’s exclusive remedy shall be the 
repair or replacement of any defective product during the warranty period. Matrox does not offer any other 
warranty with respect to Matrox hardware or software or any other hardware or software.

4 Customer shall be responsible for all applicable taxes, duties and customs fees on any replacement unit, as well 
as all transport, insurance, storage and other charges incurred on all returned products.

D. Obtaining Service in North America
1 Verify that your Matrox product was installed and configured according to the information in its accompanying 

documentation.

2 Read the “Troubleshooting” information included with the Matrox product to see if you can solve the problem 
yourself.

3 If you are still experiencing difficulties, please contact your dealer where you purchased your Matrox product.

4 If you must return a Matrox product, leave the configuration as it was when you were using it, and leave all 
identification stickers on the product. Pack the product in its original box and return to your Matrox dealer where 
the product was purchased, together with your proof of purchase. Your Matrox dealer will return the product for 
you. Alternatively, if this first option is unavailable to you, you may contact the Matrox Technical Support group 
who will issue a Return Merchandise Authorization (RMA) number, upon receipt of adequate proof of purchase, 
and inform you of shipping instructions. DO NOT RETURN THE PRODUCT TO MATROX WITHOUT 
MATROX’S RMA NUMBER AND EXPRESS AUTHORIZATION.

E. Obtaining Service outside North America
1 Verify that your Matrox product was installed and configured according to the information in its accompanying 

documentation.

2 Read the “Troubleshooting” information included with the Matrox product to see if you can solve the problem 
yourself.

3 If you are still experiencing difficulties, please contact your dealer where you purchased your Matrox product.

4 If you must return a Matrox product, leave the configuration as it was when you were using it, and leave all 
identification stickers on the product. Pack the product in its original box and return to your Matrox dealer where 
the product was purchased, together with your proof of purchase. Your Matrox dealer will return the product for 
you.

F. General
This limited warranty shall be governed by the laws of the Province of Quebec, Canada and the federal laws of 
Canada applicable therein and the courts of the Province of Quebec shall have exclusive jurisdiction to hear and 
decide any dispute instituted by the customer in connection with this limited warranty; the customer waives, by 
accepting the product, its rights to institute proceedings in connection with this warranty against Matrox in any 
jurisdiction other than Quebec.
Warranty



iv

So
Software license agreement
Single User Products. This Matrox software (the “Software”) is copyrighted by Matrox Electronic Systems 
Ltd. All rights are reserved. The purchaser is granted a license to use the software only, subject to the following 
restrictions and limitations.

1 The license is for the original purchaser only, and is not transferable without written permission of Matrox.

2 The original purchaser may use the Software on a single computer owned or leased by the original purchaser. 
You may not use the Software on more than a single machine, even if you own or lease more than one machine, 
without written consent of Matrox.

3 The original purchaser may make back-up copies of the Software for his or her own use only, subject to the use 
limitations of this license.

4 The original purchaser may not engage in, nor permit third parties to engage in, any of the following:

✄ Providing or disclosing the Software to third parties.

✄ Providing use of the Software in a computer service business, network, time-sharing, multiple CPU or multi-
user arrangement to users who are not individually licensed by Matrox.

✄ Making alterations or copies of any kind in the Software (except as specifically permitted above).

✄ Attempting to unassemble, de-compile or reverse engineer the Software in any way.

✄ Granting sublicenses, leases, or other rights in the Software to others.

✄ Making copies, or verbal or media translations, of the user’s guide.

✄ Making telecommunication data transmissions of the Software.

Matrox reserves the right to terminate this license if there is a violation of its term or default by the Original 
Purchaser. Upon termination, for any reason, all copies of the Software must be immediately returned to Matrox, 
and the Original Purchaser shall be liable to Matrox for any and all damages suffered as a result of the violation or 
default.

Limited warranty. Matrox warrants to you, for a period of ninety (90) days normal use from your date of 
purchase, that:

1 The CD/disks on which the software is furnished and the documentation are not defective.

2 The Software is properly recorded upon the CD/disks included.

3 The documentation is substantially complete and contains all the information Matrox deems necessary to use the 
software.

4 The Software functions substantially as described in the documentation.

Matrox’s entire liability and your exclusive remedy shall be the replacement of any CD/Disks or documentation not 
meeting these warranties, which is returned to Matrox or an authorized dealer, together with a copy of your paid 
receipt. The above is the only warranty of any kind, either express or implied, including, but not limited to the 
implied warranties of merchantability and fitness for a particular use that is made by Matrox on this Licensed 
Software. In no event shall Matrox be liable to you or to any third party for consequential, special, indirect or 
incidental damages which you may incur as a result of using the licensed software, including, but not limited to, loss 
of data, or information of any kind which you may experience.

This limited warranty shall be governed by the laws of the Province of Quebec, Canada and the federal laws of 
Canada applicable therein and the courts of the Province of Quebec shall have exclusive jurisdiction to hear and 
decide any dispute instituted by the customer in connection with this limited warranty; the customer waives, by 
accepting the product, its rights to institute proceedings in connection with this warranty against Matrox in any 
jurisdiction other than Quebec.
ftware license agreement
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Chapter 1
Introducing Matrox RT.X10 Xtra

This chapter outlines some of 
the features of your RT.X10 
Xtra, lists the contents of your 
kit, and describes the available 
RT.X10 Xtra documentation.
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Welcome
Matrox RT.X10 Xtra is a video editing hardware and software bundle designed 
for home video enthusiasts who want professional results fast. It is part of the 
new generation of Matrox products that incorporate the “Power of X”— a new 
architecture that leverages the scalable power of your CPU with the explosive 
performance of dedicated hardware for the ultimate realtime video editing 
experience.

Matrox RT.X10 Xtra features
Capture faster

• Realtime SinglePass DV scan and capture cuts capture time in half and saves 
wear and tear on your camcorder.

• High-quality capture from VHS, S-VHS, Hi-8, and Video8.

• Single-frame capture from DV tape or a live source lets you easily create 
photomontages.

• Video capture using Video for Windows programs.

Edit in real time—no rendering!
• Full version of Adobe Premiere included.

• Full-quality video output on your TV, while you edit.

• Realtime color correction makes all your shots picture perfect.

• Realtime customizable 3D effects such as page curls, organic wipes, spheres, 
cubes, particles, 3D tiles, and picture-in-picture give your projects a high-
end TV look.

• Realtime adjustable speed control with blended-field processing for super-
smooth slow or fast motion.

• Realtime broadcast-quality titles with dazzling motion effects.

• Multi-track audio mixing lets you easily add soundtracks and music.

Deliver anywhere
• Realtime recording to VHS, S-VHS, Hi-8 and Video8 tape.

• Matrox TurboDV export engine lets you record to DV tape in a flash.

• Hardware-accelerated simultaneous batch encoding of DVD, VCD, SVCD, 
multimedia, and web formats.

• Easy-to-use DVD authoring package (Sonic DVDit! SE) included.

• Free hosting for your web videos at www.matrox.tv.
pter 1, Introducing Matrox RT.X10 Xtra
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Hardware supplied

¦ Note The color of cables or other components in your Matrox RT.X10 Xtra kit 
may vary from the illustration on your Matrox RT.X10 Xtra box.

Software supplied
• Matrox X.tools Includes the necessary drivers for Matrox RT.X10 Xtra, 

and the following software:

$ Matrox realtime plug-in for Adobe Premiere Lets you add realtime 
effects and transitions to your Adobe Premiere projects.

$ Matrox MediaTools A DV capture application that lets you perform 
automatic, unattended DV tape scanning and batch capture in a single pass.

$ Matrox MediaExport Lets you export material from your Adobe 
Premiere projects to Windows Media, RealMedia, and MPEG formats.

$ WYSIWYG DirectShow Control Panel Lets you display video played 
back using Windows Media Player and other supported DirectShow 
applications on your NTSC or PAL video monitor. This gives you a 
WYSIWYG (What You See Is What You Get) video display for checking 
how your clips appear on a TV or other interlaced monitor. If you connect 
an analog video recorder to your RT.X10 Xtra system, you can record your 
clips onto tape as they play back on your video monitor.

• Adobe Premiere A nonlinear video editing program. Adobe Premiere is 
bundled with additional software that you can choose to install, such as 
SmartSound Quicktracks (for soundtrack creation) and demo programs.

• Sonic DVDit! SE An interactive DVD creation program.

RT.X10 Xtra card Breakout cable 4-to-6 pin 
1394 cable
Hardware supplied
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System requirements
Matrox RT.X10 Xtra requires the following minimum system configuration:

• Microsoft Windows XP Home or Professional, or Windows 2000 
Professional with Service Pack 2 or later.

• Intel Pentium III at 1 GHz, Pentium 4 at 1.8 GHz, or 
AMD Athlon XP 1500+.

• 256 MB physical memory (RAM).

• Free PCI slot.

• Display card (Matrox Millennium G550, P650, P750, or Parhelia 
recommended).

• 16-bit sound card (DirectSound-compatible).

• CD-ROM drive for software installation.

• At least 500 MB of free space for software installation on system drive 
(considerably more if installing for all video standards).

• Separate hard drive for A/V content.

• Video camera or VCR.

¦ Note Certain complex effects, or combinations of effects, require a more 
powerful system to prevent dropped frames during playback. Because some 
of the Matrox realtime effects are CPU-based, upgrading to a more powerful 
CPU might allow you to combine more of these effects.

Recommended system configuration:

• Pentium 4 at 2.2 GHz, AMD Athlon XP 2000+, or faster.

• 512 MB RAM.

• Service Pack 1 for Windows XP, or Service Pack 3 for Windows 2000.

• DV-1394 camcorder or VTR.

• NTSC or PAL video monitor.

DualHead and TripleHead editing using Matrox 
display cards
Many video editors prefer the larger desktop workspace that two or three 
monitors can provide. We recommend the Matrox G550, P650, P750, and Matrox 
Parhelia display cards, which are optimized for DualHead and/or TripleHead 
editing with Matrox RT.X10 Xtra.

Check our web site for equipment information
For up-to-date information about recommended computer systems, 
motherboards, and other RT.X10 Xtra-compatible devices such as display cards, 
pter 1, Introducing Matrox RT.X10 Xtra
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sound cards, and DV-1394 devices, see the RT.X Support section of our web site 
at www.matrox.com/videoweb/support.

Style conventions of this manual
The following style conventions are used in this manual:

• The names of files, directory paths, and manuals appear in italics. For 
example:

$ The data is stored in the sample.wav file.

$ The file is located in your C:\Windows\System directory.

$ Please refer to your Adobe Premiere User Guide.

• Menus and commands that you need to choose are displayed in the form 
Menu > Command. For example, File > Save means click File in the 
menu bar, then click Save in the menu that appears.

• The names of keys are displayed in small capital bold letters, such as the 
CTRL key.

• A plus (+) sign is used to indicate combinations of keys and/or mouse 
operations. For example:

$ CTRL+C means to hold down the CTRL key while pressing the C key.

$ SHIFT+click means to hold down the SHIFT key while you click an item 
with the mouse.

A note about screen shots in this manual
Sample screen shots of dialog boxes in this manual were taken on an NTSC 
system with Windows XP installed. If you have a different system configuration 
(such as a PAL system), your settings may not match those of the screen shots.

Other documentation
In addition to this manual, you have access to other documents.

Last-minute information
Any important information that wasn’t available for inclusion in the manual by 
publication time is provided to you in one or both of the following:

• The Readme file installed with the software in the Matrox X.tools folder.

• Printed Release Notes packaged with the manual.

Other electronic documents
The following electronic documents are also available:

• HTML-based online Help installed on your hard drive. 

¦ Note To properly view online Help, you must have Microsoft Internet 
Explorer 4.0 or later (5.0 or later is recommended).
Style conventions of this manual
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• A PDF version of this manual is available from the RT.X Support section of 
our web site (see below).

Web site
We update the RT.X Support section of our web site on a regular basis. You can 
always find the most up-to-date information about your RT.X10 Xtra there. 
See www.matrox.com/videoweb/support.

Installation overview
The following steps summarize the installation procedure for your Matrox 
RT.X10 Xtra system. 

¡ Important Please read the detailed instructions in each chapter before 
attempting the installation.

1 Prepare your system for the RT.X10 Xtra installation. See Chapter 2, 
“Preparing Your System.”

2 Install your RT.X10 Xtra hardware and connect your external devices. See 
Chapter 3, “Installing Your RT.X10 Xtra and Connecting Your Devices.”

3 Install Matrox X.tools, register your RT.X10 Xtra, and install the rest of the 
software. See Chapter 4, “Installing Your Matrox RT.X10 Xtra Software.”

Keep a record of your serial numbers
Take care not to discard the serial numbers provided with your bundled software. 
You usually need these numbers when you install the software, and also when 
requesting software upgrades. It’s a good idea to write down all your serial 
numbers and keep them in a safe place so that you can easily refer to them when 
needed.
pter 1, Introducing Matrox RT.X10 Xtra
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Overview of the preparation steps
In order to ensure a successful RT.X10 Xtra installation and trouble-free 
operation afterwards, there are certain things you must do to prepare your system 
before installing your RT.X10 Xtra hardware and software.

The following list provides an overview of the steps required. These steps are 
explained in greater detail later in this chapter.

1 Plan your storage configuration and install your drives. See page 8.

2 Install Windows XP or Windows 2000 on your system drive. See page 11.

3 Configure your Windows display. See page 11.

4 Configure your sound card. See page 12.

5 Install Adobe Premiere. See page 13.

¡ Important You must follow all the steps in this chapter before attempting to 
install your Matrox RT.X10 Xtra card and software.

1. Plan your storage configuration and install 
your drives

You should plan how you’ll set up your storage devices and then connect them 
accordingly. If you’re installing your RT.X10 Xtra card in an existing system, you 
may have to reconfigure your storage connections for proper performance. If you 
have a new system, it’s important to set up your system right the first time. For all 
cases, the instructions in this section will help you avoid problems or having to 
repeat procedures later on. 

Matrox RT.X10 Xtra data transfer rate 
requirements
To be compatible with the dual-stream operation of Matrox RT.X10 Xtra, the 
storage device you use must sustain a data rate of at least 12 MB/sec.

¦ Note Our tests have shown that 1394 hard drives are not capable of sustaining 
the data transfer rates that are needed for video editing with RT.X10 Xtra. 

General storage considerations
Storage plays a vital role in the overall performance of your Matrox RT.X10 Xtra 
system. Without adequate storage for your audio and video clips, your system 
will not work properly.

Certain issues, such as what to store on your A/V drives, use of the NTFS file 
system, and disk fragmentation, are important to the use of both EIDE and SCSI 
storage devices with Matrox RT.X10 Xtra.
pter 2, Preparing Your System
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A separate Audio/Video (A/V) drive
To use Matrox RT.X10 Xtra, you must store your audio, video, and graphics files 
on an A/V drive reserved solely for this purpose. Windows frequently needs to 
access your system drive for various reasons, so attempting to store your 
audio/video files on your system drive will provide unacceptable performance.

Your system’s virtual memory paging (swap) file must be stored on your system 
drive and not on your A/V drive. By default, Windows stores this file on your 
system drive. For information on how to configure your system’s virtual memory, 
see your Windows documentation.

¦ Note Do not create multiple partitions on your A/V drives. Doing so can 
reduce performance leading to dropped frames in your projects. Make sure you 
have only one partition per A/V drive.

Planning your connections
In addition  to most SCSI devices, almost all recent EIDE storage devices are able 
to meet the data throughput requirements of your Matrox RT.X10 Xtra system. 
You can have only two EIDE devices on each of the two controller connections 
found in most PCs.

The following diagram provides a typical EIDE device configuration for your 
system:

Typical system with separate system and A/V drives

Storage information on our web site
Most hard drives and controller cards manufactured in the past year should be 
suitable for use in your Matrox RT.X10 Xtra system. For more information on 
storage recommendations, and a list of any devices we’ve found to be unsuitable 
for use with RT.X10 Xtra, see the RT.X Support section of our web site at 
www.matrox.com/videoweb/support.
1. Plan your storage configuration and install your drives

www.matrox.com/videoweb/support


10

Cha
Use the NTFS file system
Your A/V drives must be formatted using NTFS for use with Matrox RT.X10 
Xtra because NTFS overcomes FAT32 file size limitations. When a hard drive is 
formatted using FAT32, files saved to this drive cannot exceed 4 gigabytes in 
size. This translates to approximately 20 minutes of DV video, which poses a 
serious limitation to a nonlinear editing platform like your Matrox RT.X10 Xtra 
system.

With NTFS, you also have the option of creating a striped volume, which consists 
of multiple hard drives formatted as a single partition. This allows you to work 
with multiple drives as a single large drive, which offers more disk space and 
enhances hard drive performance. NTFS also provides better audio and video 
synchronization than FAT32 when you play back your clips.

If you already have Windows installed on your computer, you can check the 
format of your drives. In Windows Explorer, right-click the drive letter (such as 
D:), then choose Properties. Under General, check the format of your drive 
next to File system.

If you need to format a drive using NTFS, right-click My Computer, then 
choose Manage. Under Computer Management > Storage, select Disk 
Management. In the Disk Management utility, right-click the appropriate 
drive and choose Format. In the provided dialog box, specify a volume label for 
the partition you are creating. From the File System list, select NTFS. Leave the 
Allocation unit size at Default. Do not select the Enable file and folder 
compression option. If you are formatting the drive for the first time, do not 
select the Perform a quick format option either.

¡ Important All information on the designated drive will be lost.

For more information on how to format your storage devices using NTFS, see 
your Windows documentation.

Disk defragmentation
It’s important to make sure that your storage does not become too fragmented. 
Overly fragmented drives will lead to a major reduction in your system’s 
performance, which will in turn seriously reduce the RT.X10 Xtra’s ability to 
work properly.

¡ Important To ensure that your storage is operating at optimal levels, 
defragment your hard drives regularly (once a month at least).

For information on how to defragment your storage devices, see your Windows 
documentation.
pter 2, Preparing Your System
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2. Install Windows XP or Windows 2000
¡ Important Make sure your RT.X10 Xtra card is not installed in your computer 

when you install your Windows software. If it is, Windows will attempt to install 
software drivers for it. This could cause software conflicts when you install your 
RT.X10 Xtra software.

Install Windows XP (Home or Professional with Service Pack 1 or later) or 
Windows 2000 Professional (with Service Pack 3 or later). If your Windows CD 
does not contain the appropriate service pack, you can obtain the software from 
the Microsoft web site at www.microsoft.com. If you already have Windows 
installed, you can check which service pack is installed by right-clicking My 
Computer, then choosing Properties > General.

¦ Note To carry out the installation and configuration procedures that follow, 
you must log onto an account on your Windows system that has Administrator 
privileges. For details, consult the appropriate Microsoft documentation.

3. Configure your Windows display
Before you install your RT.X hardware and software, you should configure your 
Windows display as follows.

°If you have Windows XP:
1 Right-click your Windows desktop background, then choose Properties.

2 Under the Settings tab, select a Screen resolution of at least 1024 by 768 
pixels (or 2048 by 768 pixels for a dual-monitor setup), and a Color quality 
of Medium (16 bit) or Highest (32 bit). We recommend 16-bit color for 
better performance.

3 Under the Appearance tab, select Normal for Font Size.

4 Under Themes, make sure that you select one of the Windows standard 
themes (that is, the themes that are included with your Windows system).

°If you have Windows 2000:
1 Right-click your Windows desktop background, then choose Properties.

2 Under the Settings tab, select a Screen area of at least 1024 by 768 pixels 
(or 2048 by 768 pixels for a dual-monitor setup), and set your Colors to 
High Color (16 bit) or True Color (32 bit). We recommend 16-bit color for 
better performance.

3 Click the Advanced button, then select Small Fonts for Font Size. Click 
OK.

4 Under the Appearance tab, make sure that you select one of the Windows 
standard schemes (that is, the schemes that are included with your Windows 
system).
2. Install Windows XP or Windows 2000
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¦ Note If you are using a Matrox dual-head display card, to be able to preview 
video (such as in Premiere’s Monitor window) on your second monitor, you 
must set the resolution and color display settings on your secondary monitor to 
the same as your primary monitor.

If you’re using a Matrox P650, P750, or Parhelia 
card
When using a Matrox P650, P750, or Parhelia display card with your RT.X10 
Xtra system, configure your display with a maximum of 16.8 million colors. To 
verify your display settings, right-click your Matrox PowerDesk HF icon on 
your desktop and choose Quality and Performance Settings. In the Quality 
and Performance Settings dialog box, choose Desktop Settings. Under 
Maximum number of simultaneous colors, make sure that 16.8 million is 
selected.

¦ Note When working in Adobe Premiere, do not connect your video monitor to 
the output of your Matrox display card.

4. Configure your sound card
To use your Matrox RT.X10 Xtra, you must have a DirectSound-compatible 
16-bit sound card installed and properly configured with the latest drivers. For 
information on installing your sound card, see the documentation that came with 
your card.

If your system has on-board audio, and you want to install a separate sound card, 
you’ll have to disable the on-board audio in your system’s BIOS. For details on 
how to do this, see your computer’s documentation.

For information on supported sound cards, see the RT.X Support section of our 
web site at www.matrox.com/videoweb/support.

Set your volume levels
To properly capture and play back audio, make sure you’ve set appropriate 
recording and playback volume levels as follows:

1 Double-click the speaker icon on the Windows taskbar.

¥ Tip If you don’t see the speaker icon on your Windows taskbar:

$ In Windows XP, run Sounds and Audio Devices from the Windows 
Control Panel, select Place volume icon in the taskbar, then click OK.

$ In Windows 2000, run Sounds and Multimedia from the Windows 
Control Panel, select Show volume control on the taskbar, then click 
OK.

2 Choose Options > Properties.
pter 2, Preparing Your System
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3 Select the Recording option, then select all check boxes in the list. Click 
OK.

4 For each of the controls (Line-in, Microphone, etc.), make sure the 
Volume sliders are at an appropriate level, such as at half-level. As well, 
clear all the Mute check boxes.

¦ Note Some items in Volume Control may contain a Select check box 
instead of a Mute check box. Enable Select to turn on sound for those items.

5 Choose Options > Properties.

6 Select the Playback option, then select all check boxes in the list. Click OK.

7 For each of the controls (Line-in, Wave, etc.), make sure the Volume sliders 
are at an appropriate level, such as at half-level. As well, clear all the Mute 
check boxes.

8 Close the dialog box.

5. Install Adobe Premiere
You must install Adobe Premiere before installing your RT.X10 Xtra card. If you 
don’t do so, you won’t be able to install Matrox X.tools.

°To install Adobe Premiere:
1 Close all Windows programs.

2 Insert the Adobe Premiere installation CD into your CD-ROM drive.

3 From the CD menu, choose to install Adobe Premiere. When the setup 
program starts, follow the onscreen instructions. If Windows doesn’t 
automatically start the setup program, you can start it manually as follows:

a Choose Start > Run.

b In the resulting dialog box, type e:\premiere\setup (where e: represents your 
CD-ROM drive), and click OK.

4 You can choose to install any other programs or tryouts from the Adobe 
Premiere CD menu.

¦ Note When you install the RT.X10 Xtra software (that is, Matrox X.tools),  
RT.X10 Xtra files will be added to your Adobe Premiere’s Plug-ins folder on 
your hard drive. Therefore, if you later re-install Adobe Premiere to a different 
directory, you’ll need to also re-install Matrox X.tools.
5. Install Adobe Premiere
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Are you ready?
Before continuing, go back over the steps in this chapter and make sure you’ve 
carried out all necessary preparations.

Have you...
X Installed and connected your storage devices?

X Installed Windows XP or Windows 2000 on your system drive?

X Configured your Windows display?

X Installed and configured your sound card?

X Installed Adobe Premiere?

If you’ve prepared your system for RT.X10 Xtra installation, shut down Windows 
and turn your computer’s power off before proceeding to the next chapter.
pter 2, Preparing Your System
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Before you begin
Before proceeding with this chapter, make sure you’ve prepared your system for 
the Matrox RT.X10 Xtra installation as explained in the previous chapter.

Installation overview
The following list provides an overview of the steps to install your RT.X10 Xtra 
card and connect your breakout cable and devices. These steps are explained in 
detail in this chapter.

1 Install your Matrox RT.X10 Xtra card. See the next section.

2 Connect your RT.X10 Xtra breakout cable and computer speakers. See page 
18.

3 If you want to quickly set up a typical editing system, refer to the typical 
RT.X10 Xtra connections. See page 21.

4 Connect your DV-1394 device. See page 24.

5 Connect your composite and S-Video devices. See page 25.

1. Install your Matrox RT.X10 Xtra card
For information specific to your computer, such as how to remove its cover, see 
your computer manual.

²Caution Static electricity can severely damage electronic parts. Before touching 
any electronic parts, drain the static electricity from your body. You can do this by 
touching the metal frame of your computer. Hold your RT.X10 Xtra card by its 
edges and avoid touching its circuitry.

1 Turn off your computer.

2 Unplug your computer, then remove its cover.

3 Choose the appropriate expansion slot for your Matrox RT.X10 Xtra card. 
Certain motherboards require that you install your RT.X10 Xtra card in a 
specific slot. For information on which slot to use for your specific 
motherboard, see the RT.X Support section of our web site at 
www.matrox.com/videoweb/support.

a Most computers have different types of expansion slots. Choose a PCI slot 
for your RT.X10 Xtra card. Your computer manual should identify the 
location of each type of expansion slot in your computer.

²Caution Inserting your Matrox RT.X10 Xtra card into the wrong type of 
slot could damage your card, your computer, or both.

b Remove the brackets from the slot you intend to use. Save the screw for the 
mounting bracket.
pter 3, Installing Your RT.X10 Xtra and Connecting Your Devices
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4 Insert your RT.X10 Xtra card.

a Position your RT.X10 Xtra card over the PCI slot you’ve chosen.

b Push the card in firmly and evenly until it’s fully seated in its slot.

c Using the fastening screw, secure your RT.X10 Xtra card’s bracket to the 
computer frame.

d Replace your computer’s cover.

¡ Important Don’t turn on your computer yet. Proceed to the next section to 
connect your RT.X10 Xtra breakout cable and computer speakers.

RT.X10 Xtra card
1. Install your Matrox RT.X10 Xtra card



18

Cha
2. Connect your RT.X10 Xtra breakout cable 
and computer speakers

To connect your RT.X10 Xtra breakout cable and your computer speakers: 

1 Plug the connector into the RT.X10 Xtra socket labeled VIDEO.

2 Plug the light blue and light green audio connectors (labeled TO AUDIO 
CARD IN and TO AUDIO CARD OUT) into the corresponding colored jacks 
on your sound card. If your sound card doesn’t have colored jacks, refer to 
the labels on the connectors.

¦ Note If your computer speakers are connected to your sound card, unplug 
them from your sound card, then proceed to the next step.

3 To connect your computer speakers, simply plug the connector into the 
RT.X10 Xtra socket labeled AUDIO.

If your sound card has an external breakout box (or “rack”), see the next section 
for details on how to connect your RT.X10 Xtra breakout cable to your audio 
breakout box.

The following illustration shows the TO AUDIO CARD IN cable connected to the 
LINE IN of the sound card. However, you can also connect the cable to another 
input of your sound card, for example, AUX IN. Regardless of the input to which 
you’ve connected the TO AUDIO CARD IN cable, you must specify your analog 
audio input as described in the section “Defining your Capture settings” on 
page 49 in order to capture analog audio.

You can choose to connect your other external devices either before or after 
installing your RT.X10 Xtra software. For details on how to install your software, 
see Chapter 4, “Installing Your Matrox RT.X10 Xtra Software,” on page 31.
pter 3, Installing Your RT.X10 Xtra and Connecting Your Devices
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TO AUDIO CARD OUT
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2. Connect your RT.X10 Xtra breakout cable and computer speakers
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Connections to a sound card with an external 
breakout box
Some sound cards have an external audio breakout box (sometimes referred to as 
a “rack”) to simplify connecting other devices. If you have an external audio 
breakout box, you connect the audio input and output on your RT.X10 Xtra 
breakout cable differently than explained in the previous section.

°To connect to an external audio breakout box:
1 Connect the light blue connector labeled TO AUDIO CARD IN on your 

RT.X10 Xtra breakout cable to the LINE IN jack (or corresponding jack) on 
the front panel of your audio breakout box.

2 Connect the light green connector labeled TO AUDIO CARD OUT on your 
RT.X10 Xtra breakout cable to the FRONT jack (or corresponding jack) on 
the rear panel of your audio breakout box.

The following illustration provides an example of typical connections to an 
external audio breakout box:

¦ Note If the audio input and output cables on your RT.X10 Xtra breakout cable 
aren’t long enough to reach your audio breakout box, simply use extension 
cables. These can be purchased at any electronics store.

RT.X10 Xtra
breakout cable

Audio breakout box
(FRONT)

Audio breakout box
(REAR)

SUB REAR FRONT

LINE IN

To RT.X10 Xtra

TO AUDIO
CARD IN

TO AUDIO
CARD OUT
pter 3, Installing Your RT.X10 Xtra and Connecting Your Devices
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3. Typical RT.X10 Xtra connections
The following illustrations show some typical audio and video connections for 
capturing and printing to tape. If you require a typical studio setup, you can 
quickly set up your editing system by referring to these illustrations. For more 
details on how to connect your devices, see “4. Connect your DV-1394 device” 
on page 24 and “5. Connect your composite and S-Video devices” on page 25.

¦ Note In these illustrations, we’ve connected a video monitor (NTSC or PAL) 
to view the signal that is being captured or recorded, and we’re monitoring audio 
from the sound card to the computer speakers (requires you to connect the small 
connectors to the corresponding jacks of your computer’s sound card, and your 
computer speakers to the AUDIO jack of the RT.X10 Xtra card as explained on 
page  18).

DV-1394 connections

OUT Video monitor
or television

Computer speakers

DV-1394 Device

DV VIDEO

VIDEO

IN
AUDIO L

VIDEO

S-VIDEO

AUDIO R

L R

AUDIO OUT

R

L

VIDEO OUT

S-VIDEO
OUT

AUDIO IN
R

L

VIDEO IN

S-VIDEO
IN

To AUDIO connector
on RT.X10 Xtra card

RT.X10 Xtra
breakout cable

To RT.X10
Xtra

To RT.X10
Xtra
3. Typical RT.X10 Xtra connections
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S-Video connections using same device 
for capture and print-to-tape

Video monitor
or television

S-Video VCR

VIDEO

VIDEO

S- VIDEO
OUT IN

IN

AUDIO L

AUDIO R

To AUDIO connector
on RT.X10 Xtra card

Computer speakers

L R

AUDIO OUT

R

L

VIDEO OUT

S-VIDEO
OUT

AUDIO IN
R

L

VIDEO IN

S-VIDEO
IN

RT.X10 Xtra
breakout cable

To RT.X10 Xtra
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Composite connections using separate source 
and record devices

Video monitor
or television Video recorder

VIDEO

VIDEO

OUT IN
IN

AUDIO L

AUDIO R

Camcorder
(source)

AUDIO L

AUDIO R

VIDEO

S-VIDEO

OUT

L R

Computer speakers

AUDIO OUT

R

L

VIDEO OUT

S-VIDEO
OUT

AUDIO IN
R

L

VIDEO IN

S-VIDEO
IN

To AUDIO connector
on RT.X10 Xtra card

RT.X10 Xtra
breakout cable

To RT.X10 Xtra
3. Typical RT.X10 Xtra connections
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4. Connect your DV-1394 device
Use the supplied 4-to-6 pin cable to plug your DV-1394 device (such as a DV 
camcorder or DV deck) into the 1394 connector on the RT.X10 Xtra card. The 4-
to-6 pin cable will work with most DV devices. Some DV-1394 devices have 6-
pin connectors (in this case, you’ll have to supply your own 6-to-6 pin cable). For 
a list of compatible DV-1394 devices, see the RT.X Support section of our web 
site at www.matrox.com/videoweb/support.

²Caution Use extra care when plugging in or unplugging the 4-to-6 pin 
connector. It’s very easy to bend the connector pins inside your DV-1394 device, 
rendering it useless. Use only minimal force.

1 Plug the 4-pin end of the cable into your DV-1394 device.

2 Plug the 6-pin end of the cable into the 6-pin 1394 connector on your 
RT.X10 Xtra card.

¦ Note In Windows XP, the first time you plug in your DV-1394 device, the 
Digital Video Device dialog box prompts you to select what you’d like 
Windows to do. To avoid having this dialog box appear every time you connect 
your DV-1394 device, click Take no action, select Always perform the 
selected action, then click OK.

Hot-plugging
Your DV-1394 device can be plugged into or unplugged from the RT.X10 Xtra 
card at any time; there’s no need to turn off your computer when connecting or 
removing your device.

¡ Important When connecting your DV-1394 device, make sure it is turned off. 
Once you’ve connected your device, you can turn it on and it will be ready for 
use. Do not try to swap DV-1394 devices while performing a capture in Adobe 
Premiere.

LINE
OUT

LINE
IN

MIC

SPKR
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5. Connect your composite and S-Video 
devices

The RT.X10 Xtra breakout cable has two composite video connectors (one input 
and one output), and two S-Video connectors (one input and one output). Most 
video equipment uses composite video, but some devices (for example, S-VHS 
VCRs) use S-Video, which provides a higher quality video signal.

If you have a video device with S-Video connectors, you should use the Matrox 
S-VIDEO in and out connectors on your breakout cable. You can use the Matrox 
S-Video connectors instead of—or in addition to—the composite video 
connectors. If you use composite and S-Video connectors, you can connect up to 
four video devices to  RT.X10 Xtra at the same time (two input and two output).

RT.X10 Xtra video output is simultaneous on its composite (VIDEO) and 
S-Video (S-VIDEO) lines. Both video input types can be connected at the same 
time, but only one video input signal at a time can be used by RT.X10 Xtra. You 
need to select either the composite video input or the S-Video input signal in 
Adobe Premiere. For more information, see “Defining your Capture settings” on 
page 49.

AUDIO-R VIDEO S-VIDEO

IN

AUDIO-L
AUDIO-RVIDEOS-VIDEO

OUT

AUDIO-L

Composite S-Video S-Video Composite

Input Output
5. Connect your composite and S-Video devices
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Composite input/output connections
1 To connect your composite video source (for capturing material), use either a 

composite audio/video (RCA) cable or three separate cables with RCA 
connectors. On the input side (IN) of your breakout cable:

a Connect the video output from your composite device to the yellow VIDEO 
jack. 

b Connect the left audio output channel of your device to the white 
AUDIO-L jack.

c Connect the right audio output channel of your device to the red 
AUDIO-R jack.

VIDEO
OUT

AUDIO
OUT

L R

AUDIO-R VIDEO S-VIDEO

IN

AUDIO-L

RT2000

Video camera 
or player
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2 To connect your composite video recorder, use another composite (RCA) 
audio/video cable or three more separate cables with RCA connectors. On 
the output side (OUT) of your breakout cable:

a Connect the yellow VIDEO jack to the video input on your video recorder.

b Connect the white AUDIO-L jack to the left audio input of your video 
recorder.

c Connect the red AUDIO-R jack to the right audio input of your video 
recorder.

3 To display the output from Matrox RT.X10 Xtra on your NTSC or PAL 
video monitor1, you can connect your video monitor to the breakout cable or 
your recorder. For an illustration of typical composite connections that you 
can use, see “Composite connections using separate source and record 
devices” on page 23.

1 You can use a TV in place of an NTSC or PAL video monitor. If your TV has a TV/VIDEO 
input switch, set it to VIDEO.

VIDEO
IN

AUDIO
INL R

AUDIO-RVIDEOS-VIDEO

OUT

AUDIO-L

Video 
recorder
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S-Video input/output connections
1 To connect your S-Video source (for capturing material), use an S-Video 

cable, as well as two cables with RCA connectors for audio. On the input 
side (IN) of your breakout cable:

a Connect the video output from your S-Video device to the S-VIDEO jack. 

b Connect the left audio output channel of your device to the white 
AUDIO-L jack.

c Connect the right audio output channel of your device to the red 
AUDIO-R jack.

¦ Note If your video device has only one audio connector, use the left audio 
connector on the cable.

AUDIO
OUT

L R

AUDIO-R VIDEO S-VIDEO

IN

AUDIO-L

S-VIDEO
OUT

Video camera 
or player
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2 To connect your S-Video recorder, use another S-Video cable and two more 
cables with RCA connectors for audio. On the output side (OUT) of your 
breakout cable:

a Connect the S-VIDEO jack to the video input on your video recorder.

b Connect the white AUDIO-L jack to the left audio input of your video 
recorder.

c Connect the red AUDIO-R jack to the right audio input of your video 
recorder.

3 To display the output from Matrox RT.X10 Xtra on your NTSC or PAL 
video monitor1, you can connect your video monitor to the breakout cable or 
your recorder. For an illustration of typical S-Video connections that you can 
use, see “S-Video connections using same device for capture and print-to-
tape” on page 22.

1 You can use a TV in place of an NTSC or PAL video monitor. If your TV has a TV/VIDEO 
input switch, set it to VIDEO.

S-VIDEO
IN

AUDIO
INL R

AUDIO-RVIDEOS-VIDEO

OUT

AUDIO-L

Video 
recorder
5. Connect your composite and S-Video devices



30

Cha
Are you ready?
Before installing the software for your RT.X10 Xtra system as explained in the 
next chapter, go back over the steps in this chapter and make sure you’ve 
completed all necessary operations.

Have you...
X Installed your Matrox RT.X10 Xtra card?

X Connected your RT.X10 Xtra breakout cable and computer speakers?

X Connected your DV-1394 device, if applicable?

X Connected your composite and S-Video devices, if applicable?
pter 3, Installing Your RT.X10 Xtra and Connecting Your Devices
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Installing Your Matrox RT.X10 Xtra

Software
This chapter explains how to 
install the software required to 
use your Matrox RT.X10 Xtra, 
including Matrox X.tools and 
other software.
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Before you begin
Before proceeding with this chapter, make sure you’ve prepared your computer 
as instructed in the preceding chapters. This includes:

• Preparing your system.

$ Plan your storage configuration and install your A/V drive(s).

$ Install Windows XP or Windows 2000.

$ Configure your Windows display for a resolution of 1024×768 (or higher) 
with 16- or 32-bit color.

$ Install and configure your sound card.

$ Install Adobe Premiere.

• Installing your RT.X10 Xtra card and connecting your devices.

Overview of the software installation
Once you’ve installed your Matrox RT.X10 Xtra card and properly connected 
your devices, you can proceed with the software installation. The following list 
provides an overview of the steps required. These steps are explained in greater 
detail in this chapter:

1 Hardware detection. See the next section.

2 Install Matrox X.tools. See page 33.

3 Register your RT.X10 Xtra. See page 34.

4 Install additional software from the RT.X menu. See page 34.

5 Install Sonic Solutions DVDit! SE. See page 35.

1. Hardware detection
Turn on your computer. Once Windows restarts, the “Found New Hardware 
Wizard” detects your RT.X10 Xtra card. Because the Matrox X.tools Setup 
program will automatically detect your devices and install the appropriate 
drivers, simply press ESC or click Cancel to close the “Found New Hardware 
Wizard.” You may have to repeat this procedure several times.

¦ Note The “Found New Hardware Wizard” will only appear the first time you 
start your computer after installing your RT.X10 Xtra card.
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2. Install Matrox X.tools
1 Insert your Matrox RT.X installation CD in your CD-ROM drive. Windows 

automatically starts the Matrox RT.X menu.

2 From the Matrox RT.X menu, choose Install Matrox X.tools.

3 Follow the onscreen instructions to install Matrox X.tools on your computer. 

Remarks
$ To change the language in which you want to run the X.tools Setup program, 

choose Select a different language. All the Matrox RT.X100 Xtra dialog 
boxes and Help files will be displayed in English (if you install X.tools in 
English, French, German, Italian, or Spanish), or Japanese (if you install 
X.tools in Japanese).

$ If you’d like to be able to switch your video standard without re-installing 
Matrox X.tools, select Install all files to be able to switch the video 
standard without re-installing X.tools when prompted. When you want 
to switch your video standard, choose Start > Programs > Matrox 
X.tools > Switch Your Video Standard. 

4 When the Matrox X.tools software installation is complete, you’ll be 
prompted to restart your computer for the changes to take effect.

5 Click OK to restart your computer. You can then register your Matrox 
RT.X10 Xtra as explained in the next section.
2. Install Matrox X.tools
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3. Register your RT.X10 Xtra
When your computer restarts, you can choose Register your RT.X product 
from the RT.X menu to register your RT.X10 Xtra online. You must register your 
RT.X10 Xtra in order to be eligible for customer support and free software 
updates.

If you don’t want to register at this time, you can register later by choosing 
Start > Programs > Matrox X.tools > Register Your RT.X Product. You 
can also register in the RT.X Support section of our web site at 
www.matrox.com/videoweb/support.

4. Install additional software from the RT.X 
menu

After installing Matrox X.tools, you can choose to install additional software 
from the RT.X menu at any time.

¦ Note Not all additional software options are available for Matrox RT.X10 
Xtra.

°To install additional software from the RT.X menu:
1 Insert your Matrox RT.X installation CD in your CD-ROM drive. Windows 

automatically starts the Matrox RT.X menu.

2 From the Matrox RT.X menu, choose the option you want, such as Install 
Matrox RT.X wallpapers, and follow the onscreen instructions.

Installing the Matrox VFW software codecs on a 
system without the RT.X10 Xtra hardware
The Matrox VFW software codecs let you render (compile) and play back 
RT.X10 Xtra-compatible .avi files in your Video for Windows programs without 
having the RT.X10 Xtra hardware installed in your computer.

¦ Note If you have the RT.X10 Xtra hardware, you do not need to install the 
VFW software codecs because Matrox X.tools installs all the required Matrox 
codecs on your system.

°To install the Matrox VFW software codecs:
1 Close all Windows programs.

2 Insert your Matrox RT.X installation CD in your CD-ROM drive.

3 From the Matrox RT.X menu, choose Install Matrox VFW software 
codecs.

4 Follow the onscreen instructions. An information box indicates when the 
installation is complete.
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¡ Important If you later decide to install the RT.X10 Xtra hardware in your 
computer, you must remove the Matrox VFW software codecs from your system 
(using Add/Remove Programs in Windows Control Panel) before installing 
your RT.X10 Xtra hardware and software.

5. Install Sonic Solutions DVDit! SE
To install Sonic Solutions DVDit! SE:

1 Close all Windows programs.

2 Insert the DVDit! SE installation CD in your CD-ROM drive.

3 When the setup program starts, follow the onscreen instructions. If Windows 
doesn’t automatically start the setup program, you can start it manually as 
follows:

a Choose Start > Run.

b In the resulting dialog box, type e:\setup (where e: represents your 
CD-ROM drive), and click OK.

For information on DVDit! SE, see Chapter 10, “Using Sonic DVDit! SE,” on 
page 171.

Removing your Matrox RT.X10 Xtra software
You can remove the Matrox X.tools software from your computer at any time by 
choosing Start > Programs > Matrox X.tools > Uninstall. Uninstalling 
Matrox X.tools removes the Matrox realtime plug-in for Adobe Premiere, as well 
as Matrox MediaExport, Matrox MediaTools, and the WYSIWYG DirectShow 
Control Panel.

¦ Note If Windows prompts you with a Shared File Detected message during 
the uninstall, choose Yes to delete the file, and select Don’t display this 
message again.

If you want to remove any other Matrox software, such as the Matrox RT.X 
wallpapers, use Add/Remove Programs in the Windows Control Panel.

Are you ready?
Before defining your Adobe Premiere settings for use with Matrox RT.X10 Xtra, 
as explained in the next chapter, go back over the steps in this chapter and make 
sure you’ve completed all necessary operations.

Have you...
X Installed Matrox X.tools?

X Registered your RT.X10 Xtra?

X Installed additional software, if required?
5. Install Sonic Solutions DVDit! SE
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Your notes
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Chapter 5
Defining Your Adobe Premiere Settings

This chapter explains how to 
define various settings for 
using your Matrox RT.X10 Xtra 
with Adobe Premiere. This 
includes specifying your 
project and export movie 
settings, and setting up 
DV-1394 device control.
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A note about running other programs with 
Adobe Premiere

For the best performance, don’t run any other programs at the same time as 
Adobe Premiere. Screen savers and programs that use a large amount of system 
memory, such as most paint and compositing applications, can cause problems if 
you run them at the same time as Adobe Premiere.

Loading project presets
The Matrox realtime plug-in for Adobe Premiere includes project presets that 
you can load to immediately apply appropriate RT.X10 Xtra settings.

°To load an RT.X10 Xtra project preset:
1 Start Adobe Premiere. The Load Project Presets dialog box appears.

2 From the Matrox DV folder, select the preset, such as DV (DV-1394 Input), 
that matches the type of project you want to create.

3 Click OK to apply the settings. You can customize your project settings as 
explained in the following sections.

Setting up your scratch disks
When specifying the location of your scratch disks in Adobe Premiere, make sure 
you follow the recommendations in your Adobe Premiere User Guide. For 
example, store your video and audio files on an A/V drive used exclusively for 
that purpose.

°To specify your scratch disks:
1 Choose Edit > Preferences > Scratch Disks and Device Control.

2 Under Scratch Disks, select an A/V drive for Captured Movies, Video 
Previews, and Audio Previews. 

3 Click OK to save your preferences.

Remarks
• If you switch your video standard (as explained on page 33), you’ll have to 

set up your scratch disks again.

• For information on setting up device control for your DV camera or deck, 
see “Setting up DV-1394 device control” on page 55.

Setting your low disk space warning level
Before you perform an export to disk in Premiere, you must have enough disk 
space for your exported project. If you have low disk space during an export, 
Premiere can become unstable. To avoid this problem, you should specify a high 
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low disk space warning level. This will enable you to delete files when you’re 
warned, and resume the export.

°To set your low disk space warning level:
1 Choose Edit > Preferences > General and Still Image.

2 In the Low Disk Space Warning Level box, enter a high warning level, 
such as 100000 K.

3 Click OK to return to your project.

Defining your General settings
The Matrox Advanced Settings dialog box has several pages that you can use 
to specify various settings for editing in Adobe Premiere on Matrox RT.X10 
Xtra. 

¦ Note Any settings or options that are not applicable to Matrox RT.X10 Xtra 
will be unavailable.

°To specify your General settings on Matrox RT.X10 Xtra:
1 Choose Project > Project Settings > General.

2 From the Editing Mode list, select Matrox RT.X.

3 Click the Advanced Settings button. By default, the General tab is 
displayed.

4 Under Analog Setup (NTSC), select the setup level you want for your 
NTSC analog video. For example, select 0 IRE (DV-compliant) when using
DV-1394 devices that follow the Japanese NTSC standard. For details, see 
“Selecting your NTSC setup level for analog video” on page 40.

5 Under Editing Aspect Ratio, select the aspect ratio that matches your 
source material. For example, select 4:3 if your video was recorded using 
the standard TV screen format. For details, see “Selecting your editing 
aspect ratio” on page 41.
Defining your General settings
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6 Under Scrubbing Type, you can switch between Field 1 and Field 2. You 
may want to do this, for example, if you see “glitches” when playing back 
your Timeline that don’t appear when you subsequently scrub on the 
Timeline. For details, see “Switching between scrubbing types” on page 42.

7 Under Error Reporting, select Report dropped frames if you want to be 
warned each time frames are dropped when you play back video from the 
Timeline. Otherwise, clear this option. We recommend that you leave 
Report dropped frames selected so that you’ll be aware of any 
performance issues with your system.

8 Under Speed Change Processing, select how realtime speed changes are 
to be processed. Blend fields typically works well on standard and 
slow-paced video, and Repeat fields typically works well on fast-action 
video. For details, see “Selecting your speed control method” on page 42.

9 Click OK to save your settings and return to the Project Settings dialog 
box. You can specify additional General settings as explained in your Adobe 
Premiere User Guide.

Selecting your NTSC setup level for analog 
video
Most commercial DV cameras that have a 1394 interface follow the Japanese 
specification for analog NTSC video, where the black level (setup) is 0 IRE. The 
standard setup level for analog NTSC video in North America, however, is 
7.5 IRE. 

The black level used for the digital bit stream is the same for both Japanese and 
North American video equipment. This means that when you capture DV video 
over the 1394 interface on Matrox RT.X10 Xtra, the video is captured at the 
correct black level. When you play back the captured clips on your NTSC 
monitor, however, you may find that the video appears too bright or colors appear 
to be washed out. This is because the default setup level for the analog output of 
Matrox RT.X10 Xtra is 7.5 IRE, whereas your DV camera’s analog output uses 
the Japanese setup level of 0 IRE.

°To change the setup level of your analog NTSC video on Matrox RT.X10 
Xtra:

1 Choose Project > Project Settings > General.

2 Click the Advanced Settings button.
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3 Under Analog Setup (NTSC) on the General page, select one of the 
following setup levels. This affects both the analog video input and output.

$ 0 IRE (DV-compliant) Applies a setup level of 0 IRE. You should select 
this option only when working with a commercial DV-1394 device that uses 
the Japanese analog NTSC setup of 0 IRE. For example, if the video appears 
too bright when you play back DV clips on your NTSC monitor, you can 
change the setup to 0 IRE to output your DV clips at the correct brightness.

$ 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

¦ Note If your DV-1394 device has a different NTSC setup level for input and 
output, you can switch the setup level as needed before capturing clips or 
exporting to tape. If you’re not sure which setup level your DV-1394 device 
uses for input and output, check with your device’s manufacturer.

4 Click OK to return to the Project Settings dialog box. Your new setup level 
will take effect only after you restart your computer.

Selecting your editing aspect ratio
To specify the aspect ratio of the material you’re editing on Matrox RT.X10 Xtra:

1 Choose Project > Project Settings > General.

2 Click the Advanced Settings button.

3 Under Editing Aspect Ratio on the General page, select the aspect ratio 
that matches your source material. This ensures that your effects will be 
displayed with the correct proportions.

$ 4:3 Select this if your video was recorded using the standard TV screen 
format.

$ 16:9 Select this if your video was recorded using the widescreen 16:9 
format.

¡ Important If the editing aspect ratio isn’t set correctly, certain effects may 
appear distorted (that is, squeezed or stretched horizontally). Make sure you 
create all animations, titles, and graphics for your production using the same 
aspect ratio as your source video. For example, when creating your own 
organic wipe patterns for use in a widescreen production, make sure you 
create your organic wipes with a 16:9 aspect ratio. For more information, see 
“Creating a production in 16:9 format” on page 63.

4 Click OK to return to the Project Settings dialog box.
Defining your General settings
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Switching between scrubbing types
When you play back the Timeline, both fields of each frame are displayed. When 
you scrub the Timeline, however, only one field is displayed. As well, only one 
field is displayed when you pause or stop playback on the Timeline. For example, 
if you see a “glitch” in your project when you play it back from the Timeline, but 
notice that when you scrub on the Timeline to find the glitch, you can’t find it, 
you may need to switch the field you’re scrubbing over. You can then return to 
your Timeline and find the problem by scrubbing.

°To change your scrubbing type:
1 Choose Project > Project Settings > General.

2 Click the Advanced Settings button.

3 Under Scrubbing Type on the General page, select either Field 1 or 
Field 2.

4 Click OK to return to the Project Settings dialog box, then click OK again 
to return to the Timeline.

5 When you scrub the Timeline, or pause or stop playback on the Timeline, 
only the particular field you selected will be displayed.

Selecting your speed control method
Your Matrox RT.X10 Xtra provides two methods of processing realtime speed 
changes in your Premiere projects. Depending on whether most of your project is 
slow-paced video or fast-action video, you can choose the type of speed control 
that’s best suited for your video project.

°To specify your speed control method:
1 Choose Project > Project Settings > General.

2 Click the Advanced Settings button.

3 Under Speed Change Processing on the General page, select one of the 
following: 

$ Blend fields Interpolates between the video fields, and typically works 
well on standard or slow-paced video and camera pans.
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$ Repeat fields Mimics the classic “bob and weave” algorithm found on 
Betacam machines, and typically works well on fast-action video.

¦ Note The speed change processing option you select applies to all speed 
changes in your current project. Therefore, select the option that best suits the 
type of video you use most often in your project. For details on how to apply 
speed changes to your clips, see your Adobe Premiere User Guide. 

4 Click OK to return to the Project Settings dialog box.

Selecting your codec options for rendering
On the Codec (Rendering) page of the Matrox Advanced Settings dialog 
box, you can choose whether or not you want Matrox RT.X10 Xtra to show your 
render results in Premiere’s Monitor window, as well as select your color space 
conversion options.

When you render material in your Adobe Premiere project on Matrox RT.X10 
Xtra, such as preview files for non-realtime effects, you can determine how you 
want the chroma information to be processed during the color space conversion 
that’s performed during the render.

¦ Note The default settings for color space conversion provide good results for 
most applications. We recommend that you change these settings only when 
needed for special purposes.

°To select your codec options for rendering:
1 Choose Project > Project Settings > General. 

2 Click the Advanced Settings button, then click the Codec (Rendering) 
tab.

3 Under Monitor Window, select Show render results on computer 
monitor if you want to view your render results in Premiere’s Monitor 
window. You can clear this option to improve the speed of rendering.
Defining your General settings
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4 Under Color Space Conversion, select the options you want:

$ Chroma filtering and Chroma interpolation Select these options to 
adjust the chroma bandwidth of RGB graphics. This improves images that 
have abrupt changes between different colors, such as a blue box on a black 
or white background. You should select these options for most animation 
and compositing work (computer-generated material). For most video 
material, however, it’s best that you not select these options. If you find that 
your rendered images appear to be blurred, try clearing one or both of these 
options.

$ Chroma sampling for fast-motion video Select this option to help 
eliminate artifacts such as jagged edges and unwanted lines at the edges of 
fast-motion video (for PAL video only). 

¡ Important When rendering graphics and titles, make sure that Chroma 
sampling for fast-motion video is not selected, as this option can cause 
jagged edges to appear in your rendered images.

5 Click OK to return to the Project Settings dialog box.

Selecting your DV-1394 settings
On Matrox RT.X10 Xtra, you can define various settings for working with 
DV-1394 devices, such as which DV stereo streams you’d like to capture, and the 
NTSC time code format of your DV tapes.

°To select your DV-1394 settings:
1 Choose Project > Project Settings > General.

2 Click the Advanced Settings button, then click the DV-1394 tab.

3 Under Export to Tape, you should select Enable video preview during 
export. This lets you preview the video you’re exporting to tape on your 
computer monitor. Some systems and DV-1394 devices, however, don’t 
support this option. If you’re unable to perform an export to tape, try clearing 
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Enable video preview during export. The preview will be disabled on 
your computer monitor, but you can preview the video on your camcorder’s 
viewfinder and on your NTSC or PAL monitor (assuming you’ve connected 
the analog video output of your DV-1394 device to your video monitor).

¦ Note If you clear Enable video preview during export after a failed 
DV-1394 export to tape, you’ll need to restart your computer before starting 
the export to tape again.

4 Under 1394 Audio Capture, select which DV stereo audio streams you 
want to capture. If you capture only one DV stereo stream, the audio stream 
of your stereo clip will be embedded in your .avi file, creating a single 
interleaved audio and video file. If you choose to capture both DV stereo 
streams, the second audio stream will be saved to a separate audio file named 
clipID_2ndStream.wav.

Remarks
$ Some DV-1394 devices let you capture only one stereo audio stream. For 

more information, consult the documentation that came with your DV-1394 
device.

$ When capturing audio over the 1394 interface with certain DV devices 
(such as Sony or Canon), the left and right channels may be inverted in the 
resulting file. If this happens, you can select Invert left and right channels 
to correct this problem.

5 If you have an NTSC system, under Tape Time Code Format, select the 
format that matches the format on your DV tapes.

6 Click OK to return to the Project Settings dialog box.
Defining your General settings
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Selecting your realtime effect settings
You can specify default cropping settings for your realtime Matrox effects, as 
well as select which Premiere transitions you’d like to play back in real time. For 
example, all of the Matrox transitions are realtime, whereas Adobe Premiere’s 
transitions require rendering. With the Matrox realtime plug-in, however, you can 
select which Adobe Premiere transitions you’d like to play back in real time.

°To select your realtime effect settings:
1 Choose Project > Project Settings > General.

2 Click the Advanced Settings button, then click the Realtime Effects tab.

3 Under Default Cropping for Matrox Effects, select Enable cropping and 
specify in pixels the default cropping values that you want to be applied each 
time you create an effect using the Matrox realtime plug-in. For example, if 
garbage video or black lines appear at the left and right edges of your video, 
you’ll want to crop these edges so that they’re not visible in your effects. Be 
aware that your new crop settings will be applied only to subsequent clips 
you add to the Timeline (that is, clips already on the Timeline won’t be 
affected).

Remarks
$ Unless you need cropping to be applied to your clips, make sure that Enable 

cropping is not selected. This improves system performance.

$ If you’ve applied cropping, make sure you apply the same cropping settings 
when you perform a Premiere export to disk on your Matrox RT.X10 Xtra 
system (see “Performing a Premiere export to disk” on page 54). If your 
project and export cropping settings don’t match, incorrect cropping will 
be applied to your Timeline immediately after completing the export. To 
restore the correct settings, save your project, then quit and restart Premiere.

4 Under Realtime Premiere Transitions, click the Select Transitions 
button.

5 In the provided dialog box, select the transitions you want to play back in 
real time. Matrox provides realtime playback by emulating Premiere’s 
non-realtime version of these transitions. If you don’t like a realtime 
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transition, you can clear (deselect) it to revert to Premiere’s version that 
requires rendering.

¦ Note Some Premiere transitions let you apply various settings that may 
cause frames to be dropped during realtime playback. If this happens, you 
should clear those transitions to turn off the realtime playback.

6 Click OK to return to the Matrox Advanced Settings dialog box, then 
click OK again to return to the Project Settings dialog box.
Defining your General settings
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Defining your Video settings
Your project’s Video settings determine the compression format for playing back 
video from the Timeline. On Matrox RT.X10 Xtra, your Timeline’s compression 
format is set to DV/DVCAM at a fixed data rate of 25 Mb/sec.

°To specify your project’s Video Settings on Matrox RT.X10 Xtra:
1 Choose Project > Project Settings > Video.

¦ Note The Compressor is automatically set to Matrox DV/DVCAM. This 
codec will be used to render your preview files when playing back 
non-realtime effects.

2 From the Frame Rate list, select 29.97 if you have an NTSC system, or 25 
if you have a PAL or SECAM system.

3 From the Pixel Aspect Ratio list, select the setting that matches the aspect 
ratio of the material you’re editing:

$ D1/DV NTSC (0.9) For NTSC material that uses the standard TV screen 
format.

$ D1/DV NTSC Widescreen 16:9 (1.2) For NTSC material that uses the 
widescreen 16:9 format.

$ D1/DV PAL (1.067) For PAL material that uses the standard TV screen 
format.

$ D1/DV PAL Widescreen 16:9 (1.422) For PAL material that uses the 
widescreen 16:9 format.

4 Click OK to save your settings. 

Defining your Audio settings
When you set your project’s Editing Mode to Matrox RT.X (see “Defining your 
General settings” on page 39), your project’s Audio settings are automatically set 
to 48000Hz, 16 Bit – Stereo, Uncompressed.

You can specify additional Audio settings as explained in your Adobe Premiere 
User Guide. 

¡ Important For the best performance, use only 48 kHz, 16-bits/sample (stereo) 
audio in Adobe Premiere.
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Defining your Capture settings
Matrox RT.X10 Xtra lets you capture your video to DV/DVCAM format at a 
fixed data rate of 25 Mb/sec. Video captured from your DV-1394 device over the 
1394 interface is captured in native DV format.

°To specify your settings for capturing material in Adobe Premiere on 
Matrox RT.X10 Xtra:

1 Choose Project > Project Settings > Capture.

2 From the Capture Format list, select Matrox AVI Capture to capture to a 
DV/DVCAM .avi file.

3 If you’ll be capturing audio with your video, make sure that both Capture 
Video and Capture Audio are selected.

¦ Note Make sure you’ve correctly set your sound card’s volume levels for 
recording and playback as explained in the section “Set your volume levels” 
on page 12.

4 To select the audio and video sources from which you want to capture 
material, click the A/V Inputs button.

5 From the Video Source list, select Composite, S-Video (Y/C), or 
DV-1394. For example, to capture your composite input to Matrox RT.X10 
Defining your Capture settings
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Xtra, select Composite. To capture material from your DV-1394 device 
over the 1394 interface, select DV-1394. If you want to capture material 
from your DV camera or deck using device control over the 1394 interface, 
you must set up the device control as explained in the section “Setting up 
DV-1394 device control” on page 55. If you don’t set up this device control, 
you can capture your clips by manually controlling your DV-1394 device.

6 If you selected an analog video source, you must also select the audio source 
from which you want to capture material from the Analog Audio Source 
list. Your audio source must match your audio input (that is, where you’ve 
connected the light blue connector labeled TO AUDIO CARD IN on your 
breakout cable, as explained on page 18. For example, if you plugged the TO 
AUDIO CARD IN connection into the Line-In jack (or corresponding jack) 
on your sound card, choose Line-In from the Analog Audio Source list. 

Remarks
$ All supported audio sources will appear in the Analog Audio Source list, 

but in most cases the recommended source will be the default. If your audio 
input connection does not appear in the list, you must unplug the TO AUDIO 
CARD IN connector on your breakout cable and connect it to an audio input 
on your sound card that appears in the list.

$ If your analog audio source appears with an * beside it in the list, your sound 
card does not have matching audio inputs and outputs. In this case, choose 
the audio source with an * that matches your audio input, make sure that 
your source is playing back audio, and click Advanced Settings. In the 
provided dialog box, select an Analog Audio Passthrough. If you can 
hear audio, then you’ve selected the correct analog audio source and 
passthrough. If you can’t hear audio, try selecting a different analog audio 
source and/or passthrough.

7 If you selected DV-1394 as your video source, select which DV stereo audio 
streams you want to capture. If you capture only one DV stereo stream, the 
audio stream of your stereo clip will be embedded in your .avi file, creating a 
single interleaved audio and video file. If you choose to capture both DV 
stereo streams, the second audio stream will be saved to a separate audio file 
named clipID_2ndStream.wav.

Remarks
$ Some DV-1394 devices let you capture only one stereo audio stream. For 

more information, consult the documentation that came with your DV-1394 
device.

$ When capturing audio over the 1394 interface with certain DV devices 
(such as Sony or Canon), the left and right channels may be inverted in the 
resulting file. If this happens, you can select Invert left and right channels 
to correct the problem.
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8 Under Source Type, specify the type of analog equipment you’re using:

$ Broadcast-quality Select this if your source device is broadcast-quality, 
such as a device with a built-in time base corrector (TBC). This allows 
RT.X10 Xtra to digitize the input signal as-is.

$ Consumer-quality Select this if your source device doesn’t have a time 
base corrector or meet broadcast-quality standards. RT.X10 Xtra will then 
filter the input signal to increase tolerance for sync pulse instability.

9 Under VCR Tracking, the Tight setting gives you the best results with most 
analog source tapes. When using poor-quality analog tapes, select Looser to 
improve the video playback, similar to when you adjust the tracking on your 
home VCR.

10 Click OK to return to the Project Settings dialog box.

11 To adjust the proc amp settings for the analog (S-Video or composite) video 
that you’ll be capturing, click the Proc Amps button.

¦ Note Once you’ve captured your video clips, you can apply proc amp 
changes and other color corrections to your clips on the Timeline using the 
Matrox color correction effect. For details, see “Applying a pre-created color 
correction” on page 79.

12 Use the proc amp controls as needed to adjust the incoming analog video 
signal before starting the capture. To return a control to its factory default 
setting, click the Def button. 

$ Hue Adjusts the tint of the colors in the image.

$ Saturation Adjusts the saturation (vividness) of the image’s colors.

$ Contrast Adjusts the difference in luminance between the lightest and 
darkest areas of the image.

$ Brightness Adjusts the level of black in the image.

13 Click OK to save your proc amp changes and return to the Project Settings 
dialog box. 
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You can specify additional Capture settings as explained in your Adobe Premiere 
User Guide.

Running the Audio Capture Drift Detection test
The first time you perform an analog capture in Adobe Premiere, you’ll be 
prompted to run the Audio Capture Drift Detection test. This test ensures proper 
audio and video synchronization between your sound card and your Matrox 
RT.X10 Xtra hardware during analog captures. Click Start to run the test (it will 
take about five minutes to complete). Once the test is finished, your capture 
window will open.

¡ Important If you choose not to run the Audio Capture Drift Detection test and 
click Cancel, you won’t be able to perform analog captures in Premiere until you 
run the test.

Once you’ve completed the test, you won’t be prompted to run the test again 
unless:

• You’ve changed your sound card. 

• You have more than one sound card installed in your computer and have 
selected a different sound card as your preferred device for sound recording 
(capture). For details on how to change your preferred device for sound 
recording, see your Windows documentation.

There are, however, several instances in which you’ll want to manually start the 
test again:

• You’ve replaced your sound card with a similar model. (If you replace your 
sound card with a different model, the Matrox realtime plug-in will 
automatically prompt you to run the test again.)

• You’ve updated or re-installed the drivers for your sound card.

• You’ve moved your sound card to another slot in your computer.
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°To run the Audio Capture Drift Detection test manually:
1 Choose Start > Programs > Matrox X.tools > Audio Capture Drift 

Detection.

2 From the Test Duration list, select a duration for the test. In most cases, five 
minutes will give you good results.

¦ Note If you often perform long analog captures (longer than one hour), it’s 
recommended that you select one of the longer test durations, such as 
10 minutes.

3 Click Start to run the test.
Defining your Capture settings
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Performing a Premiere export to disk
Adobe Premiere lets you export video from the Timeline to a single DV/DVCAM 
.avi file for purposes such as distribution on CD-ROM and publishing on the web. 
Several software codecs are included with Adobe Premiere so that you can export 
your video to different formats. Your Matrox RT.X10 Xtra system adds the 
Matrox DV/DVCAM codec to the ones included with Premiere. Because the 
Matrox codec uses your RT.X10 Xtra hardware to accelerate rendering, it can 
export video much faster than when you use a software codec.

¦ Note The Matrox MediaExport plug-in for Adobe Premiere lets you export 
your project to various web-optimized and MPEG formats (see Chapter 9, “Using 
Matrox MediaExport”). 

°To export your Timeline to a Matrox DV/DVCAM .avi file:
1 Depending on whether you want to export your Timeline or only the current 

frame from your Timeline, do one of the following: 

$ To export all or part of your Timeline, choose File > Export Timeline > 
Movie. Click the Settings button, and from the File Type list, select 
Matrox RT.X.

$ To export only the current frame from your Timeline, choose File > Export 
Timeline > Frame. Click the Settings button, and from the File Type list, 
select Matrox RT.X Single-frame AVI.

2 From the menu at the top of the dialog box, select Video.

3 From the Pixel Aspect Ratio list, select the setting that matches the aspect 
ratio of the material you’re editing:

$ D1/DV NTSC (0.9) For NTSC material that uses the standard TV screen 
format.

$ D1/DV NTSC Widescreen 16:9 (1.2) For NTSC material that uses the 
widescreen 16:9 format.

$ D1/DV PAL (1.067) For PAL material that uses the standard TV screen 
format.

$ D1/DV PAL Widescreen 16:9 (1.422) For PAL material that uses the 
widescreen 16:9 format.

4 If you’re exporting all or part of your Timeline, it’s recommended that you 
do not select Recompress. This retains the quality of your video. It also 
optimizes the speed of the export because realtime segments that have no 
effects will be copied directly to disk without recompression. 

5 Click OK to save your export settings.
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Setting up DV-1394 device control
With Matrox RT.X10 Xtra, you can take advantage of the DV-1394 device 
control on your DV camera or deck when capturing or recording material in 
Adobe Premiere. 

¡ Important To be able to perform a frame-accurate export to tape, you must use 
Matrox DV-1394 device control.

°To set up this device control:
1 Choose Edit > Preferences > Scratch Disks and Device Control.

2 Under Device Control, select Matrox DV-1394 Device Control.

3 Click Options to display the following dialog box:

4 If you have an NTSC system, select the format that matches the time code 
format on your DV tapes (Drop frame or Non-drop frame).

5 Under Seek Method, if you’re having trouble controlling your DV-1394 
device, select an alternate method to improve its performance. For example, 
if your DV-1394 device stops responding after performing a batch capture or 
cues incorrectly to an In/Out point on tape, you can experiment with 
alternate seek methods until you find the one that works best with your 
DV-1394 device. 

¦ Note Most devices work best with the default seek method. If, however, an 
alternate seek method improves the performance of an RT.X-compatible 
DV-1394 device, this will be mentioned in the RT.X Support section of our 
web site.

6 Click OK to return to the Preferences dialog box, then click OK to save 
your settings.
Setting up DV-1394 device control
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You can now use device control when capturing or recording material using your 
DV-1394 device (make sure your device is set to Remote or VTR Mode). Device 
control will be available when capturing or recording material over the 1394 
interface, and also when capturing the analog input from your DV-1394 device, 
such as the composite input.

For details on how to capture material in Adobe Premiere, see your Adobe 
Premiere User Guide. To record your Adobe Premiere Timeline onto DV tape 
using device control, see “Exporting your Timeline to DV tape” on page 57.

¦ Note When capturing material using DV-1394 device control, the Preroll 
Time and Timecode Offset features are not supported. If you want to capture 
material from a composite or S-Video deck, make sure you select None under 
Device Control.
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Exporting your Timeline to DV tape
You can export DV material from your Adobe Premiere Timeline to tape using 
device control over the 1394 interface on Matrox RT.X10 Xtra.

Preparing your tapes for recording
To use DV-1394 device control, the tape on which you’ll be recording your DV 
material must contain continuous and consecutive time code. You can stripe your 
entire tape with time code by recording black video for the duration of the tape. 
To do this, insert a blank tape into your camcorder, put the lens cap on, then 
record up to the end of the tape.

¦ Note The format of your DV tape must match the format you’re recording. For 
example, if you set your DV-1394 device to record in DV/DVCAM format, your 
tape must be striped entirely in DV/DVCAM format. Mixed format tapes are not 
supported. 

Obtaining a frame-accurate export to tape
In order to achieve a frame-accurate export to tape, you need to specify various 
export options. The values you enter for these options depend on the DV-1394 
device you are using. Preset values are available for some devices. You can 
download the latest DV-1394 device presets from the RT.X Support section of our 
web site at www.matrox.com/videoweb/support. If no presets are available for 
the device you are using, you will need to do a test export to obtain the correct 
values. For more information, see “Defining your export to tape options” on 
page 60.

Exporting to DV tape with device control
To export your Timeline to tape over the 1394 interface:

1 Make sure your DV device is properly connected, turned on, and that you’ve 
selected Matrox DV-1394 Device Control in Adobe Premiere’s 
Preferences dialog box as explained in “Setting up DV-1394 device 
control” on page 55.

¦ Note If you’re using a camcorder, switch it to VTR Mode. 

2 Load a tape that you’ve striped with time code into your device.

3 Open the project you want to export to tape. 
Exporting your Timeline to DV tape
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4 Choose File > Export Timeline > Export to Tape. This displays the 
following dialog box:

5 Indicate which Channels you want to export by selecting Export video 
and/or Export audio. If you decide to export audio only, black video will 
accompany your audio. 

6 By default, the edit points are displayed in time code format. If you would 
like to display the edit points in frames, select Show time code in frames.

¥ Tip To toggle between the two formats, press CTRL+SHIFT while the 
insertion point (flashing vertical bar) is in a time code field.

7 To mark the In point where you want to start recording on your tape, play 
your tape using the transport controls provided in the dialog box, then click 
the Mark In button when you see the frame you want. You can also type the 
In point you want in the Mark In field. 

8 Under Export Setup, specify how you want the export to be done, such as 
whether you want to record color bars at the start of your tape, and record 
your entire project or just the work area. 

¦ Note You can enter values in the Duration fields only. The In Point fields 
are automatically adjusted for you based on the values you enter in the 
Duration fields. Items are recorded on your tape in the order they are listed 
in the dialog box.

$ Color Bars To add color bars at the start of your recording, enter a 
duration for the amount of time you want the color bars to be recorded. 

¦ Note Color bars are accompanied by a 1-kHz audio tone.
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$ Logo To add a logo to your recording, click the Browse button to locate 
the logo you would like to add, then enter the duration for the logo. The 
logo must be a full-screen, 32-bit, uncompressed .tga file.

$ Leading Black To add black video to the start of your project, enter a 
corresponding duration.

9 From the Project list, select Entire Project to export your entire project, or 
Work Area to export the range marked by the work area bar.

10 To add black video to the end of your project, enter a value in the Duration 
field for Trailing Black. 

11 Click Export to start the export to tape.

¦ Note Your project (or work area) will be rendered by Adobe Premiere 
before the export.
Exporting your Timeline to DV tape
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Defining your export to tape options
In order to achieve a frame-accurate export to tape, you need to specify various 
export options. The values you enter for these options depend on the DV-1394 
device you are using. 

¦ Note Not all DV-1394 devices are frame-accurate. For more information, 
please see the RT.X Support section of our web site at 
www.matrox.com/videoweb/support.

°To define your export options:
1 Choose File > Export Timeline > Export to Tape, then click the Options 

button.

2 From the Preset list, select the model that matches (or most closely 
matches) the DV-1394 device you are using. This will immediately apply the 
appropriate export options for that device.

Remarks
$ For Matrox RT.X10 Xtra, you must select a Non-RT preset, such as Sony 

DSR-45 NTSC (Non-RT). 

$ You can download the latest DV-1394 device presets from the RT.X Support 
section of our web site at www.matrox.com/videoweb/support. If a preset 
is not available for your DV-1394 device, you will need to do a test export 
to obtain the correct values. Once you’ve got the right values, type the name 
of your device in the Preset box and click the Save button. Your settings 
will be saved in the Preset list for future use.
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3 Under Offset Times for Recording, specify the appropriate values for your 
DV-1394 device.

$ The first value delays the playback of your project to allow your DV-1394 
device time to start recording. For example, some devices require a delay 
between the time they receive the record command and the time the project 
starts playing back from your computer.

$ The second value lets you specify when the command to stop recording 
should be sent to your DV-1394 device. For example, if your DV deck takes 
time to stop recording, the stop command must be sent before the end of 
the project is reached. Alternately, if your deck buffers video prior to 
recording, the stop command must be sent late.

¡ Important The values under Offset Times for Recording are 
interdependent. Before changing these settings, you should first do a test 
export to tape with both values set to zero. If you’re missing frames from the 
start of your project, specify a delay for the project playback and do another 
test. Once you’ve set the correct delay to obtain frame accuracy at the start of 
the recording, you can adjust the other setting as needed to obtain frame 
accuracy at the end of the recording. 

4 If the In point at which the recording starts on your tape doesn’t match the 
Mark In point you specified for the export, use the value under In Point 
Adjustment to correct it. For example, if you set your Mark In point to 
1:00:20:10 and your deck actually started recording at 1:00:20:12, then you 
would enter -2.

5 If you have an NTSC system, select the format that matches the time code 
format on your DV tape.

6 Click OK to save your settings and return to the Matrox DV Export to Tape 
dialog box.
Exporting your Timeline to DV tape
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Things you need to know about using DV-1394 
devices

Please keep the following points in mind when using a DV-1394 device with 
Matrox RT.X10 Xtra to capture or record DV material in Adobe Premiere:

• Set your camcorder to either Camera Mode (to capture live video), or VTR 
Mode (to capture from tape or record material onto DV tape). 

¥ Tip When in Camera Mode, make sure that the cassette compartment is 
empty to avoid possible auto-shutdown of the camera.

• Captured DV audio is sampled at a rate of 48 kHz, 16-bits/sample. Any 
audio recorded at a lower sampling rate or bit depth will be resampled to 
these values. For the best results, it’s recommended that both your camcorder 
and DV deck be able to support 16-bit, 48 kHz audio.

• To use DV-1394 device control, your DV tapes must contain continuous and 
consecutive time code, and all material on the tape must be recorded at the 
same speed. Leaving blank gaps between recorded material results in 
discontinuous time code. To avoid this problem, stripe your entire tape with 
time code before recording your source material (see “Preparing your tapes 
for recording” on page 57). The existing time code will be used when you 
shoot your footage and any gaps between sections of recorded material will 
have continuous time code.

• When performing an export to tape, the format you are recording must match 
the format on your DV tape. For example, if you set your DV-1394 device to 
record in DV/DVCAM format, your tape must be striped entirely in 
DV/DVCAM format. Mixed format tapes are not supported.

• The DV-1394 device control requires about six seconds of preroll before 
capturing material. Therefore, don’t record material that you want to capture 
within the first six seconds of your DV tape.

• When using DV-1394 device control, the running time code display in 
Adobe Premiere may temporarily stop. This has no effect on your captured 
clips. When the display resumes, the correct time code will be displayed.

• When performing a batch capture, you’ll see video in the preview window 
while the clips are being captured, but not while Adobe Premiere searches 
for each clip’s In point. If you’ve connected the analog output from your 
DV-1394 device to an NTSC or PAL video monitor, you’ll see the video 
being played on your video monitor. You may want to use the toggle 
switches on your video monitor to switch between viewing the output from 
your DV-1394 device and the output from the RT.X10 Xtra breakout cable.
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Creating a production in 16:9 format
When editing on Matrox RT.X10 Xtra, you can choose to work with source video 
that’s been recorded in either the 4:3 standard TV screen format, or the 
widescreen 16:9 format. 

°To create a production in 16:9 format on Matrox RT.X10 Xtra, do the 
following:

1 Record your video onto tape with your camera set to the widescreen 16:9 
format. The video will be recorded as horizontally compressed 4:3 video.

2 Start Adobe Premiere, then set your editing aspect ratio to 16:9 as explained 
in the section “Selecting your editing aspect ratio” on page 41. This ensures 
that the effects you create on Matrox RT.X10 Xtra will be displayed with the 
correct proportions when viewed in 16:9 format.

¦ Note When editing in 16:9 format, certain pre-created Matrox organic 
wipes may appear distorted. For example, circular wipes will appear 
elongated.

3 Capture your video clips as you normally would. Select the 16:9 display 
option on your NTSC or PAL video monitor to “unsquish” the video and 
play it back in widescreen format without distortion. 

4 If you create animations, titles, or graphics (including organic wipe patterns) 
for your production using a program that lets you set the pixel aspect ratio, 
use the appropriate setting for 16:9 display:

$ On an NTSC system, set the pixel aspect ratio to 1.185.

$ On a PAL system, set the pixel aspect ratio to 1.422.

If you can’t set the pixel aspect ratio, create your image at 853×480 (NTSC) 
or 1024×576 (PAL). After you’ve created your image, resize only its width 
to 720. When you resize the image, your text or graphic will appear 
elongated on your computer screen.

5 Edit your production as you would a standard 4:3 production. Make sure you 
change the pixel aspect ratio setting for your project to D1/DV NTSC 
Widescreen 16:9 (1.2) or D1/DV PAL Widescreen 16:9 (1.422), as 
explained in the section “Defining your Video settings” on page 48.

¦ Note Be aware that if your video monitor is displaying in 4:3 format, certain 
effects may appear elongated because of the horizontal scaling. Setting your 
monitor to 16:9 will display the effects with the correct proportions.

6 Record your finished production onto tape. Remember that you’ll need a 
monitor capable of displaying material in 16:9 format to properly view your 
master tape.
Creating a production in 16:9 format
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Your notes
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Available effects
The Matrox realtime plug-in for Adobe Premiere lets you:

• Set up spectacular realtime 2D and 3D effects and transitions, using up to 
two video clips and four graphics clips. The plug-in includes color 
corrections, page curls, cubes, particles, 3D tiles, spheres, organic wipes 
(including Pixélan Software’s Video SpiceRack Lite), and 2D/3D DVE 
effects such as picture-in-picture, tumbles, and spins.

• Set up over 60 Adobe Premiere transitions in real time.

• Transform and crop your realtime effects by adding or modifying keyframes.

• Create graphics overlays using single-frame graphics files with an alpha-key 
channel.

• Create realtime fade (video opacity) effects using Adobe Premiere’s Opacity 
rubberband.

• Apply realtime speed changes to video clips.

Realtime means that you can play back and record your effects onto tape without 
having to render them. This gives you creative freedom to experiment with 
different effects and change your mind as often as you want. You’ll instantly see 
the changes you make on your NTSC or PAL video monitor. Effects in Adobe 
Premiere other than those listed above are not realtime, and therefore require 
rendering. For guidelines on setting up your realtime effects, see “How to place 
your effects to avoid rendering” on page 67, and “RT.X10 Xtra realtime rules” on 
page 111.

When you install the Matrox realtime plug-in, the Matrox effects are added to 
Adobe Premiere so that you can include them in your video productions. You set 
up Matrox effects in your productions the same way as other effects included 
with Adobe Premiere. For example, you apply a Matrox transition to your clips 
just as you would any other type of transition, except that the dialog box provided 
lets you create a Matrox transition, as is explained in this chapter.

For instructions on how to apply Adobe Premiere effects to your productions, 
refer to your Adobe Premiere User Guide. For details on selecting which Adobe 
Premiere transitions you want to play back in real time, see “Selecting your 
realtime effect settings” on page 46.

¡ Important To use the Matrox realtime plug-in, you must have defined your 
Adobe Premiere settings for use with your Matrox RT.X10 Xtra, as explained in 
Chapter 5, “Defining Your Adobe Premiere Settings.”
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How to place your effects to avoid rendering
All the Matrox effects require a certain amount of preload time that’s determined 
by the capabilities of your system (both CPU and storage). To keep your effects 
realtime, use the following guidelines when setting up your effects:

• Leave a gap of at least two seconds between the end of one Matrox particle 
effect and the start of the next.

• Arrange all other Matrox effects, cuts, and single-frame graphics on your 
Timeline with a minimum duration of one second between the starting point 
of each clip.

Two-second gap between 
particle effects

One second between the 
starting point of each clip
How to place your effects to avoid rendering
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• When playing the Timeline, a maximum of four single-frame graphics clips 
can be stored in the Matrox RT.X10 Xtra buffer. Because each clip requires 
one second to clear the buffer before the next graphics clip on the Timeline 
can be preloaded, you’ll need to leave an appropriate gap between your 
graphics clips depending on how many graphics are loaded in the buffer for a 
given sequence, and how many graphics need to be pre-loaded for the next 
sequence.

The following sequence of graphics clips follows the proper spacing 
guidelines by not having more than four clips in the buffer at a time:

¦ Note Because of the spacing restrictions for single-frame graphics files, 
graphics sequences (such as .tga and .bmp sequences) are not supported on 
Matrox RT.X10 Xtra.

2 sec

3 sec

4 sec

1 sec

3 sec
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How to apply a Matrox transition in Adobe 
Premiere

In Adobe Premiere, all of the transitions can be found in the Transitions palette. 
By default, the Matrox transitions are found in the Matrox folder.

An easy way to create a Matrox transition is to drag the desired effect from the 
Transitions palette to the Transition track of the Timeline (between clips on the 
Video 1A and 1B tracks). To set up your Matrox transition, double-click the 
transition’s icon on the Timeline. This opens the Matrox Effect Setup dialog 
box.

¦ Note To change the default transition, see “Specifying a default Matrox effect” 
on page 72.

How to apply a Matrox video effect in Adobe 
Premiere

The Matrox realtime plug-in for Adobe Premiere allows you to apply many 
realtime video effects to your clips. To apply a Matrox video effect to a clip, drag 
the desired effect from the Video effect palette onto the clip on the Timeline. By 
default, the Matrox video effects are found in the Matrox folder.

To set up your Matrox video effect, click Setup beside your effect in the Effect 
Controls palette. This opens the Matrox Effect Setup dialog box.

¦ Note To change the default video effect, see “Specifying a default Matrox 
effect” on page 72.

Applying Matrox video effects to graphics
If you want to apply a Matrox video effect to a graphics clip placed on a 
superimpose track (Video 2 or higher), you must apply an Alpha Channel key to 
the clip in order to see the underlying image in your effect. To do this, right-click 
your graphics clip on the superimpose track and choose Video Options > 
Transparency. In the Transparency Settings dialog box, choose Alpha 
Channel as the Key type.

¥ Tip You can also select the graphics clip on the Timeline and press CTRL+G to 
open the Transparency Settings dialog box.
How to apply a Matrox transition in Adobe Premiere
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Using common controls in the plug-in
When you apply a Matrox realtime effect, a dialog box similar to the following 
appears (the resulting dialog box depends on the type of effect that you apply):

These items are common to most Matrox realtime effects:

✐ Directory This directory tree holds all of the effects for each transition or 
video effect type. If any effects have been added or deleted since the last 
time you selected a directory, a dialog box will appear with a summary of the 
changes.

✑ Effect tabs Several tabs are available to let you switch between pages for 
setting up your effect:

$ “Pre-created effect” tab This tab displays the default page that appears 
when you first apply a Matrox effect. On this page, you can select a 
pre-created effect from the Directory, for the type of effect that you’ve 
applied (such as any of the available page curls).

$ Transform tab Click this tab to display the Transform page, where you 
can apply various settings to transform your clip, such as to resize and rotate 

✐

✑
✒ �

✔

✕

✖
✗
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your clip. For details on the available transform settings, see “Transforming 
your clip” on page 91.

$ Crop tab Click this tab to display the Crop page, where you can apply 
crop settings to your effect, such as to remove unwanted edges. For details 
on using the crop settings, see “Cropping your effect” on page 95.

¦ Note The Transform and Crop tabs are not available for all Matrox effects.

✒ Effect List This section provides a small sample (icon) representing each 
effect. Simply click an effect to select it. If you’re creating a transition, “A” 
and “B” represent your clips on the Video 1A and 1B tracks, respectively. If 
you’re creating a video effect, “A” represents the clip on which you’re 
applying the effect, and “B” represents your underlying (background) image 
on the lower tracks.

� Preview Window Allows you to see the result of your chosen effect. Your 
effect will also be displayed on your NTSC or PAL video monitor.

✔ Effect modifiers By selecting Allow changes, you can change various 
settings for the effect (these will differ for certain transitions and video 
effects). These settings are active for the duration of your clip. Not all 
Matrox effects have effect modifiers on the pre-created page.

✕ Keyframe controls Several controls are provided in this section to let you 
move around to different points on your clip and create keyframes. For 
details, see “Working with keyframes” on page 99.

$ Toolbar Provides buttons for the most commonly used keyframe tasks. 
Only buttons that can be used at a given time are available.

$ Tracks and Ruler The tracks represent the progression of your effect over 
time, with the Ruler above the tracks denoting your effect’s frame numbers. 
You can create keyframes on the tracks to change a clip’s settings over time, 
such as to make a clip progressively shrink and expand.

$ Positioner You use the Positioner (vertical bar) to preview an effect by 
dragging it across the Ruler (scrubbing), or to specify at which frame you 
want to create a keyframe on the track. To move the Positioner to a particular 
frame, enter the frame number in the Current frame box, or click the frame 
on the Ruler. You can also right-click the Positioner or Ruler to display a 
pop-up menu with commands for moving the Positioner.

$ Zoom buttons You use the + or – zoom button to zoom in or out on the 
tracks. You can use this feature to find a certain frame, or range of frames, 
within your effect.

✖ Reverse Select this to reverse the direction of the pattern for your selected 
effect.
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✗ Force render Select this to force your effect to be rendered when you 
return to the Timeline. Certain effects, particularly particle effects, are 
difficult for some systems to play back in real time without dropping frames. 
If you find that this is happening, select Force render. The effect will appear 
with a red bar over it when you return to the Timeline, indicating that the 
effect requires rendering. Once rendered, the effect will play back smoothly. 

Specifying a default Matrox effect
The first time you apply a Matrox transition or effect to your Timeline, a default 
effect is applied. This default effect is usually the first effect in the Effect List. 
You can change the default effect for each effect category (advanced DVEs, page 
curls, etc.). 

°To change the default Matrox effect:
1 Set up the Matrox effect on the Timeline.

2 In the Matrox Effect Setup dialog box, locate the effect you want from the 
Effect List. If needed, select a different folder under Directory to find the 
effect you want.

3 Right-click the effect you want as the default effect, and choose Set as 
Default Effect from the pop-up menu. 

¦ Note The name of your default effect or transition will be highlighted in 
orange in the Effect List.

The next time you apply this category of Matrox effect to your Timeline, the 
default effect will be applied.
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Previewing your effects
There are several ways to preview your effects:

• Preview entire effect Click the Preview button at the bottom of the 
page, or press ALT+SPACEBAR.

• Preview from Positioner Press SPACEBAR. To stop the preview, press 
SPACEBAR again.

• Preview a specified range To highlight the range you want to preview, 
SHIFT+drag on the Ruler. Click the Preview button to view the range 
you’ve specified. To clear the selected range, CTRL+click the Ruler.

• Scrub through your effect Drag the Positioner through the section of the 
effect you want to preview. You can also ALT+drag the Positioner to 
render-scrub your effect (same as when you render-scrub the Timeline). 

• Toggle track state for previewing By default, the track state is set to 
preview all tracks every time you open the Matrox Effect Setup dialog box 
(that is, the effect track, Transform track, and Crop track). You can switch 
between previewing all tracks, one track only, or without the current effect 
by toggling the track state as follows:

$ Preview current track’s effects Click the Toggle Track State button 
on the toolbar once (or press CTRL+F2) to disable all tracks except the 
current track. Use any of the methods for previewing your clip. Your effect 
is shown with only the settings of the highlighted track applied. For 
example, if you want to add a colored border to your advanced DVE, but 
the transform and crop settings are obscuring the clip, click the Toggle 
Track State button to see the advanced DVE without the transform and 
crop settings. 

$ Preview without current effect Click the Toggle Track State button 
on the toolbar again (or press CTRL+F2) to disable all the tracks. Use any 
of the methods for previewing your clip. Your clip is shown without the 
current effect applied.

¦ Note Click the Toggle Track State button again to return to the default 
track state (that is, previewing all tracks).

• Preview current source only Click the Solo Mode button on the toolbar 
(or press F2). Only the source for the effect that you are currently editing is 
previewed. All other effects on your clip and all other sources on the 
Timeline are ignored. If you’ve exceeded the realtime capabilities of your 
RT.X10 Xtra system (see “RT.X10 Xtra realtime rules” on page 111), solo 
mode will automatically be set and the Solo Mode button won’t be 
available. To see the segment with all applied effects, use the render-scrub 
feature (ALT+drag the Positioner).
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¥ Tip If you have added a realtime fade to your clip using Adobe Premiere’s 
Video Opacity rubberband control, clicking the Solo Mode button allows 
you to temporarily remove the transparency setting without having to return 
to the Timeline.

Using text boxes and sliders
Text boxes and sliders are provided to let you adjust the settings for most of the 
Matrox effects. For example, the Softness text box and slider on the Page Curls 
page let you create a soft edge for your effect.

To adjust a setting, do one of the following:

• Enter the value you want directly in the text box.

• Drag up and down within the text box.

• Click inside the text box, then press the up and down arrow keys. You can 
also use the PAGE UP and PAGE DOWN keys to adjust the value by 10 at a 
time.

• Drag the slider to the left or right. For a faster but less precise adjustment, 
SHIFT+drag the slider.

¥ Tip To return a text box and slider to its default setting, click the  
button, or CTRL+click the slider or slider bar.

Undoing and redoing changes
You can undo and redo most changes you make to the settings of an effect in the 
Matrox Effect Setup dialog box, up to a maximum of 15 changes. To undo the 
last change made to the settings of an effect, click the Undo button on the 
toolbar, or press CTRL+Z. To redo the changes, click the Redo button on the 
toolbar, or press CTRL+Y. 

You can continue to choose Undo or Redo to sequentially undo or redo up to 15 
of your most recent changes. If a particular change can’t be undone, the Undo 
button won’t be available. 

Slider
Default button
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Selecting colors
Several Matrox effects provide a “color picker” button to let you choose the color 
you want for the effect, such as the border color for an advanced DVE.

When you click a  button, the Color dialog box appears:

°To select your color:
1 Click one of the basic colors on the left side of the dialog box, or click the 

color you want inside the Color refinement box.

2 Adjust your color’s luminance by clicking inside the Luminance bar or by 
dragging the arrow beside it.

3 Alternatively, if you know your desired color’s Hue, Saturation, and 
Luminance values, or Red, Green, and Blue values, you can enter them in the 
corresponding text boxes.

✐ Color refinement box ✑ Luminance bar

Color picker 
button

✐

✑
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Creating a 3D tile
When you apply a Matrox 3D tile, the 3D Tiles page appears:

°To set up a 3D tile:
1 Choose the type of effect you are looking for in the Directory.

2 Click the particular effect you want from the Effect List.

3 To see a preview of your effect at any time, click the Preview button.

4 To change the settings for your selected 3D tile pattern, select Allow 
changes, then use the 3D tile modifiers as follows:

$ Rows Sets the number of rows in your 3D tile pattern.

$ Columns Sets the number of columns in your 3D tile pattern.

$ Spread Determines the number of tiles that rotate at the same time.

$ Softness Sets the softness on the border of your clip and on the edges of 
the tiles.

$ Rotation Type Select a type from this list to change the orientation of 
the 3D tile pattern.

5 If you want to apply or change various transform settings, such as to change 
your clip’s size, position, and rotation settings, see “Transforming your clip” 
on page 91.
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6 When you are satisfied with your effect, click OK to return to your Timeline.

Creating an advanced DVE
When you apply a Matrox advanced DVE, the Advanced DVEs page appears: 

°To set up an advanced DVE:
1 Choose the type of effect you are looking for in the Directory. For example, 

click the PiP Effects folder under 3D DVE Effects to display a list of 
available 3D picture-in-picture effects.

¥ Tip Static 2D or 3D DVE effects are not suitable for use as transitions. For 
example, the static effects listed in the 2D DVE Effects PiP Effects folder do 
not switch from one source to another. Such effects are designed to be 
applied as video effects only, and should not be used as transitions.

2 Click the particular effect you want from the Effect List.

3 To see a preview of your effect at any time, click the Preview button.

4 To create a border or soft edge on your clip, select Allow changes, then use 
the Border modifiers as follows:

$ Colors Click the first  button to select the border color you want. To 
create a border consisting of a gradient between two colors, select the option 
beside the second  button, then click that button to select your other 
color. For details on how to select colors, see “Selecting colors” on page 75.
Creating an advanced DVE
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$ Width Sets the width of the border, in pixels.

$ Softness Lets you adjust the softness of the edge or border on your clip. 
The higher the softness value, the less sharp the edge or border becomes.

5 To display a shadow behind your clip, make sure that Allow changes is 
selected, then use the Shadow modifiers as follows:

$ Color Click the  button to select the color of your shadow.

$ Transparency Sets the transparency of your shadow. Levels range from 
opaque (0) to fully transparent (100).

$ X Offset Sets the position of your shadow with respect to the horizontal 
edges of your clip. Negative numbers move the shadow to the left, and 
positive numbers move the shadow to the right.

$ Y Offset Sets the position of your shadow with respect to the vertical 
edges of your clip. Negative numbers move the shadow to the bottom, and 
positive numbers move the shadow to the top.

$ Z Offset Sets the depth of your shadow behind your clip.

6 If you want to apply or change various transform settings, such as to change 
your clip’s size, position, and rotation settings, see “Transforming your clip” 
on page 91.

7 When you are satisfied with your effect, click OK to return to your Timeline.
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Applying a pre-created color correction
When you apply a Matrox color correction, the Color Corrections page 
appears:

¦ Note You can apply Matrox color corrections to video clips only. To correct 
the color of your graphics clips, you can use an image-editing program (such as 
Adobe Photoshop).

°To set up a color correction effect:
1 Click the particular effect you want from the Effect List.

¥ Tip If you want to modify your clip without using any of the pre-created 
settings, select the _Dud effect.

2 To change the settings for your selected color correction effect, see “Creating 
a custom color correction” on page 80.

3 To see a preview of your effect at any time, click the Preview button.

4 When you are satisfied with your effect, click OK to return to your Timeline.
Applying a pre-created color correction
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Creating a custom color correction
To customize the settings for your Matrox color correction, click the Custom 
Color Corrections tab or the ColorCor track:

By selecting Simple edit, all settings are applied for the duration of your clip. 
This means that you’ll have only one keyframe at the first frame of your clip. If 
you want to change settings at different frames of the clip, you’ll have to clear 
Simple edit.

You can customize your color correction using the following:

• Proc Amps The processing amplifier (proc amp) controls allow you to 
adjust different aspects of your clip:

$ Hue Adjusts the tint of the colors in the image.

$ Saturation Adjusts the saturation (vividness) of the image’s colors.

$ Contrast Adjusts the difference in luminance between the lightest and 
darkest areas of the image.

$ Brightness Adjusts the level of black in the image.

• Color Balance These controls let you adjust the mixture of colors in your 
clip.
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¦ Note Any changes you make to the color balance (cyan to red, magenta to 
green, or yellow to blue) affect your clip globally, from the lightest white to 
the darkest black.

$ Auto Balance When you click this button, an eyedropper tool appears 
over your image in the Preview Window. Click the eyedropper tool on an 
area of white or gray in your image. This automatically applies a color shift 
to your clip to compensate for different lighting conditions.

¥ Tip You can also use a keyboard shortcut to select Auto Balance. Press A, 
then use the eyedropper tool.

$ Color sliders Drag a slider toward a color you want to increase in your 
clip, or away from a color you want to decrease. You can also enter a value 
in the text box beside each slider. Increasing a color by a certain value 
automatically decreases the opposite color by the same value. For example, 
if you move the Cyan/Red slider towards red, you also decrease cyan by 
the same amount, as shown in the following diagram:

MAGENTARED

YELLOW BLUE

CYANGREEN
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Creating a cube effect
When you apply a Matrox cube effect, the Cubes page appears:

°To set up a cube effect:
1 Choose the type of effect you are looking for in the Directory.

2 Click the particular effect you want from the Effect List.

¦ Note If you want to modify your clip without using any of the pre-created 
settings, select the _dud effect.

3 To see a preview of your effect at any time, click the Preview button.

4 To change the settings for your cube effect, select Allow changes, then use 
the cube modifiers as follows:

$ Thickness Specifies the width between the front and back sides of your 
cube, in pixels. This sets the depth of your cube.

$ Shadow  Adjusts the intensity of the shadow on the side of the cube that 
is spinning downwards. Click the  button to select the color of your 
shadow.

$ Highlight Adjusts the intensity of the highlight on the side of the cube 
that is spinning upwards. Click the  button to select the color of your 
highlight.
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$ Softness Lets you adjust the softness of the outer edge or border on your 
cube.

5 If you want to apply or change various transform settings, such as to change 
your clip’s size, position, and rotation settings, see “Transforming your clip” 
on page 91.

6 When you are satisfied with your effect, click OK to return to your Timeline.
Creating a cube effect
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Creating an organic wipe
When you apply a Matrox organic wipe, the Organic Wipes page appears: 

°To set up an organic wipe:
1 Choose the type of effect you are looking for in the Directory.

2 Click the particular effect you want from the Effect List.

3 To see a preview of your effect at any time, click the Preview button.

4 To create a soft edge on the border of your organic wipe, select Allow 
changes, then drag the Softness slider. The higher the value, the less sharp 
the edge of your organic wipe becomes.

5 When you are satisfied with your effect, click OK to return to your Timeline.

¦ Note The Matrox organic wipes are not transformable (that is, the 
Transform track is not available when setting up organic wipes). You can, 
however, add your own patterns as explained in “Adding your own organic 
wipe patterns” on page 85.
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Adding your own organic wipe patterns
You can create your own organic wipe patterns and add them to the Matrox 
realtime plug-in for use in your projects. Organic wipes use grayscale gradient 
patterns to switch from one image to another by gradually revealing the second 
image in a certain pattern. A progressive transition occurs between your initial 
image (Video 1A), represented by the white areas of your gradient pattern, and 
your final image (Video 1B), represented by the black areas.

The following pattern is used for the 2-Corner Diag organic wipe in the Matrox 
plug in:  

When you apply this organic wipe, you’ll see it affect your clips halfway through 
the transition like this:

✐Video 1A ✑Video 1B

✐

✑

✐

✑
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Creating a subdirectory for your new organic wipes
Your new organic wipes must be added to a subdirectory where you installed 
Matrox X.tools. If you chose the default location when you installed Matrox 
X.tools, your Matrox organic wipes will be installed at:

Program Files\Matrox X.tools\Effects\Organic Wipes

Under the Organic Wipes directory, create a new subdirectory in which to store 
your own organic wipe patterns, such as:

Program Files\Matrox X.tools\Effects\Organic Wipes\My Patterns

¡ Important To create your own organic wipe patterns for use in a 
widescreen production, create them with a 16:9 aspect ratio. For more 
information, see “Creating a production in 16:9 format” on page 63.

Creating your own organic wipe patterns in Adobe 
Photoshop LE

1 Start Adobe Photoshop LE, then choose File > New.

2 In the New dialog box, define the size of your image:

$ For an NTSC image, select 720 pixels for Width and 480 pixels for 
Height.

$ For a PAL image, select 720 pixels for Width and 576 pixels for Height.

¥ Tip If you want to create an organic wipe for use in a widescreen (16:9) 
production, create your image at 853×480 (NTSC) or 1024×576 (PAL). 
After you’ve created your image, resize only its width to 720. When you do 
this, your graphic will appear elongated on your computer screen.

3 Choose Image > Mode, then select Grayscale and 8 bits/channel.

4 Create your organic wipe pattern using any of the tools in the toolbox. The 
gradient tools, however, work best for creating organic wipe patterns.

5 When finished, choose File > Save As, name your file, select Targa [*.tga, 
*.vda, *.icb, *.vst] as the file type, and select your subdirectory under the 
Organic Wipes directory.

6 When you open your subdirectory within the Matrox realtime plug-in for 
Adobe Premiere, you’ll see that the new effect was found, and an icon of 
your pattern will be added to the Effect List.

¦ Note While these instructions are for creating organic wipe patterns with 
Adobe Photoshop LE, you can use any image-editing software—as long as you 
specify the correct image size, select 8-bit grayscale, and save your pattern as a 
.tga file. If your program provides the option of saving your .tga file as 
Compressed or Uncompressed, make sure you select the Uncompressed 
option.
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Creating a page curl
When you apply a Matrox page curl, the Page Curls page appears: 

°To set up a page curl:
1 Choose the type of effect you are looking for in the Directory.

2 Click the particular effect you want from the Effect List.

3 To see a preview of your effect at any time, click the Preview button.

4 To create a soft edge on your page curl, select Allow changes, then drag the 
Softness slider.

5 If you want to apply or change various transform settings, such as to change 
your clip’s size, position, and rotation settings, see “Transforming your clip” 
on page 91.

6 When you are satisfied with your effect, click OK to return to your Timeline.
Creating a page curl
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Creating a particle effect
When you apply a Matrox particle effect, the Particles page appears:

°To set up a particle effect:
1 Choose the type of effect you are looking for in the Directory.

2 Click the particular effect you want from the Effect List.

3 To see a preview of your effect at any time, click the Preview button.

4 To change the settings for your effect, select Allow changes, then use the 
particle effect modifiers as follows:

$ Spread Sets the progression of the effect. The higher the spread, the 
closer to the beginning of your clip the particles start to explode. For 
example, a spread of 100 indicates that all particles start to explode at the 
first frame of the clip, and a spread of 20 indicates that all particles explode 
by the 80% point of the clip.

$ Speed Sets the speed at which the particles explode.

$ Border Softness Sets the softness on the border of your clip.

$ Seed Sets the random behavior of the pattern. Each value (from 0 to100) 
represents a different random pattern.

$ Vanishing particles Select this to make the particles vanish after they 
explode.
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$ Particle softness Select this to soften the edges of the particles that 
haven’t exploded yet.

$ Reverse sequence Select this to reverse the pattern of the effect.

5 If you want to apply or change various transform settings, such as to change 
your clip’s size, position, and rotation settings, see “Transforming your clip” 
on page 91.

6 When you are satisfied with your effect, click OK to return to your Timeline.
Creating a particle effect
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Creating a sphere effect
When you apply a Matrox sphere effect, the Spheres page appears:

°To set up a sphere effect:
1 Choose the type of effect you are looking for in the Directory.

2 Click the particular effect you want from the Effect List.

3 To see a preview of your effect at any time, click the Preview button.

4 To change the settings for your effect, select Allow changes, then use the 
sphere modifiers as follows:

$ Light Intensity Drag the slider to change the brightness of the highlight 
in your sphere.

$ Remove back face Select this option to remove the back face of your 
sphere. This option is useful if you’re applying transparency to your clip 
and do not want to see the back face of your clip through your sphere.

5 If you want to apply or change various transform settings, such as to change 
your clip’s size, position, and rotation settings, see “Transforming your clip” 
on page 91.

6 When you are satisfied with your effect, click OK to return to your Timeline.
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Transforming your clip
To apply various transform settings to your clip, such as to resize, position, and 
rotate your clip, click the Transform tab or the Transform track:

• Position Lets you position your clip on x-y-z coordinates (horizontal, 
vertical, depth).

• Size Lets you resize your clip.

• Offset Lets you move the pivot point for rotating your clip.

• Rotation Lets you set the number of spins of the clip on its x, y, or z axis.

You can adjust the transform settings in the following ways:

• Use the transform controls to select the settings you want.

• Choose commands from the Transform menu to set a particular size and 
position, such as half-screen size in the bottom-right corner.

• Work directly in the Preview Window using your mouse. For example, you 
can click and drag to resize, rotate, or position your clip.

¦ Note Many of the Matrox effects, such as advanced DVEs, already have 
transform settings defined as keyframes on the Transform track. For details on 
how to change a clip’s transform settings over time by creating and editing 
keyframes, see “Working with keyframes” on page 99.
Transforming your clip
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Using the transform controls
You can use the text boxes or sliders to position, resize, or rotate your clip. For 
information on how to use the text boxes and sliders, see page 74.

°There are four types of transform settings that you can work with:
• Position Use these controls to position your clip on the x (horizontal), y 

(vertical), and z (depth) axes. Values of (0,0,0) pixels align the center of your 
clip with the center of the screen, and positions are measured from this point. 
You can enter positive or negative pixel values to move your clip right or left 
(x), up or down (y), and forward or backward (z).

• Size Use these controls to make your clip smaller or larger. Full-screen 
size is represented as 100%. You can shrink your clip to 0% or enlarge it to 
1000%. Note, however, that by enlarging your clip, the resolution may 
become blurry. You can adjust the size controls individually, or if you select 
Fixed aspect ratio, you only need to adjust one axis, and the others 
automatically take the same value. Adjusting the percentage on the x and y 
axes changes your clip’s width and height, respectively. You’ll only notice 
adjustments to the z axis when you have depth in your effect, such as in the 
advanced DVE effects.

• Offset and Rotation Use the Offset controls to set the pivot point, or 
center of rotation, of your clip. When Rotation settings are applied, your 
clip spins around this point. You can use positive or negative pixel values to 
offset your clip on the x (horizontal), y (vertical), and z (depth) axes. Each 
rotation of 360° produces one spin on the selected axis. You can have 
positive or negative rotation from -3600° to 3600°, which is equal to -10 to 
10 spins, depending on the direction you want your clip to rotate.
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In the illustrations below, notice how different Offset values can affect the 
rotation of the cube.

In Figure 1, the Offset values are (0,0,0), so the center of rotation for the cube is 
where the x, y, and z axes meet. In Figure 2, the Offset value for the x axis is set 
to 100, thus moving the cube and the pivot point to the right, so when the cube is 
rotated, it has a wider arc when spinning around the axes.

Using the Transform menu
You can also resize and position your clip by choosing commands from the 
Transform menu, located below the Preview Window.

• Default Restores your clip to its default settings (full-screen size of 100%, 
and all other transform controls at 0).

• Use Safe Title Area Restricts the DVE Position presets (see below) to the 
Safe Title Area. This is the central area of the screen where you can safely 
position your clip to be sure it will be visible on all monitors.

• DVE Size Lets you select a preset to resize your clip. The presets range 
from full-screen down to invisible.

• DVE Position Lets you select a preset to position your clip, such as 
Bottom Right. If Safe Title Area is selected, it will serve as the reference 
for positioning your clip. If it isn’t selected, your clip will be positioned 
relative to the entire screen area.

Y

X

Z

Y

X

Z

Figure 1: Offset at 0,0,0 Figure 2: Offset at 100,0,0
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Transforming a clip using the Preview Window
In the Preview Window, you can use your left or right mouse button to resize, 
position, and rotate your clip 

¡ Important You must first select the type of transform settings you want to 
adjust by clicking the appropriate button (Position, Size, Offset, or Rotation). 
Alternately, you can use keyboard shortcuts to select the transform setting you 
want. Press Q for Position, W for Size, E for Offset, or R for Rotation. You’ll 
notice that the values will change for the selected controls as you drag the mouse 
in the Preview Window.

The following table shows the available mouse controls for working in the 
Preview Window.

For example, if you want to alter the position of your clip on the y axis only, first 
click the Position button, then press and hold SHIFT while dragging the mouse 
up or down in the Preview Window.

Action Result

Left mouse button Adjusts x and y axes

SHIFT+left mouse button, drag left or right Adjusts x axis only

SHIFT+left mouse button, drag up or down Adjusts y axis only

Right mouse button Adjusts z axis only
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Cropping your effect
To apply crop settings to your Matrox effect, click the Crop tab or the Crop 
track:

By selecting Simple edit, all settings are applied for the duration of your clip. 
This means that you’ll have only one keyframe at the first frame of your clip. If 
you want to change settings at different frames of the clip, you’ll have to clear 
Simple edit.

¦ Note The default crop settings that you specify in the Matrox Advanced 
Settings dialog box (see page 46) are applied to all your Matrox effects. You can 
customize the crop settings for individual effects by defining keyframes at any 
point on the Crop track. For details on how to change an effect’s crop settings 
over time by creating and editing keyframes, see “Working with keyframes” on 
page 99.

You can adjust the crop settings in the following ways:

• Crop directly in the Cropping Window by dragging resize handles on the 
image.

• Use the crop controls to crop any edge by a given number of pixels.

• Choose a command from the Crop menu to crop your effect by a preset 
amount.
Cropping your effect
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• Crop directly in the Preview Window using your mouse.

Using the Cropping Window
The Cropping Window allows you to adjust a cropping area using eight resize 
handles. 

To display a particular frame in the Cropping Window, move the Positioner to 
the frame you want displayed, and click the Grab Image button.

To resize your cropping area, drag any of the resize handles. For example, drag 
the middle right handle to crop the right edge of your clip. To resize the entire 
cropping area at once, drag one of the corner handles (the corner that’s diagonally 
opposite the handle you are moving will remain stationary).

Once you’ve cropped your image, you can drag the entire cropping area in the 
Cropping Window to select a different area of your clip. You’ll notice that the 
Preview Window displays your changes as you resize or drag the cropping area.

Mouse 
pointer on 
resize 
handle
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Using the crop controls
The controls under Crop Settings let you crop any edge of your effect. You can 
enter the values you want in the text boxes or drag the appropriate sliders (Left, 
Right, Top, Bottom):

Using the Crop menu
You can also crop your effect using commands from the Crop menu, located 
below the Cropping Window:

• Full Screen Sets your effect to full-screen size (that is, no cropping is 
done to the image).

• Crop Analog Video Crops the thin black borders that appear along the 
edges of video that’s been captured from an analog source. These borders 
typically appear at the right and bottom edges of your image.

• Crop Using Project Defaults Re-applies the default cropping values you 
defined for your project (that is, your General settings in Adobe Premiere, as 
explained on page 46).

• Enlarge Lets you enlarge the visible area of your image by decreasing the 
cropping on all edges by a given percentage.

• Reduce Lets you reduce the visible area of your image by increasing the 
cropping on all edges by a given percentage.
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Cropping an effect using the Preview Window
In the Preview Window, you can use your left and right mouse buttons to crop 
any edge of your effect: 

The following table shows the available mouse controls for cropping in the 
Preview Window.

You’ll notice that the values will change for the crop controls as you drag the 
mouse in the Preview Window.

Action Result

Left mouse button, drag up or down Adjusts the top edge

Left mouse button, drag left or right Adjusts the left edge

Right mouse button, drag up or down Adjusts the bottom edge

Right mouse button, drag left or right Adjusts the right edge

Both mouse buttons Moves the cropped image
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Working with keyframes
A keyframe is a frame at which you’ve defined one or more effect settings to take 
place in a clip. The settings start at the frame where you define them, and remain 
active on the clip until you define a later keyframe to turn off or change the 
settings. This allows you to control the occurrence and duration of your effect 
settings. By interpolating between keyframes, you create gradual transitions 
between different settings for an effect.

¦ Note The following sections explain how to use the Matrox realtime plug-in to 
work with keyframes. Be aware that the Matrox effects do not support Adobe 
Premiere’s keyframes that are applied on the Timeline.

In the following sections, we explain how to:

• Use the effect controls to work with keyframes.

• Perform basic operations such as creating, copying, cutting, and pasting 
keyframes.

• Interpolate between keyframes.

Using the keyframes controls
Several controls are provided at the bottom of the Matrox Effect Setup dialog 
box to let you work with and view the keyframes in your clip: 

✐ Toolbar Provides buttons for the most commonly used keyframe tasks. 
Only buttons that can be used at a given time are available. When you hover 
your mouse pointer over an available Toolbar button, you’ll see a tooltip 
describing the button.

✑ Tracks and Ruler The tracks represent the progression of your clip over 
time, with the Ruler above the tracks denoting your clip’s frame numbers. 
Keyframes can be created on all tracks except the topmost track. You can 
click a track to switch to its corresponding page. For example, clicking the 
Transform track displays the Transform page.

✒ Keyframe symbols Whenever you change an effect setting, a symbol 
such as  appears on the appropriate track, representing the keyframe 
you’ve created. For example, in the preceding illustration, the  symbol on 
the Transform track at frame 0 represents a transformation created at the 

✐
✑ �

✔

✕✒
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beginning of the clip. For more information, see “Creating new keyframes” 
on page 101.

� Positioner You can use the Positioner to indicate where you want to create 
a keyframe. You can also preview an effect by dragging the Positioner as 
explained in “Previewing your effects” on page 73. To move the Positioner 
to a particular frame, enter the frame number in the Current frame box, or 
click the frame on the Ruler.

✔ Zoom buttons You can zoom in or out to view keyframes by clicking the 
Zoom buttons. Depending on your zoom setting and the length of your clip, 
only a portion of your clip might be displayed inside the tracks. If this is the 
case, you can scroll forward or backward through the runoff portion of your 
clip by dragging the Positioner.

✕ Right-click pop-up menus You can right-click any of the effect controls 
to display a context-sensitive pop-up menu. For example, if you right-click 
the Ruler, a pop-up menu appears that includes the Zoom to Extent 
command, which zooms your clip to fill the entire length of the tracks. 
Right-clicking the Positioner or the Ruler displays a pop-up menu that 
includes commands for moving the Positioner, such as Snap, which makes it 
easier to drag the Positioner onto a keyframe or vice versa.

For a complete list of shortcuts available for working with keyframes, see 
“Keyboard shortcuts” on page 108.
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Creating new keyframes
°To create a keyframe:

1 In the Matrox Effect Setup dialog box, click the tab or track where you 
want to create your keyframe.

2 Move the Positioner to the frame in your clip where you want the settings to 
take place.

¥ Tip Press the HOME key to move the Positioner to the first frame of your 
clip.

3 Use the effect controls in the dialog box to set up your effect. As soon as you 
adjust a control, a keyframe is created on the corresponding track, behind the 
Positioner:

You can create a keyframe with default settings by pressing CTRL+INSERT or 
by clicking the Apply Default Settings button on the Toolbar. You can also 
create a keyframe with the currently displayed settings by pressing INSERT or 
by clicking the Apply Current Settings button on the Toolbar.

Modifying keyframes
°To edit a keyframe:

1 Double-click the keyframe. The current settings for the keyframe are 
displayed on the page.

2 Edit the effect as needed. To apply default settings to the keyframe, press 
CTRL+INSERT or click the Apply Default Settings button on the Toolbar.

Resetting a track to default settings
To reset a track to its default settings, right-click the track and choose Reset 
Track Data from the pop-up menu. Resetting clears all keyframes from the 
track, including those that were pre-defined, and restores the default effect 
settings.

¦ Note For those effects for which the Simple edit option is available, resetting 
the track to default settings replaces all keyframes on the track with a single 
keyframe.

Newly created 
keyframe
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Selecting keyframes
Many operations that you can perform on a keyframe, such as copying and 
deleting, require you to select the keyframe first. You can select keyframes using 
any of the following methods:

• Select a single keyframe by clicking it, or moving the Positioner to it when 
the track is highlighted.

• Select more than one keyframe by holding down the CTRL key while 
clicking the keyframes you want to select.

• Select a range of keyframes by clicking the first keyframe, then holding 
down the SHIFT key while clicking the last keyframe you want in the range.

• Select all keyframes on a track by: 

$ clicking the Select All button on the Toolbar, 

$ or pressing CTRL+A when the track is highlighted, 

$ or by right-clicking the track and choosing Select All.

Copying and moving keyframes
°To copy selected keyframes to a new location, do one of the following:

• Click the Copy button on the Toolbar, or press CTRL+C. Move the 
Positioner to the destination frame, then click the Paste button on the 
Toolbar, or press CTRL+V.

• Right-click the selection and choose Copy from the pop-up menu. Move the 
Positioner to the destination frame, then right-click the track and choose 
Paste at Current Frame.

• CTRL+drag the selected keyframes to a new location on the track.

°To move selected keyframes, do one of the following:
• Click the Cut button on the Toolbar, or press CTRL+X. Move the Positioner 

to the destination frame (this frame can be in a different clip or for a different 
effect), then click the Paste button on the Toolbar, or press CTRL+V.

• Right-click the selection and choose Cut from the pop-up menu. Move the 
Positioner to the destination frame (this frame can be in a different clip or for 
a different effect), then right-click the track and choose Paste at Current 
Frame.

• Drag the selected keyframes to a new location on the track.

If a keyframe exists at your destination frame, it will be replaced with the pasted 
keyframe.

¦ Note For details on how to paste only certain attributes of a keyframe, see the 
next section. You can also save all keyframes on a track to a file, then load the file 
to apply your settings to other clips. For details on how to do this, see “Saving 
and loading keyframe files” on page 104.
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Pasting attributes of a keyframe (“selective 
paste”)
You can copy and paste some or all of the attributes of a single keyframe to 
selected keyframes. The attributes you choose to paste replace the corresponding 
attributes of the destination keyframes. This is called a “selective paste,” and is 
particularly useful when you want to make changes to a complex series of 
keyframes in a clip.

For example, let’s say you’ve created a series of Transform keyframes on a clip, 
where each keyframe uses all of the transform controls but with different Size 
settings. Your keyframe sequence might appear as follows: 

If you later decide that you’d like all the keyframes to have the same Size setting 
as the keyframe at frame 0, you could easily fix the sequence by pasting the 
initial keyframe’s Size onto the other keyframes as follows:

1 Click the keyframe containing the settings you want to paste. For this 
example, that would be the keyframe at frame 0 on the Transform track.

2 Click the Copy button on the Toolbar, or press CTRL+C.

3 Select the keyframes to which you want to paste the copied settings. You can 
CTRL+click individual keyframes to select them, or use SHIFT+click to 
select a range of keyframes.

4 Click the Selective Paste button on the Toolbar, or right-click any of the 
selected destination keyframes, then choose Selective Paste from the 
pop-up menu that appears. This displays a dialog box containing settings 
available for pasting, similar to the following:
Working with keyframes



104

Cha
¦ Note The dialog box that appears depends on what type of keyframe you’re 
pasting.

5 Select the settings you want to paste. For this example, you would select 
only Size.

6 Click OK. Your destination keyframes are updated with the settings you 
selected, while retaining all other attributes.

Deleting keyframes
°To delete a keyframe selection, use one of the following methods:

• Click the Delete button on the Toolbar.

• Press the DELETE key.

• Drag the selection vertically off the tracks.

• Right-click the selection and choose Delete or Cut from the pop-up menu.

¥ Tip To delete all keyframes on a track, right-click the track and choose 
Delete All from the pop-up menu.

Saving and loading keyframe files
The Save Keyframes command lets you save all keyframes on a track to a file. 
You can then use the Load Keyframes command to load that file and apply the 
keyframes to other clips in your video production. This is useful for building a 
library of complex or frequently used keyframe sequences.

For example, after creating a complex series of keyframes to perform a 3D DVE 
tumble, you can save your keyframe sequence to a file, then load that file 
whenever you want to apply the same tumble to another clip in your project. You 
may also want to exchange your saved keyframes with other Matrox users.

°To save all keyframes on the currently selected track to a file:
1 Press CTRL+S or right-click the track and choose Save Keyframes from the 

pop-up menu. 

2 In the provided dialog box, specify the file to which you want to store the 
keyframes. Your file will be given an extension that signifies the track name, 
such as .Transform.Kft if you’re saving keyframes on the Transform track.

°To load saved keyframes to the currently selected track:
1 Press CTRL+O or right-click the track and choose Load Keyframes from the 

pop-up menu.

2 In the provided dialog box, select the file you want to load. This file must 
contain keyframes belonging to the current track. For example, you can load 
only transform keyframes to the Transform track, and load only crop 
settings to the Crop track.
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¦ Note Any keyframes presently on the track will be replaced by the loaded 
keyframes.

Interpolating between keyframes
Interpolating between two or more consecutive keyframes on the same track 
enables you to create a gradual transition from one keyframe’s settings to the 
next.

In the following sections we explain:

• How interpolation works.

• Considerations for creating an interpolation sequence.

• Linear and spline interpolation.

• How to turn interpolation on and off.

How interpolation works
Interpolations are performed between different settings for an effect. For 
example, if you defined a size of 25% at the start of a clip and a size of 100% at 
the end of the clip, interpolating between the two keyframes makes your clip 
gradually increase in size from 25% up to full-screen size.

The speed of the transition between two consecutive keyframes depends on the 
amount of space (time) between them. For example, if you have a large amount 
of space between keyframes, the transition will occur slowly. Alternately, if your 
keyframes are close together, the transition will occur quickly.

Interpolating between different transform settings enables you to make a clip 
shrink, expand, tumble, and/or move across the screen.

Considerations for creating an interpolation sequence
By default, a spline interpolation is set between consecutive keyframes created 
on the same track. For an explanation of spline interpolation, see the next section.

As you create new keyframes, each keyframe is initialized to the same settings as 
the one to the immediate left on the track. This makes it easy for you to define an 
interpolation sequence in ascending order (from left to right). If you add a new 
keyframe between two interpolated keyframes, however, the new keyframe’s 
settings will be calculated according to the adjacent keyframes. For example, if 
you add a keyframe between a size setting of 0% and 50%, the size for the new 
keyframe will be set to 25%.

¦ Note If you use the Reverse option for a Matrox effect, the interpolation 
sequence is defined from right to left.

Linear and spline interpolation
There are two types of interpolation that you can apply to a keyframe — linear or 
spline. Linear interpolation means that the transition between effect settings 
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occurs in even, linear increments. For example, let’s say you have two linearly 
interpolated keyframes 75 frames apart with Size settings of 0% and 75%, 
respectively. When you play back your clip, the size of your clip increases 
between these two keyframes at a steady rate of 1% per frame.

If you have three or more interpolated keyframes, linear interpolation might not 
give the results you want. Spline interpolation gives you a smoother transition 
based on the settings of all keyframes. For example, if you add a third keyframe 
(with Size at 100%) to the example given in the previous paragraph, the 
difference between linear and spline interpolation can be illustrated as follows:

Notice how spline interpolation reduces the abruptness in the rate of interpolation 
between the keyframes. Spline interpolation is particularly useful for creating 
smooth transitions when you move a clip to different locations on the screen.

Creating keyframes outside the clip region
Because spline interpolation is affected by both the number of keyframes and the 
distance (frames) between them, you may find it helpful to create keyframes 
outside the clip region on the track. For example, you could start your 
interpolation sequence several frames before your clip starts to make the spline 
calculations start earlier.

To display the area outside the clip region, right-click the track and turn off 
Display Clip Region Only. Then drag the Positioner forward or backward to 
scroll to the area outside the clip. 

FRAME

50%

75% 75%

50 100 150 200

100%

50%

50 100 150 200

100%

Linear interpolation Spline interpolation

FRAME

Area before clip Clip region Area beyond end of clip
pter 6, Setting Up Realtime Effects with Adobe Premiere



107
Turning interpolation on and off
As previously mentioned, a spline interpolation is set by default between 
consecutive keyframes created on a track. You may, of course, choose to turn off 
interpolation or change the interpolation type.

To turn off or reset interpolation, click the keyframe or a range of selected 
keyframes, then on the Toolbar, click  for no interpolation,  for linear 
interpolation, or  for spline interpolation. You can also right-click the 
keyframe or a range of selected keyframes, then choose Interpolation Type > 
None, Linear, or Spline from the pop-up menu.

Depending on the location of a keyframe in a sequence and whether or not 
interpolation is set, the keyframe will be represented as follows:

¦ Note Newly created keyframes will be assigned the same interpolation setting 
as that of the keyframe to the immediate left on the track (or to the right if you 
use the Reverse option).

First keyframe in an interpolation sequence.

Intermediate keyframe in an interpolation sequence.

Last keyframe in an interpolation sequence.

Keyframe that is not in an interpolation sequence.
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Keyboard shortcuts
The following table provides a complete list of keyboard shortcuts (and 
corresponding buttons, if available) that you can use when working with 
keyframes in the Matrox Effect Setup dialog box.

Command
Keyboard 
Shortcut

Button

Zoom In = or F4

Zoom Out - or F3

Zoom to Extent \ or SHIFT+F3

Select All CTRL+A

Cut CTRL+X

Copy CTRL+C

Paste at Current Frame CTRL+V

Selective Paste CTRL+SHIFT+V

Delete DELETE

Save Keyframes CTRL+S

Load Keyframes CTRL+O

Previous Keyframe CTRL+LEFT 
ARROW or F5

Next Keyframe CTRL+RIGHT 
ARROW or F8

Previous Frame LEFT ARROW or F6

Next Frame RIGHT ARROW or 
F7

First Frame HOME or CTRL+F6

Last Frame END or CTRL+F7

Snap S

Preview Entire Effect ALT+SPACEBAR

Preview from Positioner SPACEBAR

Toggle Track State CTRL+F2

Solo Mode F2

Apply Current Settings INSERT

Apply Default Settings CTRL+INSERT

Undo CTRL+Z

Redo CTRL+Y
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Setting up realtime graphics overlays
You can add realtime alpha-keyed graphics layers to your production (such as to 
overlay a title onto a video clip). To do this, you create a single-frame graphics 
file using any graphics program that supports an alpha channel, such as Adobe 
Photoshop. You can use any graphics format that is supported by Adobe Premiere 
(such as .tga or .icg).

°To set up your realtime graphics overlay:
1 Import the graphics file into your Adobe Premiere project.

2 Place the clip in your Timeline on a superimpose track (Video 2 or higher). 

3 Right-click your clip on the superimpose track, then choose 
Video Options > Transparency.

¦ Note Some graphics file formats (such as .icg) are automatically 
alpha-keyed when placed on Video 2 or higher.

4 In the Transparency Settings dialog box, choose Alpha Channel as the 
Key type, then click OK to return to your Timeline.

Remarks
• If needed, Premiere will resize your graphics to full screen resolution 

(720×480 for an NTSC image, or 720×576 for a PAL image). You can 
maintain your clip’s aspect ratio by choosing Clip > Video Options > 
Maintain Aspect Ratio.

• You can change the duration of your graphics overlay by dragging its 
borders. For example, to make your graphics overlay the same length as your 
underlying video clip, drag its left or right border until your clip is the 
desired length. To change the default duration of your single-frame graphics 
overlays, choose Edit > Preferences > General and Still Image.

Graphics overlay

Underlying 
video clip
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• You can add a realtime fade to your graphics overlay using Adobe 
Premiere’s Video Opacity rubberband control, such as to fade-in and 
fade-out as shown below: 

Rubberband 
control
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RT.X10 Xtra realtime rules
In your Adobe Premiere projects, you can use various combinations of Matrox 
RT.X CPU-based effects, hardware-accelerated effects, and Adobe Premiere 
realtime transitions, all with transparency, and still play back your effects in real 
time.

The Matrox CPU-based effects are color corrections, and speed changes applied 
to a clip. The CPU-based effects can be applied only to video clips. The Matrox 
hardware-accelerated effects are all the other RT.X effects (such as page curls, 
organic wipes, Premiere realtime transitions, and fades). The 
hardware-accelerated effects can be applied to video or graphics clips.

This section explains the rules and guidelines you’ll need to follow in order to 
keep your effects realtime, assuming that you’re using a recommended system, as 
explained in “System requirements” on page 4.

Supported graphics formats
All single-frame graphics formats supported by Adobe Premiere are supported in 
real time on Matrox RT.X10 Xtra. This includes all titling formats that Premiere 
supports, such as Adobe Title Designer .prtl files and Inscriber .icg files. For 
details on the supported formats, see your Adobe Premiere User Guide.

¦ Note For Premiere to use titling formats such as .icg, you’ll need to have the 
manufacturer’s program installed on your Matrox RT.X10 Xtra system. For 
example, .icg files require an Inscriber program, such as TitleExpress.

General rule
The general rule to follow when setting up your realtime effects is that in any 
given segment, you can use up to two video clips (.avi files), and four 
single-frame graphics clips.

Each clip in the segment can have a fade applied to it, and still play back in real 
time. A fade can be any one of the following:

• A fade (video opacity) effect created using Premiere’s Opacity rubberband.

• An Adobe Premiere Cross Dissolve.

• An Alpha Channel key applied to a graphics clip (with or without 
rubberbanding).
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Combining effects
In any given segment, you can apply the following RT.X effects in real time:

• 2 color correction effects, and

• 2 speed changes, and

• 1 other Matrox hardware-accelerated effect (such as a page curl or a 
Premiere realtime transition).

¦ Note Certain complex Matrox effects, such as particles, may not be realtime 
when applied to a segment containing multiple graphics clips.

Order of effects
The order in which you apply your RT.X effects is important when you combine 
effects. When applying multiple RT.X effects to a segment, follow this order:

1 Color correction effect(s).

2 Matrox hardware-accelerated effect.

For example, you can apply a page curl to a color correction and play back the 
clip in real time. If, however, you apply a color correction to a page curl, the clip 
will require rendering (unless you change the order of the effects).

To change the order of effects applied to a particular clip, you can drag and drop 
effects in Premiere’s Effect Controls palette. In the following example, Matrox 
Page Curls appears after Matrox Color Corrections. Therefore, the clip will 
play back in real time:

Restrictions
If you follow the rules listed above, you’ll be able to play back your effects in 
real time. You will, however, need to render your effects when you do any of the 
following:

• Select Force render when you set up an effect in the Matrox Effect Setup 
dialog box (see page 72).

• Place effects or clips too close on the Timeline, as explained in the section 
“How to place your effects to avoid rendering” on page 67.
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• Use a graphics roll, crawl, or animation (only single-frame graphics are 
supported in real time).

• Add a non-Matrox effect or transition, such as an Adobe Premiere video 
effect or non-realtime transition. For details on selecting which Adobe 
Premiere transitions you want to play back in real time, see “Selecting your 
realtime effect settings” on page 46.

• Apply an Adobe Premiere key type other than None, Alpha Channel, 
Black Alpha Matte, or White Alpha Matte.

• Apply any field processing options to a clip, such as Always deinterlace or 
Flicker Removal.

• Apply a freeze-frame effect to a clip using the Frame Hold command with 
the Deinterlace option selected (rendering won’t be required if you clear the 
Deinterlace option).

¦ Note Non-realtime segments of the Timeline (that is, areas that require 
rendering) are identified by a red line above the time ruler.

A/B mode preview
There area few instances when you’ll see an A/B representation of your Matrox 
effect in the Matrox Effect Setup dialog box. This is because the segment 
you’re editing has one or more of the following characteristics:

• A graphics roll, crawl, or animation.

• A video standard that doesn't match your system.

• An unsupported video source (such as a QuickTime file).

¥ Tip To see the segment with all applied effects, you can use the render-scrub 
feature (ALT+drag the Positioner) in the Matrox Effect Setup dialog box. 

Monitoring your CPU usage
Even on a system that meets the recommended system requirements, you can 
experience dropped frames when playing back certain complex realtime effects, 
or combinations of effects. This is because of the high demand these effects place 
on your system’s CPU.

You can monitor your CPU usage by right-clicking on the Windows taskbar, and 
choosing Task Manager. On the Performance tab, choose Options and make 
sure that Always On Top is selected. While playing back a segment of the 
Timeline, if your CPU usage reaches and maintains 100% for too long, you will 
drop frames.

You can use the Force render option to render your realtime effects without 
dropped frames (see page 72). Because some of the Matrox realtime effects are 
CPU-based, upgrading to a more powerful CPU might allow you to combine 
more of these effects.
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Your notes
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Using RT.X10 Xtra with Video for

Windows Programs
This chapter provides 
information you need to know 
when using Video for Windows 
programs to capture and 
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Overview
When using Video for Windows programs to render (compile) material to an .avi 
file, such as in the case of a completed video production or an animation, you can 
use a Matrox codec to create a Matrox .avi file. For example, you may want to 
render an animation to Matrox DV/DVCAM format so that you can record it onto 
DV tape. You could also use your Video for Windows program to render video to 
a Matrox .avi file so that you can import the file as a realtime clip into your 
Adobe Premiere projects on Matrox RT.X10 Xtra. 

Your Matrox RT.X10 Xtra hardware also allows you to use your Video for 
Windows program to capture analog video. The Matrox realtime plug-in for 
Adobe Premiere lets you capture analog and DV clips. You can, however, capture 
analog clips using capture programs other than Adobe Premiere, such as Sonic 
Foundry’s Vegas Video. You can also use many messenger and video 
conferencing programs (such as Microsoft NetMeeting) to send streaming video 
over the internet or your corporate intranet.

The following sections explain the various settings you need to make to render 
and capture material using a Video for Windows program with your Matrox 
RT.X10 Xtra system. For details on exporting video from Adobe Premiere to a 
Matrox .avi file, see “Performing a Premiere export to disk” on page 54. Using 
Adobe Premiere to export video on your Matrox RT.X10 Xtra system lets you 
overcome the 2-GB .avi file limit of Video for Windows programs.

Remarks
• Be aware that .avi files do not have an alpha-key channel for storing 

transparency information. If you want to render an animation containing 
transparency information so that it can be alpha-keyed using your nonlinear 
editing program, you should render the animation to a series of .tga files, not 
to an .avi file. You can import a .tga sequence into Adobe Premiere and 
alpha-key the sequence after placing it onto a superimpose track, but your 
sequence will not play back in real time. If you render a single-frame .tga 
file with an alpha-key channel, however, you can set up a realtime graphics 
overlay in Adobe Premiere as explained in the section “Setting up realtime 
graphics overlays” on page 109.

• Instead of using your Video for Windows program to capture analog clips on 
your Matrox RT.X10 Xtra system, you’ll get much better results using a 
Matrox capture format in Adobe Premiere to capture your analog clips.

• Although Matrox has tested many Video for Windows programs, there may 
be certain operational limitations when using Matrox RT.X10 Xtra with 
some of these programs (as well as with untested programs).
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Using VFW programs without the RT.X10 Xtra 
hardware

If you installed the Matrox Video for Windows (VFW) software codecs (see 
“Installing the Matrox VFW software codecs on a system without the RT.X10 
Xtra hardware” on page 34), you can render and play back RT.X10-compatible 
.avi files using your Video for Windows program without having the RT.X10 
Xtra hardware in your computer. To capture material, however, your system must 
be equipped with the RT.X10 Xtra hardware.

Before you start rendering
Before you start rendering material to a Matrox .avi file, make the following 
settings in your Video for Windows program:

• Set the frame rate for rendered material to 29.97 frames per second for 
NTSC video, or 25 frames per second for PAL video.

• Set the frame size of your rendered material to full-screen: 720×480 for 
NTSC video, or 720×576 for PAL video.

• To render a video production at a quality that’s different from the one at 
which your clips were created, all your clips must be recompressed at the 
new quality level during the rendering process. If your program provides an 
option for controlling compression, set this option to Always recompress 
when rendering.

• For best results, make sure you clear your program’s Data rate limit option 
for rendered material. This ensures that your .avi files will be rendered at the 
particular video quality you select.

• If you’re using Adobe Premiere, set the Fields for rendering to Lower Field 
First for NTSC video, or Upper Field First for PAL video.

¦ Note Before rendering a lot of material, check that your rendered animations 
and transitions such as wipes and slides play back smoothly. If they appear 
jumpy, try adjusting the field dominance or field order for your rendered material. 
For example, if your transitions appear jumpy with the field dominance set to 
Odd field or Field 1, try switching the setting to Even field or Field 2.
Using VFW programs without the RT.X10 Xtra hardware
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Selecting color space conversion options
When you render material to an .avi file using a Matrox VFW codec, you can 
determine how you want the luminance levels and chroma information to be 
processed during the color space conversion that’s performed during the render.

¦ Note The default settings for color space conversion provide good results for 
most applications. We recommend that you change these settings only when 
needed for special purposes.

°To select the color space conversion options you want:
1 If you’re using Windows XP, do the following:

a Right-click My Computer, then choose Properties > Hardware > 
Device Manager.

b Under Sound, video and game controllers, double-click Video 
Codecs.

c Click Properties, then select Matrox Codecs.

d Click Properties, and then Settings.

2 If you’re using Windows 2000, do the following:

a Choose Start > Settings > Control Panel > Sounds and Multimedia.

b Click the Hardware tab. Under the list of devices, select Video Codecs.

c Click Properties, then the Properties tab, and select Matrox Codecs.

d Click Properties, and then Settings.

3 In the provided dialog box under Color Space Conversion, select the 
options you want:

$ Standard Renders video using standard broadcast luminance levels. 
Super black and super white luminance levels are clipped.

$ DV-compliant Renders video using luminance levels appropriate for DV 
material. This ensures that the super white luminance levels of your video 
are retained.

$ Expanded Renders video using the full range of luminance levels. Super 
black and super white luminance levels are retained. You may want to use 
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this setting, for example, to render material on which you’ll be applying 
luminance key effects.

¡ Important When rendering RGB graphics, selecting Expanded or
DV-compliant will create super black and/or white in your rendered images. 
For example, if you select Expanded, all black in your RGB graphics will 
become super black, and white will become super white. To render your 
RGB graphics with standard black and white levels, set your luminance 
range to Standard.

$ Chroma filtering and Chroma interpolation Select these options to 
adjust the chroma bandwidth of RGB graphics. This improves images that 
have abrupt changes between different colors, such as a blue box on a black 
or white background. You should select these options for most animation 
and compositing work (computer-generated material). For most video 
editing programs, however, it’s best that you not select these options. If you 
find that your rendered images appear to be blurred, try clearing one or both 
of these options.

$ Chroma sampling for fast-motion video Select this option to help 
eliminate artifacts such as jagged edges and unwanted lines at the edges of 
fast-motion video (for PAL video only). 

¡ Important When rendering graphics and titles, make sure that Chroma 
sampling for fast-motion video is not selected, as this option can cause 
jagged edges to appear in your rendered images.

4 Click OK to save your settings. Any change you make to your selected 
luminance range setting (such as switching from Standard to Expanded) 
will only take effect the next time you start your VFW program.

Rendering material to a Matrox VFW .avi file
When you render material to an .avi file, such as when you render a finished 
video production or an animation, you must select the compressor (codec) you 
want to create the file. The compressor determines the quality of your rendered 
video. Refer to your program’s documentation for instructions on how to select a 
compressor for your .avi file.

To create a Matrox Video for Windows .avi file, select the Matrox DV/DVCAM 
codec from your program’s list of available compressors.

¦ Note If you installed the Matrox VFW codecs on a system without the Matrox 
RT.X10 Xtra hardware, additional Matrox codecs will be available, such as the 
Matrox DVCPRO and Matrox MPEG-2 I-frame codecs. These codecs can be 
used to create clips for other Matrox systems, such as DigiSuite or RT2500. 
Matrox RT.X10 Xtra supports DV/DVCAM clips only.
Rendering material to a Matrox VFW .avi file
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Before you start capturing
To properly capture and play back audio, make sure you’ve set appropriate 
recording and playback volume levels for your sound card, as explained in the 
section “4. Configure your sound card” on page 12.

If you want to create RT.X10-compatible .avi files (such as to use in your Adobe 
Premiere projects), make the following settings in your Video for Windows 
program before you start capturing:

• Set the frame rate for your captured clips up to 29.97 frames per second on 
an NTSC system, or up to 25 frames per second on a PAL system.

• For the best results, set the audio sampling rate to 44.1 or 48 kHz, and the 
sample size to 16-bit (mono or stereo). If you’ll be capturing digital audio 
(AES/EBU or S/PDIF), make sure you set the audio sampling rate to the 
same rate as the digital input. For example, to capture audio from a CD 
player, set the sampling rate to 44.1 kHz.

¦ Note The Matrox VFW capture driver does not support running more than one 
Video for Windows program at a time.

Capturing material for your production
The following sections explain how to select the device from which you want to 
capture material, change the proc amp settings of your incoming video, and select 
your video capture format and resolution.

¡ Important Depending on which Video for Windows program you use, you 
may not have access to all of the following settings. Some Video for Windows 
programs may also override your settings with defaults needed for proper use of 
the program. For instructions on a program’s use, such as how to capture 
material, refer to your program’s documentation.

Selecting your capture source and adjusting 
proc amp settings

1 Start your Video for Windows program.

2 Choose the program’s Video Source command (refer to your program’s 
documentation). 
pter 7, Using RT.X10 Xtra with Video for Windows Programs



121
3 From the list of available devices, select Matrox Video Capture Device. 
The Matrox Input Source Settings dialog box appears:

4 From the Video Source list, select Composite or S-Video (Y/C). Make 
sure this setting matches your input device.

5 Use the proc amp controls as needed to adjust the incoming analog video 
signal before starting the capture. To return a control to its factory default 
setting, click the Def button.

$ Hue Adjusts the tint of the colors in the image.

$ Saturation Adjusts the saturation (vividness) of the image’s colors.

$ Contrast Adjusts the difference in luminance between the lightest and 
darkest areas of the image.

$ Brightness Adjusts the level of black in the image.
Capturing material for your production
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Selecting your capture format and resolution
1 Choose your program’s Video Format command. The Matrox Capture 

Format Settings dialog box appears:

2 From the Capture Format list, select the format you want for your captured 
clips. To create an RT.X10-compatible .avi file, select DV/DVCAM. 

¦ Note In some Video for Windows programs, if you select RGB or YUV as 
your capture format, you’ll have to choose a compressor from the list supplied 
by your program. For details, see your program’s documentation.

3 If you select RGB as your capture format, you can select a different 
resolution from the Capture Resolution list.

¦ Note The only Capture Resolution available for the YUV and 
DV/DVCAM capture formats is full-screen (that is, 720×480 for NTSC and 
720×576 for PAL). Some Video for Windows programs, however, may only 
allow certain resolutions for proper usage, or may set a default resolution that 
overrides the selected capture resolution.

¥ Tip If you’re experiencing dropped frames during your captures, you can 
disable the program’s live video window on your computer monitor (if allowed 
by the program) to try to solve this problem. If you have an NTSC or PAL video 
monitor connected to your system, you’ll still be able to monitor your captures. 
Refer to your program’s documentation for information on disabling the live 
video window.
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A note about capturing video with audio
Because of the way Video for Windows captures material, when you capture 
video and audio to the same .avi file, the duration of the video and audio portions 
of the clip may not be exactly the same. For example, the clip’s audio may end a 
few frames before its associated video. To play back the clip, Video for Windows 
adjusts the frame rate of the video so that it’s synchronized to start and stop at the 
same time as the audio. This means the video may not play back smoothly, and 
the clip’s frame rate won’t match the standard frame rate for your system (29.97 
fps for NTSC video, or 25 fps for PAL video). The problem is most apparent with 
very short clips.

If you use Adobe Premiere to capture your material, the duration of the video and 
audio portions of your clips will match.
Capturing material for your production
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Your notes
pter 7, Using RT.X10 Xtra with Video for Windows Programs



Chapter 8
Using Matrox MediaTools

This chapter explains how to 
use Matrox MediaTools to scan 
and capture clips from your 
DV-1394 device, create a 
batch capture list, grab single-
frame images, and export clips 
to an Adobe Premiere project.
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About Matrox MediaTools
Matrox MediaTools is a DV capture application that allows you to perform 
automatic, unattended DV tape scanning and batch capture. With MediaTools, 
you can:

• In a single pass, automatically scan and capture clips from a DV tape into 
.avi files on your computer.

• Automatically scan an entire DV tape to create a batch capture list. 

• Capture clips from a batch capture list at a later time, and adjust the In and 
Out points of clips prior to capturing.

• Capture live video from your DV-1394 device. 

• Use onscreen transport controls to navigate quickly and easily through clips 
on tape or clips on disk.

• Grab single-frame images and save them as .tga or .avi files, such as to 
create photo montages. 

• Edit the In and Out points of clips and recapture them. 

• Change the order of clips in your clip list by simply dragging and dropping 
clips into the sequence you want.

• Export your clip list to an Adobe Premiere project where you can add 
Matrox realtime effects.

¦ Note Your clips are captured in native DV format (that is, Matrox 
DV/DVCAM format).

Preparing your tapes for use with MediaTools
The tapes you use with MediaTools must contain continuous and consecutive 
time code, and all material must be recorded at the same speed. Leaving blank 
gaps between recorded material results in discontinuous time code. To avoid this 
problem, stripe your entire tape with time code before recording your source 
material. You can stripe your entire tape by recording black video for the duration 
of the tape. To do this, insert a blank tape into your camcorder, put the lens cap 
on, then record up to the end of the tape.

¦ Note MediaTools requires about six seconds of preroll before capturing 
material. Therefore, don’t record material that you want to capture within the first 
six seconds of your DV tape.
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Starting Matrox MediaTools
Before you start Matrox MediaTools, make sure that your DV-1394 device is:

• Properly connected and turned on.

• Set to VTR mode to capture from tape, or Camera mode to capture live 
video.

• Loaded with a striped tape. To avoid problems, make sure your tape is not at 
the end.

¥ Tip If you want to capture live video, make sure that the cassette compartment 
is empty to avoid possible auto-shutdown of the camera. For information on how 
to capture live video, see “Capturing live video” on page 137.

°To start Matrox MediaTools:
1 Close any program you have running that uses your Matrox RT.X10 Xtra, 

such as Adobe Premiere. 

2 Choose Start > Programs > Matrox X.tools > Matrox MediaTools. 

¦ Note The first time you start MediaTools, the Options dialog box will be 
displayed. You can choose to display this dialog box each time you start 
MediaTools. For information on the Options dialog box, see “Defining your 
capture settings” on page 134.

3 To close the Options dialog box and start working with MediaTools, click 
OK.
Starting Matrox MediaTools
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Using the Matrox MediaTools interface
When you start MediaTools, a dialog box similar to the following appears:

Here’s a brief description of the MediaTools dialog box: 

✐ New tab Use this tab to scan and capture new clips to add to your clip list, 
and create batch capture lists. For more information, see “Scanning and 
capturing clips” on page 136.

✑ Edit tab Use this tab to capture clips in a batch capture list, edit and 
recapture clips, and update clip information. For details, see “Capturing clips 
from a batch capture list” on page 140 and “Editing clips” on page 140.

✒ Preview Window Allows you to preview clips on tape or clips on disk. 
Your clips are also displayed on your NTSC or PAL video monitor. 

� VTR, CAM, and Disk buttons These buttons let you switch between the 
following modes: 

✐ ✑

✒

�

✔

✗

✖

✕ ✘
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$ VTR mode lets you control your DV-1394 device to capture and play back 
clips on tape.

$ CAM mode lets you capture live video from your DV-1394 device.

$ Disk mode lets you play back captured clips in your clip list.

✔ Clip identification area This section contains several items to help you 
identify your clips. 

$ Tape ID Displays the name that you’ve assigned to the DV tape in your 
DV-1394 device. 

$ Clip ID Displays the base name for your new clips when using the New 
tab, or the name of the currently selected clip when using the Edit tab. For 
details, see “How MediaTools assigns clip names” on page 136.

$ Comment Lets you enter comments that help you distinguish between 
clips in your clip list.

✕ Transport controls A set of common transport controls that lets you 
easily navigate through clips on tape and clips on disk. For more 
information, see “Navigating through clips with the transport controls” on 
page 130.

✖ Clip list A numbered list of clips and their properties. As you scan or 
capture clips in MediaTools, your clips are automatically added to the clip 
list. The clip list can be docked to the MediaTools dialog box or float freely 
as a resizable window. For more information on using the clip list, see 
“Working with the clip list” on page 141. 

✗ Status bar Displays information about the operation you’re currently 
performing in MediaTools, such as clip information during a scan or capture.

✘ Float/dock clip list button This button lets you dock the clip list to the 
MediaTools dialog box, or detach the clip list so that you can move and 
resize it. For more information, see “Detaching and resizing the clip list” on 
page 143.
Using the Matrox MediaTools interface
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Using the MediaTools pop-up menu
When you right-click anywhere in the clip list, a pop-up menu appears containing 
commands for working with MediaTools. All commands present in the 
MediaTools pop-up menu are described in this chapter. 

Navigating through clips with the transport 
controls
MediaTools includes a common set of transport controls for navigating through 
clips on tape and clips on disk. You indicate the type of material you wish to 
control by selecting VTR or Disk. In VTR mode, the transport controls are used 
to navigate through clips on your DV tape. In Disk mode, the transport controls 
are used to control playback of clips from your hard drive (that is, .avi files for 
clips in your clip list).

¦ Note The transport controls are disabled in CAM mode.

The transport controls are much like those on your VTR:

Most of these controls perform standard transport functions, but some can be 
used for special tasks:

• Shuttle/seek Drag the slider on the Positioner to shuttle through your 
tape or any clip in your clip list. 

• Cue to In or Out point on disk Click the Rewind or Fast Forward 
button to cue to the beginning or end of a clip on disk. Press SHIFT+Mark 
In/Out to cue to the In or Out point of a clip. 

• View frame-by-frame Click the Frame Reverse or Frame Advance 
button.

• Play a clip on disk repeatedly Click the Loop button, then click the 
Play button.

¥ Tip You can play back selected clips by right-clicking the clip list and choosing 
Play From Tape or Play From Disk from the pop-up menu. If multiple clips are 
selected in the clip list, the clips play back according to their assigned number 
(order) in the clip list. You can also play back any captured clip by double-
clicking the clip in the clip list.

Loop 
button

Positioner
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¦ Note To select the style of keyboard shortcuts you want to use, click the 
Options button in the MediaTools dialog box, then select the option you want 
under Transport Control Shortcuts.

Using the time code fields
The time code fields display the In and Out points and duration of your clips. 

The following sections describe how to:

• Mark In and Out points.

• Edit the time code fields.

• Change the time code fields’ format.

Marking In and Out points
To define a clip’s In and Out points, you can either mark them as explained in this 
section, or you can type the In and Out points directly into the time code fields as 
explained in the next section. 

To mark the In and Out points of your clip, do one of the following: 

• Play your material and click the Mark In or Mark Out button when you see 
the frame where you want your clip to start or end, respectively. 

Keyboard Shortcuts

CMX-style Premiere-style

K Disk mode D

L VTR mode V

B Play L or SPACEBAR

Z  Rewind R

X Fast Forward F

’ (apostrophe) Frame Advance right arrow or 2

; (semicolon) Frame Reverse left arrow or 1

V Stop S or K

A Loop A

Clear button
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• For increased precision, stop your clip at the appropriate frame and click the 
Mark In or Mark Out button. 

You can cue to your In or Out point on tape by SHIFT+clicking the Mark In 
or Mark Out button. 

Editing the time code fields
When you type a time code in an empty or highlighted time code field, the 
numbers fill each section sequentially from right to left (frames, seconds, 
minutes, and hours), and separators are placed for you between the sections. 

If you enter a value that exceeds the two-digit limit for a section, the appropriate 
time code will be calculated when you press the TAB key. For example, if you 
type 9005 (90 seconds, five frames) and press TAB, it will be calculated as 
00:01:30:05 (one minute, 30 seconds, five frames) on an NTSC system. 

When at least two time code fields are defined, MediaTools automatically 
calculates the remaining field. For example, once you’ve defined the In and Out 
points for a clip, its duration will be calculated for you. 

To clear all the time code fields, click the clear button.

Changing the time code display
A value in a time code field can be displayed and entered as a time code or a 
specific number of frames. The first time you run MediaTools, the fields display 
time codes. To toggle between the two formats, press CTRL+SHIFT while the 
insertion point (flashing vertical bar) is in any time code field. 

For example, on an NTSC system, you could change a value of 24:04 (24 
seconds, 4 frames) to 724 frames by pressing CTRL+SHIFT. You could then edit 
the field in frames and switch back to time codes again by pressing CTRL+SHIFT.

Keyboard shortcuts

CMX-style Premiere-style

M Mark In I

, (comma) Mark Out O

SHIFT+Mark In Cue In SHIFT+Mark In
SHIFT+Mark Out Cue Out SHIFT+Mark Out
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The time code format of your DV tape is indicated by the separator between the 
seconds and frames digits in the time code fields as follows: 

• A semicolon ( ; ) indicates drop frame.

• A colon ( : ) indicates non-drop frame.

¦ Note MediaTools automatically detects the time code format on your DV tape. 
If MediaTools is unable to determine the format, you’ll be prompted to select the 
format that matches the format on your DV tape. 
Using the Matrox MediaTools interface
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Defining your capture settings
Before capturing clips with MediaTools, you need to specify various capture 
settings, such as the folder where you want MediaTools to store your captured 
clips. 

°To define your capture settings for MediaTools:
1 Click the Options button. 

¦ Note By default, the Options dialog box is configured to pop up every time 
MediaTools starts. To turn off this feature, clear Show this dialog box when 
MediaTools starts.

2 Under Capture Folder, specify the folder where you want to store your 
captured clips. For more information, see “Selecting your capture folder” on 
page 135. 

3 Under 1394 Audio Capture, select which DV stereo audio streams you 
want to capture. If you capture only one DV stereo stream, the audio stream 
of your stereo clip will be embedded in your .avi file, creating a single 
interleaved audio and video file. If you choose to capture both DV stereo 
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streams, the second audio stream will be saved to a separate audio file named 
clipID_2ndStream.wav.

¦ Note When capturing audio over the 1394 interface with certain DV devices 
(such as Sony or Canon), the left and right channels may be inverted in the 
resulting .wav file. If this happens, you can select Invert left and right 
channels to correct the problem.

4 Under Transport Control Shortcuts, select which style of keyboard 
shortcuts you would like to use to navigate through clips on tape or clips on 
disk with the transport controls. For a list of available shortcuts, see 
“Keyboard shortcuts” on page 146.

5 Under Seek Method, if you’re having trouble controlling your DV-1394 
device, select an alternate method to improve its performance. For example, 
if your DV-1394 device stops responding after performing a batch capture or 
cues incorrectly to an In/Out point on tape, you can experiment with 
alternate seek methods. 

¦ Note Most devices work best with the default seek method. If, however, an 
alternate seek method improves the performance of an RT.X-compatible DV-
1394 device, this will be mentioned in the RT.X Support section of our web 
site.

6 Under Miscellaneous, you can select the option to rewind your DV tape if 
no In point is specified prior to starting a scan and capture. If you don’t 
select this option, MediaTools will start scanning and/or capturing from the 
tape’s current position. 

7 Click OK to save your settings and return to the MediaTools dialog box. 

Selecting your capture folder
You can select the folder where you want MediaTools to store your captured clips 
by typing the drive and folder name directly into the Capture Folder box, or by 
using the Browse button.

To ensure the best capture and playback performance of your clips, save them on 
one of your A/V drives. 

MediaTools will save your video and audio clips in a subfolder with the same 
name as the Tape ID. For example, if you selected D:\MediaTools as your capture 
Defining your capture settings
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folder, all video and audio clips from tape “MyTape” will be saved in 
D:\MediaTools\MyTape. 

How MediaTools assigns clip names
When using the New tab, Clip ID displays the base name for your new clips. For 
example, if the Clip ID is “MyClip,” MediaTools will assign the name 
MyClip000.avi to the first new clip you capture, and continue naming clips 
sequentially (for example, MyClip001.avi, MyClip002.avi, etc.). Before scanning 
or capturing new clips, you can change the Clip ID to any base name you like. 

When editing clips using the Edit tab, Clip ID displays the name of the selected 
clip in the clip list. You can change the name by typing a new name in the Clip ID 
box on the Edit tab, then clicking Update. You can also change a clip ID directly 
in the clip list by typing a new name in the clip’s Clip ID box, then pressing 
ENTER.

¦ Note Changing the clip ID for a captured clip will not change the clip’s file 
name.

Scanning and capturing clips 
With MediaTools, you can automatically scan and capture clips from a DV tape 
in a single pass. Scanning the tape identifies all the individual clips on your tape 
based on when the DV-1394 device started recording and when it stopped. You 
can also choose to capture live video from your DV-1394 device. Capturing saves 
the clips as .avi files on your computer’s hard drive, which you can later export to 
an Adobe Premiere project (see “Exporting your clip list to an Adobe Premiere 
project” on page 145). 

°To scan and capture clips from your DV tape:
1 In the MediaTools dialog box, click the VTR button. 

2 In the Tape ID box, type a name for the tape presently loaded in your 
DV-1394 device. In the Clip ID box, type the base clip name you’d like to be 
assigned to your clips. For more information, see the previous section, “How 
MediaTools assigns clip names.”

3 Mark or type in the In and Out points to identify where you want the
scan/capture to start and stop. 

¦ Note If you don’t set an In point, MediaTools will start scanning from the 
current tape position, or rewind your tape before starting the scan/capture if 
you selected that option in the Options dialog box. 

4 Click Scan/Capture. 

5 Each time the video sequence on the tape changes, the clip is captured and 
added to the clip list. Each clip also appears with time code information and 
an icon representing the first and last frames of the clip. 
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6 To stop the scan/capture before the Out point is reached (or if you left the 
Out point blank), click the Stop and Mark Out button.

¦ Note You can identify captured clips by the small video and audio icons ( ) 
in the clip list. If you captured both DV stereo streams, a second audio 
icon (A2) will appear in the clip list.

Capturing individual clips from tape
°To capture individual clips from your DV tape:

1 In the MediaTools dialog box, click the VTR button. 

2 In the Tape ID box, type a name for the tape presently loaded in your 
DV-1394 device. In the Clip ID box, type the base clip name you’d like to be 
assigned to your clip. For more information, see “How MediaTools assigns 
clip names” on page 136.

3 Mark or type in the In and Out points of the clip you want to capture.

¦ Note If you don’t set an In point, MediaTools will start capturing from the 
current tape position, or rewind the tape before starting the capture if you 
selected that option in the Options dialog box.

4 Click Capture. 

5 MediaTools will start capturing the clip. To stop the capture before the Out 
point is reached (or if you left the Out point blank), click the Stop and 
Mark Out button.

6 Your captured clip is added to the clip list with time code information and an 
icon representing the first and last frames of the clip. 

Capturing live video
°To capture live video from your DV-1394 device:

1 In the MediaTools dialog box, click the CAM button. To capture live video, 
your DV-1394 device must be set to Camera mode. 

¦ Note To avoid problems, turn off your device for a few seconds before 
switching modes on your DV-1394 device, and make sure that the cassette 
compartment of your device is empty to avoid possible auto-shutdown of the 
camera.

2 In the Clip ID box, type the base clip name you’d like to be assigned to your 
clip. For more information, see “How MediaTools assigns clip names” on 
page 136.

3 Type in a duration for the clip you want to capture. 

4 Click Capture.

5 MediaTools will start capturing the clip. To stop the capture before the 
duration is reached, click the Stop and Mark Out button.
Scanning and capturing clips
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6 Your captured clip is added to the clip list with its duration and an icon 
representing the first and last frames of the clip. 

Creating a batch capture list
A batch capture list is a list of clips with defined In and Out points for clips on 
tape that you have not yet captured. There are two ways to create a batch capture 
list with MediaTools. You can automatically scan your DV tape to create a batch 
capture list of clips on your tape, or you can specify the In and Out points of 
individual clips on tape, and add them to your clip list. 

Scanning clips
°To create a batch capture list of scanned clips from your DV tape: 

1 In the MediaTools dialog box, click the VTR button.

2 In the Tape ID box, type a name for the tape presently loaded in your 
DV-1394 device. In the Clip ID box, type the base clip name you’d like to be 
assigned to your clips. For more information, see “How MediaTools assigns 
clip names” on page 136.

3 Mark or type in the In and Out points to identify where you want the scan to 
start and stop.

¦ Note If you don’t set an In point, MediaTools will start scanning from the 
current tape position, or rewind your tape before starting the scan if you 
selected that option in the Options dialog box. 

4 Click Scan. 

5 Each time the video sequence on the tape changes, the clip is added to the 
clip list with time code information and an icon representing the first and last 
frames of the clip.

6 To stop the scan before the Out point is reached (or if you left the Out point 
blank), click the Stop and Mark Out button.

7 If you want to save your batch capture list so that you can capture the clips at 
a later time, right-click the clip list and choose Save As. For more 
information on saving and loading clip lists, see “Saving and loading a clip 
list” on page 142.

8 When you’re ready to capture your clips, see “Capturing clips from a batch 
capture list” on page 140.

¦ Note “Scanned only” clips have only a small tape icon ( ) in the clip list. 
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Adding clips to a batch capture list
°To define individual clips that you want to add to your batch capture list: 

1 In the MediaTools dialog box, click the VTR button. 

2 In the Tape ID box, type a name for the tape presently loaded in your 
DV-1394 device. In the Clip ID box, type the base clip name you’d like to be 
assigned to your clips. For more information, see “How MediaTools assigns 
clip names” on page 136.

3 Use the transport controls to navigate through clips on tape in your DV-1394 
device. 

4 Specify the In and Out points for your clip using any of the following 
methods:

$ Mark or type in the In and Out points of your clip, then click Add To List 
to add the clip to your clip list. 

$ Mark or type in the In point of your clip, then click Add To List. MediaTools 
will cue to the In point of the clip and begin playing the tape until you click 
Stop and Mark Out.

$ Mark or type in the Out point of your clip, rewind your tape to where you 
want your clip to start, then click Add To List. MediaTools will use the 
tape’s current position as the In point.

5 Continue adding new clips until you’ve completed your batch capture list.

6 If you want to save your batch capture list so that you can capture the clips at 
a later time, right-click the clip list and choose Save As. For more 
information on saving and loading clip lists, see “Saving and loading a clip 
list” on page 142.

7 When you’re ready to capture your clips, see the next section, “Capturing 
clips from a batch capture list.”
Creating a batch capture list
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Capturing clips from a batch capture list
°To capture clips from your batch capture list:

1 In the MediaTools dialog box, click the VTR button. 

2 Click the Edit tab.

3 Select the clips you want to capture in the clip list. If you want to capture all 
your clips, right-click the clip list and choose Select All. 

4 Click Capture. 

5 If needed, you’ll be prompted to load the appropriate tape in your DV-1394 
device. MediaTools will start capturing the selected clips in the order in 
which they appear on the tape. All selected clips in the clip list will be 
captured unless you click Stop and Mark Out to stop the capture. 

Editing clips
You can edit the In and Out points of a captured clip and recapture it. You can 
also update the Clip ID and Comment information for clips in your clip list.

¦ Note You can only edit and recapture clips that you originally captured in 
MediaTools. You cannot, however, recapture clips captured using CAM mode.

Updating and recapturing clips
°To edit and recapture a clip:

1 In the MediaTools dialog box, click the VTR button. 

2 Select a captured clip that you want to edit in the clip list. MediaTools will 
automatically switch to the Edit tab. 

3 Mark or type in new In and Out points, or a new clip duration.

4 To update the information in the time code fields, click Update. A warning 
message is displayed to warn you that changing the In and Out points of the 
clip requires the clip’s files to be deleted from your hard drive. Click Yes to 
change the In and Out points of the clip. 

5 To recapture the clip, click Capture. 

6 If needed, you’ll be prompted to load the appropriate tape in your DV-1394 
device. MediaTools will cue to the In point of the clip and capture it.

7 To stop the capture before the Out point is reached (or if you left the Out 
point blank), click the Stop and Mark Out button. 

¥ Tip The Update button can also be used to update the Clip ID and the 
Comment by simply typing in the text boxes and clicking Update. For more 
information on the clip ID, see “How MediaTools assigns clip names” on 
page 136.
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Changing a clip’s In and Out icons
In and Out icons are the small icons representing the first and last frames of a 
clip in the clip list. These icons can be changed to better represent your clip. 

°To change the In and Out icons of scanned or captured clips in the clip list: 
1 Use the transport controls to play back your clip in the Preview Window 

and on your NTSC or PAL video monitor. 

2 When you see the frame you want for the In icon, click Grab In Icon. 
MediaTools automatically updates the icon.

3 When you see the frame you want for the Out icon, click Grab Out Icon. 

Working with the clip list
The following sections explain how to add new clips to the clip list, save and load 
clip lists, copy, move and delete clips, and how to detach and resize the clip list.

Adding clips 
You can add a clip or a series of clips (.avi files) to the clip list using any of the 
following methods:

• On the New tab, enter valid In and Out points in the time code fields, then 
click Add To List. For more information about this feature, see “Adding 
clips to a batch capture list” on page 139.

• Drag an .avi file from a file management program, such as Windows 
Explorer, to the clip list. If you’re adding clips to an existing clip list, you 
can drag them to the bottom of the clip list, or place them in a specific 
position using the methods described in the section “Moving clips” on 
page 142.

• Right-click the clip list, then choose Import Clip from the pop-up menu (or 
double-click an empty area of the clip list). In the Open dialog box, select 
the .avi files you want to import, then click Open. 
Working with the clip list
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Saving and loading a clip list
To save a clip list, right-click the clip list. Choose Save As from the pop-up 
menu to save your current clip list as a .dvl file. 

You can load a clip list (.dvl) using any of the following methods:

• Right-click the clip list. Choose Open Clip List or Open Recent to select a 
recently-opened clip list. 

• Drag a .dvl file from a file management program, such as Windows Explorer, 
to the clip list. 

• Double-click the .dvl file in Windows Explorer to start MediaTools and load 
the clip list. Make sure that MediaTools is not running when you do this. 

¦ Note If you load a .dvl file to a clip list that already contains clips, it will 
replace the current clip list.

Copying clips
You can copy a clip or a series of clips in the clip list using either of the following 
methods:

• Select the clips you want to copy, right-click the clip list, then choose Copy 
from the pop-up menu. Select a clip in the clip list, then choose Paste to 
paste the copied clips above the currently selected clip.

• Select the clips you want to copy, then CTRL+drag the clips and drop them 
into the sequence you want.

¦ Note When copying a clip, the clip’s .avi file is not copied, only the reference 
to the clip on tape is copied. MediaTools assigns the -Copy extension to the Clip 
ID of the copied clips.

Moving clips
You can change the order of clips in the clip list, such as to arrange clips in the 
order you want them to play back when using the Play From Tape or Play From 
Disk command. To rearrange your clips, do any of the following: 

• Select the clips you want to move, then drag and drop them into the sequence 
you want. If you drag clips up in the clip list, the clips are inserted above the 
black line. If you drag clips down in the clip list, the clips are inserted below 
the black line. Releasing the mouse button places the clips in the list and 
ripples the position of all subsequent clips in the clip list.

• Select the clips you want to move, then right-click the clip list. Choose Cut 
from the pop-up menu to cut the clips. Select a clip in the clip list, then 
choose Paste to paste the clip above the currently selected clip. 
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Deleting clips
Select the clips you want to delete, right-click the clip list, then choose one of the 
following from the pop-up menu: 

• To delete only the selected clips from the clip list, choose Delete Clip Only.

• To delete the selected clips and their corresponding files from your hard 
drive, choose Delete Clip+File. 

• To delete only the files for the selected clips from your hard drive (the clips 
will remain in your clip list), choose Delete File Only.

¦ Note When you choose to Delete File Only, MediaTools keeps the 
reference to the clip on tape in case you want to recapture the clip at a later time.

Detaching and resizing the clip list
You can change the size of your clip list to suit your needs. First, detach the clip 
list from the MediaTools dialog box by clicking the Float/dock clip list button 
( ) above the clip list. Now the clip list can be freely moved and resized. To 
resize the clip list, drag the sides or corner of the clip list as needed. You can also 
use the standard Windows Maximize and Restore buttons in the top right corner 
of the window. 

After resizing, MediaTools will automatically rearrange the clips in the clip list. 
To dock the clip list back to the MediaTools dialog box, click the Float/dock 
clip list button, or click the Close button in the top right corner of the Clip List 
window. Once the window is docked again, MediaTools will remember the 
previous size and location of the clip list for the next time you detach the clip list.

Keyboard shortcuts

Delete Clip Only DELETE

Delete Clip+File SHIFT+DELETE

Delete File Only CTRL+DELETE
Working with the clip list
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Grabbing a single-frame image
You can grab single-frame (still) images and save them as .tga or .avi files to use 
in your Adobe Premiere projects. Your source video can be a clip on tape, a clip 
on disk, or live video.

¦ Note If you save your image as an .avi file, it will be saved in 
DV/DVCAM format.

°To grab a single-frame image: 
1 If your source video is on tape or disk, use the transport controls to play back 

your DV tape, or double-click a captured clip in the clip list to play it back.

2 In the MediaTools dialog box, click the Grab Image button to open the 
Grab Image dialog box. Drag the Grab Image dialog box to the side so that 
it doesn’t obscure the Preview Window. 

3 From the AVI/TGA Selection list, select Single-frame AVI or TGA to save 
your image as an .avi or .tga file.

4 When the frame you want is displayed in the Preview Window, click the 
Grab button. 

5 If you notice flickering in your image, you can choose to grab only one of 
the fields. From the Grab list, select Field 1 or Field 2. One field contains 
the odd-numbered scan lines in the frame, and the other field contains the 
even-numbered lines. Select the field that best displays your image. 
MediaTools interpolates between the two consecutive scan lines to create the 
missing field. 

6 Click Save or Save As to save the image. 
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¦ Note If you do not specify a file name in the Save As text box, or if you select 
Auto Save, MediaTools will assign a default name to the first grabbed image 
(such as MyImage01.tga, MyImage01.avi, or a name based on the last name you 
used) and continue naming images sequentially.

Exporting your clip list to an Adobe Premiere 
project 

You can export all or selected clips from the clip list directly to a new Adobe 
Premiere project (.ppj file). 

1 Select the clips you want to export using CTRL+click, or select a range of 
clips using SHIFT+click. 

2 Right-click the clip list. Choose Export to Premiere from the pop-up menu. 
A message is displayed asking if you want to export all clips in the clip list, 
or export selected clips. Choose Export All to export all clips, or choose 
Export Selected to export only selected clips. 

3 In the Save As dialog box, enter the directory and file name for the project 
you want to export. Click Save.

4 Close MediaTools and start Adobe Premiere. You can now open the Adobe 
Premiere project you created and add Matrox realtime effects. 

Keyboard shortcuts

Grab F5

Auto Save F6

Save F7
Exporting your clip list to an Adobe Premiere project
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Keyboard shortcuts
The following tables provide a complete list of keyboard shortcuts available for 
using MediaTools.

¦ Note To select the style of keyboard shortcuts you want to use, click the 
Options button in the MediaTools dialog box, then select the option you want 
under Transport Control Shortcuts.

Transport control keyboard shortcuts

CMX-style Premiere-style

K Disk mode D

L VTR mode V

B Play L or SPACEBAR

Z  Rewind R

X Fast Forward F

’ (apostrophe) Frame Advance right arrow or 2

; (semicolon) Frame Reverse left arrow or 1

V Stop S or K

A Loop A

M Mark In I

, (comma) Mark Out O

SHIFT+Mark In Cue In SHIFT+Mark In
SHIFT+Mark Out Cue Out SHIFT+Mark Out
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Additional keyboard shortcuts

CAM mode C

Delete Clip Only DELETE

Delete Clip + File SHIFT+DELETE

Delete File Only CTRL+DELETE

Grab F5

Auto Save F6

Save F7

Import Clip CTRL+I

Select All CTRL+A

Cut CTRL+X

Copy CTRL+C

Paste CTRL+V

New Clip List CTRL+N

Open Clip List CTRL+O

Save Clip List CTRL+S

Export to Premiere CTRL+E
Keyboard shortcuts
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Your notes
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Using Matrox MediaExport

This chapter explains how to use 
Matrox MediaExport to export 
material from your Adobe 
Premiere Timeline to Windows 
Media, RealMedia, and MPEG 
formats.
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About Matrox MediaExport
Matrox MediaExport is a plug-in for Adobe Premiere that brings together 
Windows Media and RealMedia streaming media, and Ligos MPEG encoding in 
one customizable export application. By taking advantage of your Matrox 
realtime editing hardware, MediaExport significantly reduces the rendering time 
of exporting clips from your Premiere Timeline. The MediaExport plug-in 
features: 

• Accelerated video export from your Adobe Premiere Timeline to Windows 
Media, RealMedia, and Ligos encoders.

• Encoding of Windows Media, RealMedia, and MPEG video files in a single 
encoding session. 

• Pre-configured streaming media encoding profiles.

• Pre-configured Ligos MPEG encoding profiles optimized for VideoCD and 
DVD-compliant video.

• Ability to customize any of the encoding profiles.

• Ability to save all settings of an encoding session to a file that can be loaded 
for a later session. 

Starting the Matrox MediaExport plug-in
Matrox MediaExport is available when you use the Export Timeline command 
from within Adobe Premiere. 

°To start Matrox MediaExport:
1 Start Adobe Premiere. 

2 Open the project from which you want to export material. 

3 If you don’t want to export all the clips in the project, drag the work area bar 
so that it covers the portion of your project you want to export. 

4 Choose File > Export Timeline > Matrox MediaExport.
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✐

Overview of the Matrox MediaExport dialog 
box

When you start MediaExport, a dialog box similar to the following appears: 

Here’s a brief description of the Matrox MediaExport dialog box:

✐ Destination Lets you specify the destination folder for your encoded files 
and assign the base file name. For more information, see “Exporting clips 
from the Timeline” on page 152.

✑Work area only Select this option if you want to export only the clips 
under the work area bar of your Adobe Premiere Timeline. For more 
information, see “Exporting clips from the Timeline” on page 152.

✒ Session window Lists the encoding profiles that have been selected for 
use in the current encoding session. The columns show encoding settings for 
each profile. For more information, see “Selecting encoding profiles for use 
in the session window” on page 153.

� Input source Lets you use either full frames or the first field of each 
frame as the input source for your encoded video. To achieve the best video 
quality, select Frame as input. However, if you crop your source video or 
output your video to non-standard frame sizes (frame sizes with heights that 
are not multiples of 480 for NTSC or 576 for PAL), the best video quality is 
achieved by selecting Field as input. 

✔ Crop button Opens the Crop Source Video dialog box where you can 
trim the edges of your source video. For more information, see “Exporting 
clips from the Timeline” on page 152.

✑

✒

� ✔ ✕ ✖ ✗ ✘
Overview of the Matrox MediaExport dialog box



152

Cha
✕ Add button Lets you add an encoding profile to the session window. For 
more information, see “Selecting encoding profiles for use in the session 
window” on page 153.

✖ Remove button Click this button to remove the currently selected profile 
from the session window.

✗ Save button and Load button Click Save to save the current session as 
a .mex file that can be loaded in a later encoding session. Click Load to load 
a saved encoding session into the session window. For more information, see 
“Saving and loading your encoding session” on page 169.

✘ OK and Cancel buttons Click OK to start encoding. Click Cancel to quit 
MediaExport and return to Adobe Premiere. 

Using the MediaExport pop-up menu
When you right-click the session window, a pop-up menu appears containing 
commands for working with MediaExport. All commands present in the 
MediaExport pop-up menu are described in this chapter.

Exporting clips from the Timeline
This section explains how to export clips from your Adobe Premiere Timeline 
using MediaExport.

1 Start MediaExport as explained in “Starting the Matrox MediaExport plug-
in” on page 150.

2 Click the Destination button, then specify the drive and folder where you 
want to store your encoded video files. 

3 In the file Destination box, enter the base name that you want to assign to 
the encoded files in this session. This base name will be assigned to the 
output files of all encoding profiles selected in the session window. To create 
a unique file name for each of your encoded files, MediaExport sequentially 
adds an underscore and a two-digit number to the specified base name. 
Regardless of what file types you encode in your session, each encoded file 
will be named using this convention (for example, MyStream_01.wmv, 
MyStream_02.rm, MyStream_03.m2v, etc.).

4 To apply crop settings to your source video, click Crop and enter the crop 
values in pixels in the Crop Source Video dialog box. Your video will be 
cropped and then resized to the frame size specified for the encoding profiles 
you’ll be using.

¡ Important When you apply crop settings to your source video, the best 
quality video is achieved by selecting Field as input from the MediaExport 
dialog box. Your crop settings and input source selection apply to all the 
encoded files in the session.
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5 To export only the clips under the work area bar of your Adobe Premiere 
Timeline, select Work area only.

6 Click the Add button, then select the encoding format you want, such as 
Windows Media.

7 From the profile library, select the encoding profiles you want to use. You 
can select many encoding profiles for a single encoding session. For details 
on selecting a standard profile, see “Selecting encoding profiles and adding 
clip information” on page 153. For details on creating a custom profile, see 
“Modifying standard profile settings to create a customized profile” on 
page 155.

¥ Tip You can clear the check boxes for profiles you don’t want to use for the 
current encoding session.

8 To start the encoding process, click OK. Once the encoding is complete, 
MediaExport closes automatically. 

Selecting encoding profiles and adding clip 
information

The Matrox MediaExport plug-in for Adobe Premiere includes a number of 
standard encoding profiles with settings pre-configured for optimum delivery and 
playback of your video. For streaming media clips, such as Windows Media 
clips, you can add information about your video, such as its title and important 
copyright information.

The standard encoding profiles are listed in MediaExport’s profile libraries. 
Standard encoding profiles cannot be removed from the profile libraries and their 
pre-configured settings cannot be permanently modified. Using standard profiles 
is the easiest and fastest way to encode your clips. 

If your video clip or target audience requires encoding settings that differ from 
those of the standard profiles, the encoding settings can be modified for the 
current encoding session. If you want to permanently save modifications to an 
encoding profile’s settings, you must create a customized encoding profile. For 
details on how to do this, see “Modifying standard profile settings to create a 
customized profile” on page 155.

Selecting encoding profiles for use in the 
session window
To encode video files, you must select at least one encoding profile from the 
profile library and add it to the session window. MediaExport allows you to add 
many encoding profiles to the session window at one time. 
Selecting encoding profiles and adding clip information



154

Cha
°To select an encoding profile:
1 Click Add and choose an encoding format from the list. You can also right-

click in the session window, then choose the format you want from the pop-
up menu, such as Add Windows Media. 

¦ Note If an encoding format is not available from the list, it cannot be added 
to the current encoding session. This means that you’ve either added the total 
maximum number of profiles to the session window, or you’ve reached the 
limit for a specific encoding format.

2 Depending on the encoding format you chose, a Profile Library dialog box 
appears. From the list, select the encoding profile that you want to use. A 
brief description of the selected standard profile appears in the status box 
below the profile list.

¦ Note Before adding the selected profile to the session window, you can view 
the profile’s default settings. Click the View button and browse through the 
tabs of the Export Settings dialog box. To modify any of the profile settings, 
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see “Modifying standard profile settings to create a customized profile” on 
page 155.

3 To add the selected encoding profile to the session window, click Select.

¥ Tip If you want to remove an encoding profile that you’ve added to the 
session window, select it, then either click the Remove button, or right-click 
in the session window and choose Remove from the pop-up menu.

Adding clip information to your streaming video
You can add information to your RealMedia or Windows Media file, such as its 
title, important copyright information, and the author’s name. This information 
will be displayed when your video clip is played in RealPlayer or in Windows 
Media Player.

°To add clip information:
1 In the session window, do one of the following:

$ Double-click the profile to which you want to add clip information.

$ To apply the same clip information to more than one profile, CTRL+click 
or SHIFT+click to select multiple encoding profiles. Right-click any of the 
selected profiles, then choose Settings from the pop-up menu.

2 Click the Clip Information tab, then enter the clip information you want. 

¥ Tip You can also add or modify the title of your video clip by typing it 
directly in the session window. 

3 To return to the session window, click OK. To save your encoding session, 
see “Saving and loading your encoding session” on page 169.

Modifying standard profile settings to create a 
customized profile

By modifying the settings of standard encoding profiles, you can create 
customized encoding profiles that meet the specific needs of your media content, 
and optimize the delivery of your video to your intended audiences. Your 
customized profiles can be renamed and permanently added to the profile 
libraries. They are easily identified in the Profile Library dialog boxes by an * 
prefix. 

°To modify an encoding profile:
1 From one of MediaExport’s profile libraries, select the standard profile that 

you want to modify. 

2 Do one of the following:

$ Click Select to add the selected profile to the session window. Double-click 
the profile, or right-click the profile and choose Settings from the pop-up 
menu. The changes you make will be retained only for the current encoding 
Modifying standard profile settings to create a customized profile
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session, unless you choose to save your customized profile as explained in 
the section “Adding your customized profile to the profile library” on 
page 168.

$ Click Copy to add a copy of the selected profile to the profile library, then 
click the Edit button. The changes you make will be saved to the copy in 
the profile library. 

¦ Note You can use the Remove button to permanently delete profile copies 
or customized profiles from the profile libraries. You can’t remove standard 
profiles.

3 Under Profile Name, enter a new profile name. 

4 Under Profile Comment, enter any comments that you want to appear in 
the status box of the Profile Library dialog box. 

5 Select the media type(s) that you want to include in your encoded file by 
selecting Export video and/or Export audio. 

6 To specify the destination folder and base name for files encoded using the 
current encoding profile, either click Output File and browse to the folder 
you want, or enter a folder and base name under Output File. Changing the 
destination folder and base name associated with this profile will not affect 
the destination folder or base name for other profiles in the session window. 

¥ Tip You can also change the destination folder and base name associated 
with the profile by typing it directly in the session window under the File 
Name heading. 

7 To add information about your RealMedia or Windows Media streaming 
video clip, click the Clip Information tab (see “Adding clip information to 
your streaming video” on page 155).

8 If you want to make advanced modifications to your customized encoding 
profile, such as to change the bit rate settings used and the desired frame 
size, see the next section,“Fine-tuning your customized encoding profiles.” If 
you want to add your customized profile to the profile library, see “Adding 
your customized profile to the profile library” on page 168.

Fine-tuning your customized encoding profiles
You can make advanced modifications to your customized encoding profiles, 
such as to change the video and audio options and bit rate settings. For your 
streaming videos, you can choose from a list of RealMedia or Windows Media 
video and audio codecs, frame sizes, and other options. For your Ligos MPEG 
videos, you can choose the MPEG format you want to use, modify the 
arrangement of the video’s GOP (Group of Pictures) structure, and set the speed 
of the motion estimation algorithm. 
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¦ Note For more information on RealMedia and Windows Media encoder 
settings, see the Advanced RealMedia and Advanced Windows Media plug-
in online Help or PDF documentation in Adobe Premiere.

Selecting your RealMedia codec options
1 Click the RealMedia tab. By default, the Codec Options are displayed. 

2 From the Video Codec list, select the video codec that you want to use. If 
you’re encoding a high-action video clip for high-bandwidth Internet 
connections, you may want to select the latest version of the video codec.

¦ Note When selecting a video codec for a RealMedia multiple bit rate profile, 
don’t select the RealVideo codec because it does not support multiple bit rate 
encoding. Later versions of the RealVideo codec, such as RealVideo 8.0 and 
RealVideo G2, do support multiple bit rate encoding. 

3 From the Frame Size list, select a size for your video frames. As frame size 
increases, greater bandwidth is required to stream the video. If you are 
encoding for slow connection speeds, such as 28.8 or 56 Kbps, it’s best to 
select a frame size no greater than 176×144.

¥ Tip You can also modify frame size by typing it in the session window 
under the Frame Size heading. When you modify the frame size of an 
encoding profile from the session window, the new frame size will apply to 
all the video streams of the encoded file.

4 From the Video Quality list, select the video quality that you want for your 
video. As you increase the sharpness of the image, the playback of the video 
may become less smooth. 
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5 From the Audio Content list, select the option that best describes the audio 
content of your video. 

6 If you want to prioritize the delivery of your clip’s audio during periods of 
Internet congestion, select Emphasize audio. This option, however, may 
cause the video portion of your clip to degrade during periods of Internet 
congestion. 

7 To allow viewers to download your encoded video onto their hard drives, 
select Allow download. 

8 To allow viewers using RealPlayer Plus to record your encoded video clip, 
select Allow recording. 

9 Under Filtering Options, select the options you want:

$ De-interlace Select this to de-interlace the fields of your video, such as 
to remove flicker from a still-frame image.

$ High-quality resize Select this to use the high quality resize filter, which 
can remove aliasing or blurring when your video is resized.

$ Inverse telecine Select this to remove the video frames added by the 
telecine process. 

$ Noise Filtering Select a noise filter from this list if you want to remove 
video noise distortion from the source video before it is encoded.
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Selecting your Windows Media codec options
1 Click the Windows Media tab. By default, the Codec Options are 

displayed.

2 From the Video Codec list, select the video codec that you want to use. If 
you’re encoding a high-action video clip for high-bandwidth Internet 
connections, you may want to select the latest version of the video codec.

3 From the Video Size list, select a size for your video frames. As video size 
increases, greater bandwidth is required to stream the video. If you are 
encoding for slow connection speeds, such as 28.8 or 56 Kbps, it’s best to 
select a size no greater than 176×144. 

¥ Tip You can also modify video size by typing it in the session window 
under the Frame Size heading.When you modify the video size of an 
encoding profile from the session window, the new size will apply to all the 
video streams of the encoded file.

4 From the Audio Codec and Audio Format lists, select the audio codec and 
audio format you want to use. 

5 Select the Index output file option if you want your viewers to be able to 
use the Windows Media Player fast forward and rewind features when they 
play your video.
Fine-tuning your customized encoding profiles
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Customizing your target audience settings
Customizing your target audience settings for RealMedia and Windows Media 
files, such as bit rate, frame rate, and key frame interval, lets you create video 
streams that are optimized for delivery over specific types of Internet 
connections. You can create multiple bit rate video files by adding one or more 
target audiences to a single bit rate encoding profile. 

°To modify your target audience settings:
1 Click the Target Audiences tab.

¦ Note If you’re modifying a multiple bit rate profile, check boxes for several 
target audiences will be selected. An individual video stream will be encoded 
for each selected target audience to create a multiple bit rate video file. You 
can change the settings for each of these target audiences.

2 From the list of target audiences, select (highlight) the target audience whose 
settings you want to change. 

3 Change the Bit Rate, Frame Rate, and Key Frame Interval as needed.

¥ Tip You can also change the frame rate by typing the value in the session 
window under the Frame Rate heading. When you modify the frame rate of 
an encoding profile from the session window, the new frame rate will apply 
to all of the profile’s target audiences.

4 If you’re modifying a RealMedia encoding profile, you can select the 
following options:

$ Variable bit rate encoding Select this to allow your video to be 
streamed at varying bit rates that correspond to the complexity of its content. 
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For example, high action segments will be allocated more bits than lower 
action segments, increasing the overall quality of the video without 
increasing the file size. 

$ Lossless protection Select this to help prevent the loss of data from your 
video file when it is being streamed during periods of heavy internet or 
network traffic.

5 If you’re modifying a Windows Media encoding profile, drag the Image 
Quality slider to select the image quality you want. As you increase the 
image quality, the playback of the video may become less smooth.

¦ Note To restore the default target audience settings, click the Reset button. 

6 Click OK to return to the session window.

Adding target audiences to create a multiple bit rate 
profile
You can add multiple target audiences to a single bit rate encoding profile to 
create a multiple bit rate video file. For each target audience that is added to the 
profile, an additional video stream is encoded in the file. 

°To add target audiences:
1 From the target audience list, choose the target audiences you want to add by 

selecting their check boxes.

2 For Windows Media, you can also add target audiences by selecting 
(highlighting) a target audience, then clicking Copy. A “Custom” target 
audience with the source’s selected target settings is added to the end of the 
target audience list. You must change the bit rate value of new “Custom” 
target audiences before MediaExport adds them to the encoding profile. 

¦ Note The check box of a target audience doesn’t need to be selected in order 
for it to be copied.

3 You can now modify the settings for each target audience, if needed. 
Fine-tuning your customized encoding profiles



162

Cha
Selecting your Ligos MPEG common settings
You can customize various common settings for the Ligos MPEG encoder, such 
as the video and audio file formats you want to encode. 

¡ Important When you customize your Ligos MPEG profile settings, ensure 
that your new settings are compliant with the type of stream you want to encode. 
Non-compliant settings may produce undesirable results in your exported video, 
and in some cases cause your export to be unsuccessful or unsupported by your 
DVD authoring program. It’s recommended that only advanced users customize 
their Ligos MPEG profile settings in MediaExport. For details about the required 
settings, see “Ligos-compliant profile settings” on page 166.

°To modify your MPEG common settings:
1 Click the Ligos MPEG tab. By default, the Common settings are displayed.

2 Under MPEG Stream, select the type of MPEG stream you want to encode. 

3 If you are encoding an MPEG-2 video file, under Profile and Level, select 
either Main Profile @ Main Level, or Main Profile @ Low Level.

4 Use the Motion Estimation slider to select the image quality you want for 
your video file. In general, setting the Motion Estimation slider to higher 
numbers produces the highest quality video, but the video will take more 
time and processor power to encode.

5 From the Audio Settings list, select the sampling format for the audio 
portion of your clip. 

6 Under File Generation, select the type of video and audio file you want the 
encoder to generate: 
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$ Video and audio in one file (MPG) Generates an .mpg (MPEG-1 or 
MPEG-2 Program) file that incorporates the video and audio portions of 
your clip into one file.

$ Video in M1V/M2V, audio in MPA Generates an .m1v (MPEG-1 
Elementary) or .m2v (MPEG-2 Elementary) video file and a compressed 
.mpa audio file. 

$ Video in M1V/M2V, audio in WAV Generates an .m1v (MPEG-1 
Elementary) or .m2v (MPEG-2 Elementary) video file and an 
uncompressed .wav audio file.

7 Under Video Settings, select the Frame Size, Frame Rate, and Aspect 
Ratio you want to use from the lists provided. 

¥ Tip You can also modify frame size by typing it in the session window 
under the Frame Size heading. 

Customizing your Ligos MPEG GOP structure 
and motion vector settings
You can define the properties of your video’s GOP structure, including its 
subgroup length and placement of the sequence headers. You can also modify the 
size of the motion vectors for your P and B frames. 

°To modify your GOP and motion vectors settings:
1 Click the GOP/Motion Vectors tab. 

2 Under GOP Structure, you can set the following:

$ GOP Length Determines the number of frames in the GOP.
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$ Subgroup Length Determines the subgroup length of B-frames and/or 
P-frames in the GOP, after the initial I-frame. A subgroup of 3 appears as 
“BBP,” a subgroup of 2 appears as “BP,” and a subgroup of 1 gives you only 
P-frames after the initial I-frame.

3 From the Put sequence header(s) list, select the placement frequency of 
the sequence header. The sequence header of an MPEG file provides 
information about the video stream for the decoder, such as bit rate, frame 
rate, and aspect ratio. Some MPEG applications require a particular 
frequency for the placement of the sequence headers in the file. For example, 
DVD-compliant video requires a sequence header before every GOP in the 
video file. 

4 Under Maximum Motion Vectors, either select a preset value from the 
lists, or enter a value for the size of your P frame and B frame motion 
vectors. The quality of your images can be affected if the motion vector 
values you choose are either too long, or too short. The best image quality is 
most often achieved using vector lengths between 16 and 32. 

¦ Note Motion vector values must be multiples of 8 between 16 and 64. If 
needed, the value you enter will be set to the nearest supported value.
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Customizing your Ligos MPEG bit rate settings
1 Click the Bit Rates tab. 

2 Under Audio (Kbps), select a bit rate for your compressed audio (for .mpg 
and .mpa files only).

3 To select a bit rate type for your MPEG video, do one of the following:

$ Select Constant if you want your video to be compressed at a constant bit 
rate. Enter the bit rate you want to use for your video in the box provided. 
Your video is compressed at exactly the bit rate you enter. However, if your 
video is very complex (such as scenes with many colors or sharp edges), 
you’ll need to specify a high bit rate to avoid having frames of very blocky 
video.

$ Select Variable if you want your video compressed at varying bit rates based 
on the complexity of the video. Enter the absolute highest bit rate for your 
video in the Maximum box, and the average target bit rate in the Keep 
average bit rate at box. 

¡ Important The maximum recommended DVD-compliant bit rate is 8000 
Kbps, which should give you good results with most DVD authoring 
programs. If you specify a higher bit rate, be aware that it may not be 
supported by your authoring program. For charts of recommended bit rates, 
see “Recommended MPEG data rates for distribution on DVD-R or CD-R” 
on page 199.

4 If you are encoding a variable bit rate video, you can choose to control the 
bit rate with a quantization scale value instead of an average bit rate. To 
Fine-tuning your customized encoding profiles



166

Cha
specify a quantization scale value, select Constant quantization scale, 
then either select a preset value from the list, or enter a value between 0 and 
31. For best results, select a constant quantization value between 2 and 6.

5 If you’ve selected Constant quantization scale, you can also select 
Specify average bit rate range, then enter an average minimum bit rate to 
use while encoding slow video, and an average maximum bit rate to use 
while encoding fast video. 

¦ Note The average maximum value you enter must be less than or equal to 
14648 Kbps, and less than or equal to the Maximum bit rate value.

6 Click OK to return to the session window.

Ligos-compliant profile settings
As explained in “Selecting your Ligos MPEG common settings” on page 162, if 
you customize your MPEG settings, you must select profile settings that are 
compliant with the MPEG stream you’re using. Non-compliant settings may 
produce undesirable results in your exported video, and in some cases cause your 
export to be unsuccessful or unsupported by your DVD authoring program. The 
required settings are listed in the following tables.

MPEG Stream DVD - MPEG-2

File Generation Video in M1V/M2V, audio in WAV

Profile and Level Main Profile @ Main Level

Audio Sampling 48000/16-bit

Frame Size 720 × 480 (NTSC), 720 × 576 (PAL)

Frame Rate 29.97 frames per second (NTSC), 25 frames per second (PAL)

Aspect Ratio 4:3 or 16:9

GOP Length 15

Subgroup Length 3

Put sequence header(s) before every GOP

Audio (bit rate) Compress at no higher than 384 Kbps

Video (bit rate)   no higher than 8000 Kbps
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MPEG Stream DVD - MPEG-1

File Generation Video in M1V/M2V, audio in WAV

Audio Sampling 48000/16-bit

Frame Size 352 × 240 (NTSC), 352 × 288 (PAL)

Frame Rate 29.97 frames per second (NTSC), 25 frames per second (PAL)

Aspect Ratio 4:3

GOP Length 15

Subgroup Length 3

Put sequence header(s) before every GOP

Audio (bit rate) Compress at no higher than 224 Kbps

Video (bit rate) no higher than 1856 Kbps

MPEG Stream Super Video CD

Audio Sampling 44100/16-bit

Frame Size 480 × 480 (NTSC), 480 × 576 (PAL)

Aspect Ratio 4:3 or 16:9

GOP Length 15

Subgroup Length 3 

Put sequence header(s) before every GOP

Video (bit rate) no higher than 2539 Kbps
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Adding your customized profile to the profile 
library

You can permanently save your modified profiles by adding them to the profile 
library. They are easily identified as customized profiles in the Profile Library 
dialog boxes by an * prefix. 

¦ Note If you edited a copy of a standard encoding profile, your customized 
profile has already been added to the profile library. 

MPEG Stream Video CD

Frame Size 352 × 240 (NTSC), 352 × 288 (PAL)

Frame Rate 29.97 frames per second (NTSC), 25 frames per second (PAL)

Aspect Ratio CCIR601 (525 lines NTSC), CCIR601 (625 lines PAL)

GOP Length 15 

Subgroup Length 3 

Audio (bit rate) Compress at no higher than 224 Kbps

Video (bit rate) no higher than 1123 Kbps

MPEG Stream MPEG-2 Profile and Level Main Profile @ Main Level

Video (bit rate) no higher than 14248 Kbps

MPEG Stream MPEG-2 Profile and Level Main Profile @ Low Level

Frame Size 352 × 240 (NTSC), 352 × 288 (PAL)

Video (bit rate) no higher than 3625 Kbps

MPEG Stream MPEG-1

Video (bit rate) no higher than 1856 Kbps
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1 In the session window, select the encoding profile you want to add to the 
profile library. 

2 Right-click the selected profile, then choose Add To Profile Library from 
the pop-up menu. 

3 When the message box appears asking if you want to add the selected profile 
settings to the profile library, click Yes.

4 The Profile Library dialog box appears with your customized profile added 
to the bottom of the profile library list.

5 To return to the session window, click Close. 

Saving and loading your encoding session
Once you have added all the encoding profiles that you want to use to the session 
window, you can save the encoding session and the settings of the selected 
profiles to a .mex file. The session and all the profile settings can then be loaded 
for a later session. 

°To save your encoding session:
1 Click Save.

2 In the Save As dialog box, name your file and click Save. 

°To load a previously saved encoding session:
1 Click Load.

2 In the provided dialog box, select the session (.mex file) you want to load, 
then click Open.

¥ Tip You can also save and load encoding sessions by right-clicking inside the 
session window and choosing Save Session or Load Session from the pop-up 
menu.
Saving and loading your encoding session
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Your notes
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Chapter 10
Using Sonic DVDit! SE

This chapter explains how to 
export material from Adobe 
Premiere for your DVD 
projects, and how to create a 
DVD volume with DVDit! SE. It 
also explains how to play back 
your DVD volumes using a 
software DVD player.
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Overview
Sonic DVDit! is a DVD authoring program that lets you create interactive content 
on your PC and publish it on DVD-R or CD-R. DVDit! SE is specifically tailored 
for use with your Matrox RT.X10 Xtra.

DVDit! SE allows you to output your DVD project to the following formats:

• DVD discs are the DVD files as they are written to recordable DVD-R or 
CD-R disc. 

$ DVD-R discs work with any set-top or software DVD player (PC-based 
DVD player). The discs can contain up to two hours of high-quality video.

$ CD-R discs work only with some software DVD players, and can contain 
about 15 to 20 minutes of high-quality video. A special cDVD player is 
included with DVDit! SE. You can copy this player onto a CD-R with your 
DVD video, so that your project can be played back on any PC.

• DVD volumes are folders containing video and audio files, as well as 
information used by a software DVD player. You can create a DVD volume 
on your hard drive, and play the files using any software DVD player (such 
as Sonic CinePlayer, which is bundled with DVDit! SE). The DVD volume 
is useful for testing your project before you create a DVD disc.
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Exporting material for your DVD project
The first step to creating a DVD is to get some MPEG-2 video material onto your 
A/V drive. You can use Matrox MediaExport to export video from your Timeline 
to an MPEG-2 Elementary (.m2v) file that’s suitable for use with DVDit! SE. 
Once you have some MPEG-2 video material, you can use DVDit! SE to create 
your DVD.

°To export material for your DVD project:
1 Start Adobe Premiere.

2 Open the project from which you want to export material.

3 Drag the ends of the work area bar so that it extends over the length of the 
area you want to export.

4 Choose File > Export Timeline > Matrox MediaExport.

5 Click Add and choose Add Ligos MPEG from the list. 

6 From the Profile Library that appears, select MPEG-2 DVD NTSC or 
MPEG-2 DVD PAL (depending on your system’s video standard), and click 
Select.
Exporting material for your DVD project
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7 In the Matrox MediaExport dialog box, click the Destination button. 

8 In the Save As dialog box, specify the drive and folder where you want to 
store your .m2v file (and .wav file if your video has associated audio). You 
can also specify a base name for your clip (such as DVDClip). 

9 To export only the clips under the work area bar of your Adobe Premiere 
Timeline, select Work area only.

10 To start the encoding process, click OK. Once the encoding is complete, 
MediaExport closes automatically. 

For more information on exporting clips using Matrox MediaExport, see Chapter 
9, “Using Matrox MediaExport.”

Creating a DVD volume

You can use DVDit! SE to create a DVD volume, which can be played using a 
PC-based software DVD player (for example, Sonic CinePlayer). The following 
steps explain how to create a simple DVD volume. For complete details on how 
to use DVDit! SE, see your DVDit! User Manual.

1 Start DVDit! SE.

2 In the Project Planner that opens, click Start a New Project.

✐ Video Monitor ✑ “First play” placeholder ✒ Palette Window

✐ ✑ ✒
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3 In the next dialog box, under 
Choose a Video Format, 
select MPEG2 (DVD- 
compliant). Click Finish.

4 Click the Backgrounds 
button on the Palette Window. 
Notice that the default theme 
backgrounds are automatically 
loaded. Select a background 
by dragging it to the “First 
play” placeholder.

5 Click the Buttons button on the Palette Window. Drag any button to the 
Video Monitor.

6 Click the button in the Video Monitor to resize it. A white border with 
handles now appears. Drag any of the eight handles to resize the button 
vertically, horizontally, or diagonally.

¥ Tip You can use CTRL+click to select multiple buttons and resize them 
simultaneously.

7 Click the Media button on the Palette Window. Right-click on the Palette 
Window, then click Add File To Theme. Locate the video file (and 
associated audio file, if applicable) that you exported from Adobe Premiere. 
Right-click the video file and click Play to watch it play back in the Video 
Monitor. Right-click the audio file and click Play to listen to it.

8 Drag the video file from the Media section of the Palette Window and drop 
it on the button you added to the Video Monitor. This creates a link between 
the button and the video. Drag the corresponding audio file to the same 
button. To see what media is linked to your button, right-click anywhere in 
the Video Monitor and choose Show Button Links. Notice that the file 
names are listed. Right-click anywhere in the Video Monitor and choose 
Hide Button Links to return to the normal view.

¥ Tip You can also create buttons by simply dragging any thumbnail from 
the Media section of the Palette Window and dropping it directly on the 
Video Monitor. A rectangular button with the thumbnail superimposed on 
the front will be created.

9 Click the Text button on the Palette Window. The default list of all the font 
styles on your computer appears. Select a font style and drag it to the Video 
Monitor. The word “Text” appears in the font style you’ve chosen.

10 Double-click the word “Text” to highlight it for editing. Enter your own text. 
Once you are finished entering your text, click anywhere in the Video 
Monitor to see the end result.
Creating a DVD volume
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11 Click your text to resize it. Choose Effects > Text Properties to apply 
color and shading effects to your text. Experiment with various settings. 
Click OK when you are finished.

¥ Tip You can link video material or still images to text, just as you can with 
buttons. Simply drag the media material and drop it on the text.

12 Click the Play button on the Palette Window to preview your DVD project. 
Preview mode simulates how the DVD project will respond once it’s 
completed. You can click the buttons on the Video Monitor to test the video 
clips or still images. Notice how the buttons and text become highlighted 
when you place the mouse pointer over them. The Remote Control behaves 
just like a real DVD player remote control, with buttons for play, stop, skip, 
menu, and title. Close the Remote Control when you’re finished.

13 Choose File > Save to save your project.

14 Choose Build > Make DVD Folder to build your DVD volume. In the Path 
section, click Browse to name your folder and specify your video drive. All 
the other settings can be left as is:

15 Click OK. Your DVD volume will now start to build. When it is complete, 
click OK.

16 Quit DVDit! SE.
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Playing your DVD volume using a software DVD 
player

You can create a DVD volume on your hard drive, and play the files using any 
software DVD player (such as Sonic CinePlayer, which is bundled with DVDit! 
SE).

Use the browse function of the software DVD player you’re using to locate the 
video_TS folder. Open the folder and select the video_ts.ifo file. This file contains 
all the information your software DVD player needs for playing back the DVD 
volume.

¦ Note Some software DVD players scan your computer drives for the video_TS 
folder and play the video_ts.ifo file automatically. With some older software 
DVD players, your DVD volume must be at the top level of your disk before it 
can be played. For more information, see your DVDit! User Manual.
Playing your DVD volume using a software DVD player
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Chapter 11
Using the WYSIWYG DirectShow

Control Panel
This chapter explains how to use 
the WYSIWYG DirectShow 
Control Panel to display clips 
played back using DirectShow 
programs on your NTSC or PAL 
video monitor.
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Overview
The WYSIWYG DirectShow Control Panel lets you display video played back 
using Windows Media Player, Sonic DVDit! SE, and other supported DirectShow 
applications on your NTSC or PAL video monitor. This gives you a WYSIWYG 
(What You See Is What You Get) video display for checking how your clips 
appear on a TV or other interlaced monitor.

The supported file types are: Matrox .avi and .m2v files, as well as Video CD and 
Super Video CD files (.mpg, .m1v, and .m2v files).

If you’ve connected an S-Video or composite video recorder to your RT.X10 Xtra 
system, you can record your clips onto tape as they play back on your video 
monitor.

Remarks
• To disable and re-enable the Matrox WYSIWYG DirectShow output to your 

video monitor, you must log onto an account on your Windows system that 
has Administrator privileges. For details, consult the appropriate Microsoft 
documentation.

• When playing non-interlaced video clips on your video monitor, you may 
see some flickering in your image that is not present in the image on your 
computer screen. This is normal.
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Configuring the WYSIWYG DirectShow Control 
Panel

1 To open the WYSIWYG DirectShow Control Panel, click the  icon on 
your Windows taskbar.

¦ Note If you are using Windows XP and do not see the  icon, right-click 
the taskbar and choose Properties. Clear the Hide inactive icons option, 
and click OK.

2 By default, the Matrox WYSIWYG DirectShow output to your NTSC or 
PAL monitor is enabled. Some DirectShow applications, however, may not 
display the video properly. If this happens, you can disable the display on 
your video monitor by clicking the Disable button. 

¦ Note After choosing Enable or Disable, you’ll need to restart your 
DirectShow application for the change to take effect.
Configuring the WYSIWYG DirectShow Control Panel
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3 Under Output Size, select the size that you want your video to be displayed 
on your NTSC or PAL video monitor. For example, select Original to 
maintain the original size of your clip.

¦ Note When you select a different output size, you won’t see the change on 
your video monitor until you pause your video clip and start the playback 
again.
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RT.X10 Xtra Troubleshooting

This chapter provides some 
possible answers if you have 
trouble installing or operating 
your RT.X10 Xtra system.
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Problems, possible causes, and solutions

Up-to-date information
The following pages contain information about the most common problems 
solved by our RT. X Support department. These solutions are also available on 
our web site at www.matrox.com/videoweb/support in the RT.X Support section. 
As new information becomes available, we’ll add it there first, so it’s always a 
good idea to check the site on a regular basis.

Possible solutions
Many of the troubleshooting items listed here, as well as others not included, 
could be solved by upgrading all of your hardware and software to the latest 
available versions. For hardware such as your motherboard, sound card, and 
storage devices, check the manufacturers’ web sites for the latest updates that you 
can download and install. As for Matrox hardware and software, check the RT.X 
Support section of our web site for the latest updates and patches. 

Multiple solutions
Some of the problems identified here may have more than one possible cause, 
and there are frequently several possible solutions. Solution instructions may 
vary depending on your operating system (Windows XP or Windows 2000).

³Warning Never open your computer system when its power is on!
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Installation/configuration

The card does not fit
Possible cause 1 New or unused slots If you’re installing your card in 

new or previously unused slots, there may be considerable 
resistance as the card slides into the slots. This is normal.

Solution Install carefully Make sure that the card is perfectly 
aligned with the slots and push it in firmly but gently until 
it is correctly seated.

Possible cause 2 Wrong slot You may be installing your RT.X10 Xtra card 
in the wrong slot.

Solution Use PCI slot Make sure to install your RT.X10 Xtra card 
in a PCI slot.

System freezes, shuts down, or crashes randomly
Possible cause 1 Other programs running You should not run any other 

programs at the same time as Adobe Premiere. Screen 
savers and programs that use a large amount of system 
memory, such as most paint and compositing applications, 
can cause problems if you run them at the same time as 
Premiere. 

Solution Quit all other programs Make sure you quit all other 
programs you have running at the same time as Premiere. 

Possible cause 2 Overheating It’s important to provide adequate 
ventilation in your computer system because your RT.X10 
Xtra card generates a significant amount of heat.

Solution 1 Provide ventilation Make sure your computer system is 
well ventilated with no obstructions blocking any 
openings, especially at the rear of the unit.

Solution 2 Operate in a safe area Avoid operating your RT.X10 
Xtra system in areas with an ambient temperature above 
55°C.
Problems, possible causes, and solutions
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Option to switch video standards isn’t available
Possible cause Option wasn’t selected You did not select the option to 

be able to switch your video standard when you installed 
Matrox X.tools.

Solution Re-install software If you’d like to be able to switch 
video standards without re-installing Matrox X.tools, you 
must select the option Install all files to be able to 
switch the video standard without re-installing 
X.tools when prompted during the X.tools install. When 
you want to switch your video standard, choose Start > 
Programs > Matrox X.tools > Switch Your Video 
Standard.
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Using Adobe Premiere

Video file playback is jerky (dropping frames)
Possible cause 1 Wrong drive or system not powerful enough You may 

not be using your A/V drive for playback, or your system is 
not powerful enough for realtime video editing.

Solution 1 Check drive properties Make sure your A/V drives are 
NTFS, and not compressed to save disk space. In Windows 
Explorer, right-click the drive letter (such as D:), then 
choose Properties. Under General, make sure that 
Compress drive to save disk space is not enabled.

Solution 2 Check settings for scratch disks In Adobe Premiere, 
you can check your scratch disks by choosing Edit > 
Preferences > Scratch Disks and Device Control. Be 
sure to specify the appropriate A/V drive letter for 
Captured Movies, Video Previews and Audio 
Previews. For more information, see “Setting up your 
scratch disks” on page 38.

Solution 3 Use the Force render option or upgrade CPU Some of 
the complex realtime Matrox effects, or certain 
combinations of effects, may cause dropped frames during 
playback. For those cases, do one of the following:

$ Use the Force render option to ensure smooth 
playback without dropped frames. For more 
information, see “Using common controls in the 
plug-in” on page 70.

$ Upgrade to a faster CPU. You can monitor your CPU 
usage by right-clicking on the Windows toolbar, and 
choosing Task Manager. On the Performance tab, 
choose Options and make sure that Always On Top 
is selected. Double-click anywhere in the dialog box 
to resize the CPU Usage window. If your CPU usage 
reaches and maintains 100% for too long while 
playing back a segment of the Timeline, you will drop 
frames.

Possible cause 2 Fragmented drive Your A/V drive may be fragmented.
Solution Defragment Try defragmenting your A/V drive. To 

defragment a hard disk, choose Start > Programs > 
Accessories > System Tools > Disk Defragmenter. 
For more information on how to defragment your storage 
devices, see your Windows documentation.
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Possible cause 3 Other programs running You should not run any other 
programs at the same time as Adobe Premiere. Screen 
savers and programs that use a large amount of system 
memory, such as most paint and compositing applications, 
can cause problems if you run them at the same time as 
Premiere. 

Solution Quit all other programs Make sure you quit all other 
programs you have running at the same time as Premiere. 

Possible cause 4 Motherboard drivers not updated Your motherboard or 
chipset drivers may not be up to date.

Solution Update drivers Update your drivers. For an updated list 
of recommended motherboard and chipset drivers, see the 
RT.X Support section of our web site at www.matrox.com/
videoweb/support.

Possible cause 5 DMA may not be enabled on your A/V drive If your 
A/V drive is an EIDE device and DMA bus-mastering is 
not enabled, your drive won’t be able to support realtime 
video editing on Matrox RT.X10 Xtra.

Solution Enable DMA Make sure that DMA is enabled for all 
EIDE devices. For more information, see your Windows 
documentation.

Adobe Premiere displays error message “The Matrox realtime 
plug-in could not start”

Possible cause 1 Other programs running You should not run any other 
programs at the same time as Adobe Premiere. Screen 
savers and programs that use a large amount of system 
memory, such as most paint and compositing applications, 
can cause problems if you run them at the same time as 
Premiere.

Solution Quit all other programs Make sure you quit all other 
programs you have running at the same time as Premiere. 

Possible cause 2 Incorrect display properties You may not have 
configured your Windows display properties correctly.

Solution Set your display properties Your Windows display 
should be configured to a resolution of at least 1024×768 
pixels with either 16-bit or 32-bit color. We recommend 
16-bit color for better performance. For complete details, 
see page 11.
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Possible cause 3 Incorrect display driver You may not have installed your 
display driver correctly, or your display driver is not up to 
date. 

Solution Re-install the driver If you use a display driver that is 
included with your Windows operating system, you should 
upgrade to the latest version. For an up-to-date list of tested 
display cards and drivers for your RT.X10 Xtra system, see 
the RT.X Support section of our web site at 
www.matrox.com/videoweb/support.

Possible cause 4 Device drivers not installed correctly Your device 
drivers may be corrupted or not installed correctly.

Solution Re-install software or drivers Uninstall Matrox X.tools 
and Adobe Premiere. Re-install Premiere, then re-install 
Matrox X.tools. 

Possible cause 5 Problem with your sound card Your sound card may be 
defective, or you may not have installed your sound card 
correctly. 

Solution Re-install your sound card Try re-installing your sound 
card, or replacing your sound card. For an up-to-date list of 
tested sound cards for your RT.X10 Xtra system, see the 
RT.X Support section of our web site at www.matrox.com/
videoweb/support.

¦ Note If the Matrox realtime plug-in still won’t start after 
trying the above solutions, contact Matrox RT.X Customer 
Support. You may be asked to provide the information listed 
under Tech Info in the error message.

Adobe Premiere freezes when using DV-1394 device control
Possible cause 1 Non-compatible device You may be using a non-

compatible DV-1394 device.
Solution Use only compatible DV-1394 devices For an updated 

list of compatible DV-1394 devices, see the RT.X Support 
section of our web site at www.matrox.com/videoweb/
support.

¦ Note Some compatible devices don’t support device 
control. However, you’ll be able to manually control your 
device for capture or recording onto tape.

Possible cause 2 Wrong time code on DV tapes Your DV tape may not 
have continuous time code.

Solution Use only continuous time code tapes To use DV-1394 
device control, your DV tapes must contain continuous 
and consecutive time code.
Problems, possible causes, and solutions
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Possible cause 3 Mixed DV tape format The format of your DV tape must 
match the format you’re recording.

Solution Use only one DV tape format Mixed format tapes are 
not supported. For example, if you set your DV-1394 
device to record in DV/DVCAM format, your tape must be 
striped entirely in DV/DVCAM format.

Possible cause 4 Wrong video standard When installing Matrox X.tools, 
you may have selected the wrong video standard for your 
system.

Solution Switch your video standard If you selected the option 
Install all files to be able to switch the video standard 
without re-installing X.tools when prompted during the 
X.tools install, you’ll be able to switch your video standard 
by choosing Start > Programs > Matrox X.tools > 
Switch Your Video Standard. You must select the video 
standard that matches your equipment. For example, you 
cannot use a PAL camera on an NTSC system. 

Unable to save entire project to disk
Possible cause 1 Scratch disks not set to A/V drive You may not have 

set up your scratch disks properly in Premiere.
Solution Check settings for scratch disks In Adobe Premiere, 

you can check your scratch disks by choosing Edit > 
Preferences > Scratch Disks and Device Control. Be 
sure to specify the appropriate A/V drive letter for 
Captured Movies, Video Previews and Audio 
Previews. For more information, see “Setting up your 
scratch disks” on page 38.

Possible cause 2 Fragmented drive Your A/V drive may be fragmented.
Solution Defragment Try defragmenting your A/V drive. To 

defragment a hard disk, click Start > Programs > 
Accessories > System Tools > Disk Defragmenter. 
For more information on how to defragment your storage 
devices, see your Windows documentation.

Possible cause 3 Not enough space Your A/V drive may not have enough 
space to save your project.

Solution Free some space Remove unnecessary files not related 
to your project to free up some space, or install a larger 
A/V drive.
pter 12, RT.X10 Xtra Troubleshooting
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A/V synchronization is poor when playing back from the 
Timeline

Possible cause 1 Non-compatible sound card You may be using a non-
compatible sound card.

Solution Use only compatible sound cards For an updated list of 
compatible sound cards, see the RT.X Support section of 
our web site at www.matrox.com/videoweb/support.

Possible cause 2 Audio Capture Drift Detection test not run   The first 
time you try to perform an analog capture in Adobe 
Premiere, you’re prompted to run the Audio Capture Drift 
Detection test to ensure proper audio and video 
synchronization between your sound card and your Matrox 
RT.X hardware. This test must be run prior to performing 
an analog capture. If you update or re-install the drivers for 
your sound card, or move your sound card to another slot, 
you should run the Audio Capture Drift Detection test 
again.

Solution Run the Audio Capture Drift Detection test   Run the 
test manually. 

°To run the Audio Capture Drift Detection test:
1 Choose Start > Programs > Matrox X.tools > 

Audio Capture Drift Detection.

2 From the Test Duration list, select a duration for the 
test. In most cases, five minutes will give you good 
results.

¦ Note If you often perform long analog captures (longer than 
one hour), it’s recommended that you select one of the longer 
test durations from the Test Duration list (such as 10 
minutes).

3 Click Start to run the test.
Problems, possible causes, and solutions
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Unable to see underlying clip in Matrox effect
Possible cause 1 Moved clip from Video 1 track If you move a video clip 

from the Video 1 track to the Video 2 track or higher (that 
is, a superimpose track) for the purpose of applying a 
Matrox video effect to the clip, you’ll have to apply an 
Alpha Channel key to the clip in order to see the underlying 
clip in your effect. You do not have to do this for video 
clips placed directly on a superimpose track.

Solution Place video clip directly on superimpose track You’ll 
be able to see the underlying clip in your Matrox effect 
when you place it directly on a superimpose track (Video 2 
or higher). For more information, see your Adobe Premiere 
User Guide.

Possible cause 2 Applied Matrox video effect to a graphics clip If you 
apply a Matrox video effect to a graphics clip on a 
superimpose track (Video 2 or higher), you must apply an 
Alpha Channel key to the clip in order to see the underlying 
image.

Solution Apply Alpha Channel key Right-click your graphics clip 
on the superimpose track and choose Video Options > 
Transparency. In the Transparency Settings dialog 
box, choose Alpha Channel as the Key type.
pter 12, RT.X10 Xtra Troubleshooting
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Capture issues

Can’t capture with DV-1394, Y/C, or composite input
Possible cause 1 Incorrect connections to breakout cable You may not 

have properly connected your video camera or deck to the 
breakout cable.

Solution Check connections Make sure you have properly 
connected your devices to the breakout cable. See Chapter 
3, “Installing Your RT.X10 Xtra and Connecting Your 
Devices.”

Possible cause 2 Incorrect video input settings Your video input 
settings in Adobe Premiere may not be correct.

Solution Make sure video input settings are correct In 
Premiere, make sure that you have selected the proper 
video input for your device in Project > Project 
Settings > Capture > A/V Inputs. Under Video 
Source, make sure you’ve selected the source you want to 
use (Composite, S-Video, or DV-1394). If using a DV-
1394 device for capture, make sure that Matrox DV-1394 
Device Control is set in Edit > Preferences > Scratch 
Disks and Device Control. 

Possible cause 3 Non-compatible device You may be using a non-
compatible DV-1394 device.

Solution Use only compatible DV-1394 devices For an updated 
list of compatible DV-1394 devices, see the RT.X Support 
section of our web site at www.matrox.com/videoweb/
support.

Possible cause 4 DV-1394 device drivers not installed correctly Your 
DV-1394 device drivers may be corrupted or not installed 
correctly.

Solution 1 Re-install device drivers Uninstall and re-install your 
DV-1394 device drivers. For details, see your Windows 
documentation.

Solution 2 Re-install software or drivers Uninstall Matrox X.tools 
and Adobe Premiere. Re-install Premiere, then re-install 
Matrox X.tools. 
Problems, possible causes, and solutions
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Export issues

Unable to export to tape via DV-1394
Possible cause 1 Non-compatible device You may be using a non-

compatible DV-1394 device.
Solution Use only compatible DV-1394 devices For an updated 

list of compatible DV-1394 devices, see the RT.X Support 
section of our web site at www.matrox.com/videoweb/
support.

Possible cause 2 Video preview during export enabled On certain 
systems, export to tape will not work if video preview 
during export is enabled.

Solution Disable video preview during export Clear Enable 
video preview during export in the Matrox Advanced 
Settings dialog box on the DV-1394 page (choose
Project > Project Settings > General > Advanced 
Settings). Be aware that the preview will be disabled on 
your computer monitor. You’ll still be able to preview the 
video you’re exporting on your NTSC or PAL video 
monitor, assuming you’ve connected the analog video 
output of your DV-1394 device to your video monitor.

¦ Note If you clear the Enable video preview during 
export option after a failed DV-1394 export to tape, you’ll 
need to restart your computer before starting the export to tape 
again. 

Possible cause 3 Using Print to Video You may be trying to print to video 
instead of exporting to tape.

Solution Use Export to Tape In Adobe Premiere, choose File > 
Export Timeline > Export to Tape.

Export to Tape dialog box does not provide options as 
documented in the RT.X10 Xtra manual

Possible cause Matrox DV-1394 Device Control not selected You may 
be using the Adobe Premiere DV device control instead of 
the Matrox DV-1394 device control. To perform a Matrox 
DV-1394 export to tape, you must set your device control 
to Matrox DV-1394 Device Control.

Solution Select Matrox DV-1394 Device Control Choose Edit > 
Preferences > Scratch Disks and Device Control. 
Under Device Control, select Matrox DV-1394 Device 
Control. When you export your Timeline to DV tape, the 
Matrox DV Export to Tape dialog box will be displayed.
pter 12, RT.X10 Xtra Troubleshooting
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Audio issues

Sound doesn’t capture or print to tape, video files play back 
with no sound, or sound output is distorted or too loud 

Possible cause 1 Incorrect adjustments If the sound problem is with a 
particular device (for example, TV or speaker), the volume 
control on the device itself may need adjusting.

Solution Adjust volume Adjust the volume control on the device.

Possible cause 2 Bad connections Audio cables may be loose or 
incorrectly wired.

Solution Check connections  Make sure that all audio 
connections to the breakout cable are correct (see Chapter 
3, “Installing Your RT.X10 Xtra and Connecting Your 
Devices”).

Possible cause 3 Incorrect adjustments in Windows Your sound card’s 
software settings may be incorrect. Specifically, input or 
output may be disabled, or volume levels may be too low or 
too high.

Solution Check adjustments  Make sure your sound card’s 
playback and recording levels are correctly set as explained 
in “Set your volume levels” on page 12.

Possible cause 4 RCA cables not properly attached You may not have 
attached your audio cables to the breakout cable.

Solution Re-attach cables Make sure that your RCA audio cables 
are securely attached and in the proper jacks on your 
breakout cable.

No audio output from the PC speakers or breakout cable
Possible cause Bad connections Audio cables may be loose or 

incorrectly wired.
Solution Check connections  Make sure that all audio 

connections to the breakout cable are correct (see Chapter 
3, “Installing Your RT.X10 Xtra and Connecting Your 
Devices”).

Windows cannot play .wav files
Possible cause No sound card installed A Windows message will appear 

if you try to play any system sounds or any non-RT.X10 
Xtra related sounds, without having a sound card installed.

Solution Install a sound card Make sure you have a sound card, 
and that it is installed correctly.
Problems, possible causes, and solutions
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DVD/CD authoring

DVD video playback is jerky (skipping frames)
Possible cause Slow player Your DVD drive may be too slow.

Solution Enable DMA If your DVD drive supports DMA, DMA 
will automatically be enabled in Windows. Not all DVD 
drives, however, support DMA well. For more information, 
see the documentation that came with your DVD drive.

Can’t play certain DVD videos
Possible cause Wrong region settings A DVD video may not play back 

because the region setting on your DVD player doesn’t 
match the region code on the DVD-ROM disc. DVD 
players and videos use region codes to prevent the 
playback of video that was intended only for a certain 
region or market.

Solution Get correct version To get a copy of a DVD video that’s 
compatible with the region code of your DVD player, 
contact the vendor of that video.
pter 12, RT.X10 Xtra Troubleshooting



Appendix A
Data Rates and

A/V Disk Space Requirements
This appendix provides the 
approximate disk space 
requirements for creating 
video and audio files on your 
Matrox RT.X10 Xtra system. It 
also includes charts showing 
the recommended MPEG data 
rates for distribution on DVD-R 
or CD-R.
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DV/MPEG-2 qualities and required disk space
The following table shows approximately how much disk space you’ll need per 
minute of video when creating DV/DVCAM .avi files and MPEG-2 Elementary 
(.m2v) files at various data rates. 

Audio sampling and required disk space
The following table shows how much disk space you’ll need per minute of audio 
sampled on your Matrox RT.X10 Xtra.

Video 
Quality

Data 
Rate1

 (Mb/sec)

1 In this calculation, a megabit (Mb) is equal to 1,000,000 (1000× 1000) 
bits.

Data 
Rate2

(MB/sec)

2 In this calculation, a megabyte (MB) is equal to 1,048,576 (1024×1024) 
bytes.

Compression 
Ratio

File Size
(MB/min)

Min/1 GB3 
of storage

3 In this calculation, a gigabyte (GB) is equal to 1024 megabytes (MB), the 
conventional value used for calculating storage.

DV/DVCAM 25.0 2.98 5:1 178.0 5.8

MPEG-2 2.0 0.24 61.7:1 14.0 73.0

MPEG-2 7.0 0.83 17.8:1 49.8 20.6

MPEG-2 9.0 1.07 13.8:1 64.0 16.0

Sampling
Rate

Bits per 
Sample

Type
File Size

(MB/min)
Min/1 GB of

Storage

48 kHz 16 Stereo 11 93.1
endix A, Data Rates and A/V Disk Space Requirements
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Recommended MPEG data rates for 
distribution on DVD-R or CD-R

The following charts show the data rate you should select when creating MPEG 
files to get the best video quality for your DVD projects. These data rates are 
calculated according to the length of your project and the size of your distribution 
medium. When disk space is not an issue, such as when your project is short, 
you’ll get the best quality using a high constant bit rate (that is, 7 Mbits/sec). 
When disk space is at a premium, you should use a variable bit rate.

At data rates of 2 Mbits/sec and higher, you can create an MPEG-2 file. At data 
rates lower than 2 Mbits/sec, you’ll need to create an MPEG-1 file. You can use 
the Ligos MPEG encoder provided with Matrox MediaExport to export video 
from your Timeline to MPEG-2 or MPEG-1 format (see Chapter 9, “Using 
Matrox MediaExport”).

¦ Note These charts assume that your DVD project includes 48-kHz, 16-bit 
stereo audio. Be aware that your DVD authoring program may create additional 
files that will limit the amount of space available for your DVD project.

Constant bit rate
Variable bit rate

Time (minutes)

Recommended data rates for 4.7-GB DVD

M
b

it
s /

se
c

Recommended MPEG data rates for distribution on DVD-R or CD-R
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Recommended data rates for 650-MB CD-ROM

Constant bit rate
Variable bit rate

M
b

it
s /

se
c

Time (minutes)
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Appendix B
RT.X10 Xtra Specifications

This appendix provides 
specifications for your RT.X10 
Xtra card.
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Appendix B, RT.X10 Xtra Specifications

Matrox RT.X10 Xtra card specifications

General
PCI interface 3/4-size PCI card

Regulatory compliance FCC Class B, CE Mark Class B, ACA Class B, BSMI 
Class B, VCCI Class B

Nominal card dimensions Card 8.4” × 4.2”
Card including bracket 8.9” × 5.0”
Overall thickness including components 0.7”

Video
Inputs 1394 6-pin

Composite video (CVBS), RCA jack 
S-Video (Y/C), mini-DIN 
NTSC, PAL, and SECAM 

Outputs 1394 6-pin
Composite video (CVBS), RCA jack 
S-Video (Y/C), mini-DIN 
NTSC and PAL 

Video formats ITU-R601
NTSC: 720×480 at 29.97 frames/sec 
PAL/SECAM: 720×576 at 25 frames/sec
4:3 and 16:9 aspect ratios

Video overlay NTSC and PAL video-in-a-window support on console 
Realtime video codec DV, DVCAM (NTSC 4:1:1, PAL 4:2:0)

Audio
Analog audio input/output Dependent on sound card

Audio sampling method 16-bit, 48 kHz

Environmental specifications
• Minimum/maximum ambient operating temperatures: 0 to 55º C
• Minimum/maximum storage temperature: –40 to 75º C
• Maximum altitude for operation: 3,000 meters
• Maximum altitude for transport: 12,000 meters
• Operating humidity: 20 to 80% relative humidity (non-condensing)
• Storage humidity: 5 to 95% relative humidity (non-condensing)



Appendix C
Matrox RT.X10 Xtra Glossary

This glossary defines many of the 
terms used in this manual and in 
related Matrox RT.X10 Xtra 
documentation.
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Glossary of terms
Use this glossary as a reference for many of 
the basic terms in your RT.X10 Xtra manual 
and related documentation.

Numerics
1394 See IEEE-1394.

2D Short for two-dimensional. An image 
that has height and width only.

3D Short for three-dimensional. An object 
in three dimensions has height, width, and 
depth. Various techniques are used to show 
3D images on 2D surfaces like your computer 
screen.

3D tile A Matrox effect that uses rotating 
tiled patterns with various numbers of rows 
and columns.

4:2:2P@ML 4:2:2 Profile@Main Level. 
An international standard video compression 
profile introduced by MPEG-2. It supports 
4:2:2 luminance/chrominance sampling at up 
to 720 × 608 pixel resolution, and data 
transfer rates up to 50 Mb/sec (5.96 MB/sec). 
This profile is used for high-quality 
distribution and for archiving. See also 
MP@ML.

A
A/B roll Typically, A/B roll is an editing 
technique where scenes or sounds on two 
source reels (called roll A and roll B) are 
played simultaneously to create dissolves, 
wipes, and other effects. On nonlinear editing 
systems, A/B roll refers to using two source 
streams (.avi, .wav, .tga, and so on) to create 
an effect.

AGP slot Connection slot to a type of 
expansion bus found in most current 
computers. The AGP slot is used to house the 
display card.

alpha key An effect that makes parts of a 
foreground image fully or partially 
transparent based on alpha (transparency) 
values stored within the image’s file, so that 
an underlying image can show through. See 
also chroma key and luma key.

analog component video See 
component video.

analog signal A video or audio signal that 
varies continuously, as opposed to a digital 
signal which varies only by fixed steps.

anti-aliasing A technique that smooths 
jagged edges in computer-generated text or 
graphics.

aspect ratio A width-to-height ratio. For 
example, a 12-by-9-inch image has an aspect 
ratio of 4:3 (four-to-three). Most TV screens 
have a 4:3 aspect ratio. HDTV screens have a 
16:9 aspect ratio.

assemble editing Recording new video 
and audio material sequentially onto tape. 
Because all the signals are recorded (video, 
audio, and control track), the new material 
completely replaces any previously recorded 
material on the tape. See also insert editing.

AVI Audio Video Interleaved. A video file 
format designed for the Microsoft Windows 
environment. See also codec.

A/V drive A hard drive capable of storing 
high-bandwidth audio/video data.

B
B-frame (Bi-directional frame) A frame 
created during the MPEG or MPEG-2 IBP 
compression process. A B-frame is generated 
by forwards and backwards referencing of the 
P-frames and I-frames respectively, which 
allows it to have the highest compression ratio 
of the three frame types. B-frames contain 
endix C, Matrox RT.X10 Xtra Glossary
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only predictive data (that is, not enough data 
to make up an entire picture), and therefore 
cannot be edited independently.

BIOS Basic Input/Output System settings 
for system components, peripherals, etc. This 
information is stored in a special battery-
powered memory and is usually accessible for 
changes at computer start-up. 

bitmap A graphics image in which a set of 
values defines each pixel’s relative brightness 
and color.

Blue Book standard See DV.

black level The level of brightness at 
which no light is emitted from the screen 
(reference black). The standard black level is 
7.5 IRE for NTSC video, or 0 IRE for NTSC-
EIAJ (Japan) and PAL video. Also called 
setup (NTSC video only). See also white 
level, super black, and super white.

bus A shared set of hardware lines that lets 
different parts of your computer transfer 
information between one another. A card 
inserted into an expansion slot of your 
computer makes an electrical connection to 
the bus and effectively becomes part of your 
computer system.

C
capture The process of digitizing video or 
audio material, usually from a VTR or 
camera, and storing it in a file on a hard disk.

chroma key An effect that makes portions 
of a foreground image fully or partially 
transparent based on the color of that image, 
so that an underlying image can show 
through. See also alpha key and luma key.

chrominance The color portion of a video 
signal that carries the hue and saturation 
information. See also luminance.

codec Compressor/decompressor. A 
processor that compresses video to reduce its 
file size by eliminating redundancies in 

information. It also decompresses files to play 
them back.

color bars A standard test signal that 
appears as a series of vertical rows of color by 
which the chrominance and video levels of a 
camera’s output or a recorded signal can be 
checked.

color correction effect A Matrox effect 
that allows various color properties of an 
image to be adjusted. There are controls for 
adjusting the intensity level for hue, 
saturation, contrast, and brightness. The color 
correction effect can correct improper color 
levels of an image that are due to varying 
lighting conditions or incorrect camera 
settings. See also white balancing. 

compile See render.

component video A video signal having 
separate channels for the video information, 
as opposed to a combined (composite) signal. 
Y, R-Y, B-Y video is a component video 
signal.

composite video A video signal 
containing luminance and chrominance 
information that has been combined using a 
video standard such as NTSC or PAL. 
Composite video often uses a single RCA or 
BNC cable connection. See also component 
video.

contrast The difference in brightness 
between the lightest and darkest areas of an 
image on the screen.

CPU-based effect An effect that takes 
advantage of your computer’s CPU to play 
back in real time. The Matrox color correction 
effect is an example of a CPU-based effect. 
Compare with hardware-accelerated effect.

crawl Sideways movement of text across a 
screen. See also roll (1). 

crossfade See dissolve.
Glossary of terms
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cube effect A Matrox effect that lets you 
map video or graphics to the faces of 3D 
shapes such as cubes and slabs.

cut A direct switch from one video and/or 
audio source to another.

D
D-9 Originally known as Digital-S. A 
professional variant of the DV format 
developed by JVC that uses a data rate of 50 
Mb/sec (5.96 MB/sec), which is double the 
data rate of most other DV formats. Video is 
sampled at 4:2:2 for both NTSC and PAL 
sources to give enhanced chroma resolution. 
It uses a 1/2” metal particle tape.

Digital8 A consumer camcorder video 
format developed by Sony. Digital8 
camcorders use the DV format to record 
digital video and audio onto 8mm and Hi-8 
tapes via any device that has an IEEE-1394 
interface. 

Digital-S See D-9.

digital signal A signal representing video 
or audio information as binary digits that can 
be easily regenerated with no noise or 
distortion. See also analog signal.

Digital Video See DV.

digitize To convert analog information, 
such as a video signal from a VTR or camera, 
into digital information that can be processed 
and stored by a computer.

Direct memory access (DMA) A 
technique used to rapidly transfer data 
between an attached device, such as a disk 
drive, and the computer's main memory 
without needing to pass the data through the 
central processing unit (CPU). 

DirectX A Microsoft-developed program 
that enables interfaces to support advanced 
hardware features without being written 
specifically for each hardware model. 

DirectShow (formerly called ActiveMovie) is 
part of DirectX.

display card A card that has its own 
memory and processor to handle graphics and 
enhance display capabilities. Also called 
graphics accelerator card or graphics card.

dissolve A transition in which one image 
smoothly fades to another image. It is 
characterized by the gradual ending of one 
image occurring simultaneously with the 
gradual beginning of another. Also called 
crossfade.

driver Software that controls a device, such 
as a display card, and enables it to work with 
other software.

drop-frame time code For NTSC video, 
time code is normally produced by a 
generator that counts at 30 frames per second. 
NTSC color signals, however, actually have a 
display frequency rate close to 29.97 frames 
per second. Drop-frame time code 
compensates for this time difference by 
dropping two frames from the count every 
minute except for every tenth minute so that 
the time code matches clock time.

DV Digital Video. A standard digital bit 
stream and compression format (known as the 
Blue Book standard) used to record video and 
audio onto a digital tape. DV is intra-frame 
based, saving each frame separately, and uses 
a fixed 5:1 compression ratio to reduce the 
size of video files. DV’s data rate is fixed at 
25 Mb/sec (2.98 MB/sec). Video is sampled 
at 4:1:1 for NTSC sources or 4:2:0 for PAL 
sources. See also DVCAM, DVCPRO, 
DVCPRO50, and D-9.

DVCAM A professional variant of the DV 
format developed by Sony that records a 15 
micron track on a metal evaporated (ME) tape 
at a data rate of 25 Mb/sec (2.98 MB/sec). 
Video is sampled at 4:1:1 for NTSC sources 
or 4:2:0 for PAL sources.
endix C, Matrox RT.X10 Xtra Glossary
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DVCPRO A professional variant of the DV 
format developed by Panasonic that records 
an 18 micron track on metal particle tape at a 
data rate of 25 Mb/sec (2.98 MB/sec). Video 
is sampled at 4:1:1 for both NTSC and PAL 
sources.

DVCPRO50 A professional variant of the 
DV format developed by Panasonic that uses 
a data rate of 50 Mb/sec (5.96 MB/sec), 
which is double the data rate of most other 
DV formats. Video is sampled at 4:2:2 for 
both NTSC and PAL sources to give enhanced 
chroma resolution. It uses the same type of 
tape as DVCPRO.

DVD Digital Versatile Disc or Digital Video 
Disc. A type of compact disc that can hold 
from 4.7 gigabytes (GB) to 17 GB of 
information. The greatest advantage that 
DVD has over CD is that it can store video as 
well as audio and computer data. For video 
storage, DVD uses MPEG-2 compression, to 
provide better quality than standard VHS.

DVE Digital Video Effect. Generally, an 
effect that resizes and repositions a picture on 
the screen.

E
Edit Decision List (EDL) A file 
containing a list of edit decision statements 
used to create a video production.

edit master The first generation (original) 
of a final edited tape.

expansion slot Electrical connection slot 
mounted on a computer's motherboard (main 
circuit board). It allows several peripheral 
devices to be connected inside a computer. 
See also AGP slot and PCI slot.

F
fade to black A transition commonly used 
to signify the end of a scene, in which an 
image or sound smoothly fades to a black 
screen or silence (also called a fade-out 
transition). Similarly, you could start a new 

scene with a fade up from black (or fade-in) 
transition.

field One-half of the horizontal lines 
needed to make a complete scan of an 
interlaced video frame. In the NTSC system, 
two consecutive fields of 262.5 lines each 
create a frame of 525 scan lines. In the PAL 
system, two consecutive fields of 312.5 lines 
each create a frame of 625 scan lines.

FireWire Apple Computer’s original 
implementation of the technology that would 
be standardized as IEEE-1394 in 1995.

Flex 3D A fully programmable architecture 
that applies 3D texture mapping to video 
using a Matrox 3D graphics accelerator chip 
and graphics memory. See also texture 
mapping.

frame A single video image. An interlaced 
video frame is comprised of two consecutive 
fields (the odd and even fields).

G
graphics overlay Text or a graphics 
image that’s superimposed on video. Also 
called super.

GOP Group of Pictures. The sequence of I, 
B and/or P-frames produced during MPEG or 
MPEG-2 compression. This sequence of 
frames contains all of the information 
required to reproduce a complete video 
segment. The longer the GOP, the less 
editable it is. 

H
hardware-accelerated effect An effect 
that requires the assistance of dedicated 
hardware, such as Matrox RT.X10 Xtra, to 
play back in real time. Matrox advanced DVE 
effects and page curls are examples of 
hardware-accelerated effects. Compare with 
CPU-based effect.
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hue The tint or tone of a color. For 
example, the difference between the color 
green and red is its hue.

I
IBP compression See MPEG-2 IBP.

IEEE-1394 An international standard data 
transfer protocol created by Apple Computer 
under the FireWire trademark and 
standardized by the Institute of Electrical and 
Electronics Engineers (IEEE). It enables 
simple, low-cost, realtime data transfer 
between computers and consumer and 
prosumer electronics products, such as DV 
camcorders and DV decks. Commonly 
referred to as 1394.

I-frame compression See MPEG-2 I-
frame.

I-frame (Intra-frame) A frame created 
during the MPEG or MPEG-2 compression 
process that contains all the information 
required to reproduce a complete image. It 
allows random access points within a video 
stream, and acts as a reference point for B-
frames and P-frames to be built. I-frames are 
editable because they contain enough data to 
construct an entire video frame, unlike B-
frames or P-frames. 

insert editing Recording new video and/
or audio material onto a prerecorded (or 
striped) tape. Insert edits can be made in any 
order, unlike assemble edits, which must be 
made sequentially.

inter-frame compression A video 
compression method that compares a series of 
frames in a video sequence and removes the 
redundant data. Inter-frame compression 
treats all the frames in the sequence as an 
interdependent group. As a result, most of the 
frames can’t be edited independently. Also 
called temporal redundancy reduction. 
Contrast with intra-frame compression. See 
also GOP.

interlaced scanning A method of 
creating a video image by drawing only the 
odd numbered lines on the screen in one pass, 
then the even numbered lines in the next pass. 
Two passes are therefore required to create a 
complete frame of video. NTSC and PAL 
displays are interlaced. See also progressive 
scanning. 

interleave A technique used to incorporate 
the video and audio portions of a video clip 
into one file. See also AVI. 

interpolate To create a gradual transition 
between different Matrox effect settings 
applied to a clip. See also keyframe, linear 
interpolation, and spline interpolation.

intra-frame compression A video 
compression method that removes redundant 
information from within a frame. Intra-frame 
compression treats each frame of a video 
segment independently. Several video 
compression formats use the intra-frame 
method. These include Motion-JPEG, DV, 
and MPEG-2 I-frame. Also called spatial 
redundancy reduction. Contrast with inter-
frame compression. See also I-frame (Intra-
frame).

J
JPEG (pronounced “jay-peg”) Joint 
Photographic Experts Group. A compression 
and storage standard used for still, digital 
images. See also Motion-JPEG.

K
key effect See alpha key, chroma key, and 
luma key.

keyframe A particular frame at which one 
or more effect settings have been defined on a 
clip using the Matrox realtime plug-in. 
Settings applied at a keyframe remain active 
on the clip until a later keyframe is defined to 
turn off or change the settings. See also 
interpolate.
endix C, Matrox RT.X10 Xtra Glossary



209
L
LTC Longitudinal Time Code. Time code 
that is generally encoded as an audio signal 
onto a linear audio track of a tape. This type 
of time code can be read only while the tape is 
moving. See also VITC.

linear interpolation One of the two types 
of interpolation that can be set between 
consecutive keyframes using the Matrox 
realtime plug-in. Linear interpolation means 
that the transition between effect settings 
occurs in even, linear increments. See also 
spline interpolation.

luma key An effect that makes portions of 
a foreground image fully or partially 
transparent based on the luminance of that 
image, so that an underlying image can show 
through. See also alpha key and chroma 
key.

luminance The brightness portion of a 
video signal. The luminance of a pixel 
determines its brightness on a scale from 
black to white. See also chrominance.

luminance key See luma key.

M
mark in To select the first frame of a clip.

mark out To select the last frame of a clip.

MIP mapping In 3D graphics, a rendering 
technique where a texture is stored at multiple 
resolutions. See also texture mapping.

M-JPEG See Motion-JPEG.

Motion-JPEG A compression and storage 
standard used for motion video. The JPEG 
compression process is applied to each video 
field, in succession. Also called M-JPEG.

MP@ML Main Profile@Main Level. An 
MPEG-2 video compression profile that 
supports 4:2:0 luminance/chrominance 
sampling at up to 720×576 pixel resolution, 
and data transfer rates up to 15 Mb/sec (1.79 

MB/sec). This profile is used for broadcast 
transmission and distribution on DVD. See 
also 4:2:2P@ML. 

MPEG A video compression standard that 
specifies a series of compression profiles and 
image resolution levels, introduced in 1990 by 
the Motion Picture Experts Group. MPEG 
takes advantage of the redundancy inherent in 
video data through a combination of inter-
frame and intra-frame redundancy reduction. 
The MPEG standard supports data transfer 
rates of up to 1.5 Mb/sec (0.2 MB/sec). Also 
called MPEG-1. See also MPEG-2, inter-
frame (IBP) compression, and intra-frame (I-
frame) compression.

MPEG-1 See MPEG.

MPEG-2 A video compression standard 
that improves upon the MPEG standard by 
supporting data rates of up to 100 Mb/sec (12 
MB/sec), scalable modes, field or frame 
searching, and much larger screen sizes. See 
also intra-frame (I-frame) compression, inter-
frame (IBP) compression, 4:2:2P@ML, and 
MP@ML.

MPEG-2 IBP An MPEG-2 compression 
type that uses inter-frame compression to 
create a group of I, B, and P-frames. Used for 
broadcast transmissions and distribution on 
DVD. See also GOP. 

MPEG-2 I-frame An MPEG-2 
compression type that uses only intra-frame 
compression (that is, only I-frames are 
created). Used for high-quality distribution 
and for archiving.

N
nonlinear editing Random access editing 
that generally uses video and audio clips 
stored on disks. Nonlinear editing programs 
let you rearrange and edit clips without 
having to redo the entire production, and 
provide instant cueing to any frame in a clip 
without waiting for tapes to rewind.
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NTSC National Television Systems 
Committee. The NTSC RS-170A standard 
defines a method of broadcasting a color 
signal that can be received by both 
monochrome and color TVs. It uses a 
composite interlaced display comprised of 
525 scan lines per frame, refreshed at a rate of 
approximately 30 frames per second. 
Broadcast systems in North America and 
Japan use the NTSC standard.

O
organic wipe A wipe effect that uses a 
grayscale gradient pattern to switch from one 
image to another by gradually revealing the 
second image according to the pattern.

P
PAL Phase Alternate Line. A video 
standard that uses a composite interlaced 
display comprised of 625 scan lines per 
frame, refreshed at a rate of 25 frames per 
second. This is the broadcast video standard 
for most of Europe.

particle effect A Matrox effect in which a 
clip breaks apart or explodes in a number of 
patterns.

PCI slot Connection slot to a type of 
expansion bus found in most current 
computers. It is smaller in size than older ISA 
slots and provides connections to the high-
speed PCI host bus.

P-frame (Predicted frame) A frame 
created during the MPEG or MPEG-2 IBP 
compression process. A P-frame is created by 
using motion vectors to predict the 
differences between it and the closest 
previous I-frame or P-frame. This forward 
prediction allows for higher compression than 
with I-frames, but not as high as with B-
frames. P-frames, like B-frames, contain only 
predictive data and therefore cannot be edited 
independently. 

pixel Picture element. The smallest portion 
of an image that can be written to a display. 
Each pixel in an image represents a single dot 
on the computer screen. A picture’s resolution 
depends on the number of pixels on the 
screen.

Plug and Play A hardware standard for 
auto-configuration. It refers to the ability of 
computer hardware to detect and configure 
expansion devices such as your Matrox 
RT.X10 Xtra card. Windows XP and 
Windows 2000 support Plug and Play.

plug-in Software that adds functionality 
and/or features to an application. For 
example, the Matrox realtime plug-in for 
Adobe Premiere adds realtime Matrox effects 
and transitions to Adobe Premiere. Plug-ins 
can be installed from a CD or downloaded 
from a web site.

proc amp An electronic device that adjusts 
the different aspects of a video signal, such as 
its hue, saturation, and contrast.

progressive scanning A method of 
creating a video image by drawing all the 
lines of a screen sequentially so that the 
complete image is displayed in one pass. 
VGA displays and some HDTV formats use 
progressive scanning. 

R
realtime effect An effect that is played 
back instantly, without having to be rendered 
by an editing program.

render To compute an image or effect 
using a nonlinear editing, compositing, or 
animation program. The result is generally 
saved in a file on the computer. Also called 
compile.

RGB video A component video signal that 
uses three signals to carry the separate Red, 
Green, and Blue channels of colored images.
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roll 1. Vertical movement of text across the 
screen. Also called scroll. See also crawl. 
2. Unwanted vertical roll of a video image, 
indicating unstable sync.

RS-232 A non-differential serial data 
transmission standard used for computer 
connections. See also serial control.

RS-422 A differential serial data 
transmission standard that is often used for 
linking video production equipment (VTRs, 
mixers, etc.). Because this standard is 
differential, RS-422 connections are less 
subject to interference and noise than RS-232 
connections. See also serial control.

S
saturation A measure of the depth of a 
color. Fully saturated colors are vivid, while 
colors that lack saturation look washed out or 
faded.

scroll See roll (1).

SECAM Séquentiel Couleur Avec Mémoire 
(sequential color with memory). A color 
television system developed in France and the 
former USSR. It uses a composite interlaced 
display comprised of 625 scan lines per 
frame, refreshed at a rate of 25 frames per 
second. The color difference signals are 
transmitted sequentially on alternate lines. On 
Matrox RT.X10 Xtra, SECAM can be used 
for video input only.

serial control A method of remotely 
controlling a device via a data line. The 
control data is transmitted in serial form (that 
is, one bit after another), such as for RS-232 
and RS-422 connections.

setup See black level.

soft wipe A split screen or wipe effect 
with a soft border or edge where the two 
images join.

spatial redundancy reduction See 
intra-frame compression.

sphere effect A Matrox effect that 
morphs an image into spheres with shadow 
and highlight.

spline interpolation One of the two 
types of interpolation that can be set 
between consecutive keyframes using the 
Matrox realtime plug-in. Spline interpolation 
provides a smooth transition based on the 
settings of all keyframes. See also linear 
interpolation.

striping a tape Preparing a tape for 
editing by recording continuous control track, 
time code, and a video signal (such as black 
or color bars).

super See graphics overlay.

super black Video that is darker than the 
standard black level. See also super white.

super white Video that is brighter than the 
standard white level. See also super black.

SVCD Super Video CD. A standard for 
storing video and audio on a CD that provides 
better video quality than VCD and standard 
VHS. Video is compressed using MPEG-2 at 
2500 Kbps, and audio is compressed as 
MPEG-1, layer II, at 224 Kbps. An SVCD 
can hold about 30 minutes of material. Super 
Video CDs will play back on some DVD set-
top players. 

S-Video A component video signal in 
which the luminance (Y) and chrominance 
(C) information are separate. S-VHS 
videocassette recorders use the S-Video 
format. Also called Y/C video.

sync A circuit or signal that directs the 
electron gun in a camera or TV picture tube to 
hold a picture steady on the screen. It also 
synchronizes the electronics of other video 
equipment.

sync generator An electrical device that 
generates sync (timing) signals used to 
Glossary of terms
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synchronize video equipment and keep 
pictures stable on the screen.

T
TBC See time base corrector.

temporal redundancy reduction See 
inter-frame compression.

texture mapping A display technique 
where bitmaps (textures) are placed (mapped) 
onto 3D surfaces to make objects look more 
realistic.

tile A transition in which one image is 
gradually replaced by another image that 
appears part-by-part in successive squares. 
The squares follow a given pattern until the 
entire screen is filled with the new image.

time base corrector (TBC) An 
electronic device that, when connected to the 
output of a VTR, corrects the stability and 
timing of the VTR’s playback video. This is 
achieved by stripping the unstable horizontal 
and vertical sync pulses from the video signal, 
and replacing them with new, clean sync 
pulses.

time code A sequential code number 
assigned to successive video frames on tape. 
Each frame has its own time code, which is 
electronically encoded on the tape in the form 
hours:minutes:seconds:frames. See also drop-
frame time code, LTC, and VITC.

timeline The graphical representation 
(normally a horizontal line) of a video 
sequence. It is usually divided into 
hours:minutes:seconds:frames, and is used to 
position video, audio, graphics, and video 
effects that make up the sequence.

tonal range The range of light and dark 
areas in an image. Tonal range can be divided 
into three different areas: shadows, midtones, 
and highlights. Shadows are the darkest areas 
of an image, highlights are the lightest areas, 

and midtones are the areas with tones 
between the lightest and darkest areas.

transform settings Settings that let you 
change the position, size, and rotation of a 
clip in the Matrox realtime plug-in. Transform 
settings can be applied on the x, y, and z axes 
of a clip. See also keyframe.

V
VCD Video CD. A standard for storing 
video and audio on a CD that provides 
slightly better video quality than standard 
VHS. Video is compressed using MPEG-1 at 
1100 Kbps, and audio is compressed as 
MPEG-1, layer II, at 224 Kbps. A VCD can 
hold about 60 minutes of material. Video CDs 
can play back on most DVD set-top players. 
See also SVCD.

VITC Vertical Interval Time Code. Time 
code that is encoded onto the vertical 
blanking interval of a video signal. VITC can 
be read by a VTR whenever an image is 
displayed, but not usually during high-speed 
operation. See also LTC.

voice over Narration added to a video 
segment and mixed in louder than the original 
background sounds.

W
WAV An audio data file format developed 
by Microsoft and IBM. This format is the 
standard for Windows and can be played by 
most applications that can support sound.

white balancing A color correction 
technique that adjusts the color levels of an 
image using white or gray as a color reference 
point. White balancing assumes that when a 
white object can be made to look white, the 
other color levels will also be accurate. White 
balancing is used to correct improper color 
levels of an image that are due to varying 
lighting conditions or incorrect camera 
settings. White balancing is available using 
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the Matrox color correction effect, and also as 
a setting on most cameras.

white level The brightest “legal” level of a 
video signal (reference white), which is at 100 
IRE. See also black level, super black, and 
super white.

wipe A transition in which one image is 
gradually replaced by another image that is 
revealed in a given pattern. For example, the 
second image could be revealed from the top 
of the screen downwards until it fills the 
entire screen. See also organic wipe.

X
x-y-z coordinate system A 3D 
positioning system that includes a third (z) 
axis running perpendicular to the horizontal 
(x) and vertical (y) axes. The x-y-z coordinate 
system is used in computer graphics for 
creating models with height, width, and 
depth, and for moving models in 3D space.

Y
Y/C video See S-Video.

Y, R-Y, B-Y video An analog component 
video signal comprised of three channels: Y 
(luminance), R-Y (red minus luminance), and 
B-Y (blue minus luminance).
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RT.X10 Xtra Customer Support

This appendix explains how to 
reach us if you need customer 
support.
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Getting the most support
If you have a problem that you’re unable to solve by referring to your RT.X10 
Xtra documentation, please contact your Matrox RT.X10 Xtra representative. He 
or she should be able to help you quickly correct any installation or system 
configuration problem.

If your representative is unable to solve your problem, contact Matrox for further 
information and assistance.

Register your RT.X10 Xtra
Only customers who’ve registered their RT.X10 Xtra are eligible to receive 
customer support service by phone. You can register your RT.X10 Xtra online by 
choosing Register your RT.X product from the Matrox RT.X menu once you’ve 
installed Matrox X.tools as explained on page 33. You can also register in the 
RT.X Support section of our web site at www.matrox.com/videoweb/support.

Registering your RT.X10 Xtra entitles you to free software updates, special 
promotional offers, and access to the Matrox RT.X10 Xtra User Forum, our 
dynamic web forum for users who want to share their experiences and learn more 
about RT.X10 Xtra. As a registered MatroxRT.X10 Xtra user, you’ll have full 
access to fxzone.matrox.com, where you can share realtime effects and download 
new effects, and www.matrox.tv, where you can post your streaming video clips 
for free. 

Keep up to date with our web site
In addition to registering your RT.X10 Xtra, our web site offers you up-to-the-
minute information about Matrox products, free software updates, access to our 
support databases, and a complete list of computer equipment compatible with 
Matrox RT.X10 Xtra. Be sure to place our site in your favorites or bookmarks: 
www.matrox.com/videoweb/support.
endix D, RT.X10 Xtra Customer Support
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Contacting us
Matrox is proud to offer worldwide customer support. Please use the contact 
information for your area.

¦ Note The following numbers are subject to change. For up-to-date contact 
information, always check our web site at www.matrox.com/videoweb/support.

United States & Canada

Telephone ....................................................................................... 1 514 822-6030

Fax..................................................................................................  1 514 685-2853

Email ......................................................................... RT.X10support@matrox.com

Europe, Middle East, & Africa
Telephone

Calls from the U.K............................................................................  01753 665686

Calls from France....................................................................  +33 01 45 60 88 66

Calls from Germany ............................................................. +49 (0) 89 621 70 570

Calls from Italy ...................................................................................... 02 5253098

Calls from the rest of Europe, the Middle East, & Africa ........... +44 1753 665686

Fax

From the U.K. .................................................................................... 01753 665599

From Italy ............................................................................................ 02 52534045

From the rest of Europe, Middle East, & Africa.........................  +44 1753 665599

Email

From Italy .................................................................................. supporto.rt@treg.it

From the rest of Europe, the Middle East, 
& Africa.............................................................. RT.X10.tech.europe@matrox.com

All other countries

Telephone ....................................................................................... 1 514 822-6030

Fax..................................................................................................  1 514 685-2853

Email ......................................................................... RT.X10support@matrox.com
Contacting us

www.matrox.com/video
mailto:rt2000support@matrox.com
mailto:supporto.3g@treg.it
mailto:rt2000.tech.europe@matrox.com
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Matrox Around the World

This appendix provides contact 
information for Matrox sales 
offices around the world.
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Worldwide Headquarters
Matrox Electronic Systems Ltd., Video Products Group
1055 St. Regis Blvd. 
Dorval, Quebec 
Canada, H9P 2T4 
tel: 1 800 361-4903 (North America) 
      514 685-2630 ext. 2036 (Worldwide) 
fax: 514 685-2853 
Email: video.info@matrox.com

Europe, Middle East, Africa 
Matrox Video and Imaging Technology Europe 
Sefton Park 
Stoke Poges 
Buckinghamshire 
SL2 4JS 
United Kingdom 
tel: +44 (0) 1753 665577
fax: +44 (0) 1753 665599
Email: video.info.emea@matrox.com 

France
Matrox France SARL 
2, rue de la Couture 
Silic 225 
94528 Rungis Cedex 
France
tel: +33 (0) 1 45 60 62 08 
fax: +33 (0) 1 45 60 88 65 
Email: infovideo.br@matrox.com 

Germany
Matrox Electronic Systems GmbH 
Inselkammerstraße 8 
D-82008 Unterhaching bei 
Munchen, Germany 
tel: +49 (0) 89 621 70 570
fax: +49 (0) 89 614 97 43 
Email: video.info.emea@matrox.com 

Asia Pacific 
Matrox Asia Liaison
Beijing Representative Office 
#1608, 138A Haidian Road 
Beijing, China 100086 
tel: (86-10) 6256 4853 
fax: (86-10) 6253 6251 
Email: myang@matrox.com 

¦ Note The above information is subject to change. For up-to-date contact 
information, always check our web site at www.matrox.com/video.

mailto:video.info@matrox.com 
mailto:video.info.emea@matrox.com 
mailto:infovideo@matrox.com 
mailto:video.info.emea@matrox.com 
mailto:myang@matrox.com 
www.matrox.com/video
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